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Note

In order to be printed easily, this PDF-format manual is converted from the HTML-format instruction manual included on
the "User Manuals CD-ROM" supplied with the printer. Thus, there are descriptions that are applied only in HTML format,
and functions (video display function, etc.) that cannot be used. We appreciate your understanding.
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Printing procedure

Printing Options Using ROIIS @Nd SHEELS .........coiiiiiiiiiiiiiiiie et e e e e et e e e e enrae e e e e e nnnees 2
Loading and Printing ON ROIIS ... ... ettt e ettt e e et e e e e e e e e e e s e nnb s bee e e e eeeaaaaaaaaans 3
Loading and Printing 0N SHEELS .........ooiiiiiiiiiie ettt e e e et ee e e e e et ee e e e e entae e e e e eennreeeeeennees 8
T oLl aTo T YA To [o PP PRUPPRP 10
Printing frOmM IMAC OS X .ttt st e e e sttt e e e st te et e e s e s tteeeeesaansbeeeaeeaansbaeeaeeeannsraeeaeeennnees 11

'Printing Options Using Rolls and Sheets

The printer supports both rolls and sheets.
This section introduces the main features of each, as well as the main printing methods available. Select rolls or sheets to
suit your particular printing application.

Note
e For information on the types of paper the printer supports, refer to the Paper Reference Guide. (See "Types

of Paper.")

* A variety of other ways to print are available besides those introduced here. Choose the printing method that
suits your particular printing application, referring to "Working with Various Print Jobs" and "Enhanced
Printing Options" from the table of contents.

Roll printing

Media in spooled rolls is generally called Roll Media. Rolls are loaded on the Roll Holder, which are in turn loaded in the
printer.
Rolls can be used to print large photos or create posters or banners that cannot be printed on regular sheets.

* Large-format printing
Easily print vertical or horizontal banners from familiar applications such as Microsoft Office applications.
(See "Printing Vertical or Horizontal Banners (Large-Format Printing).")

* Borderless printing
Print without a margin (border) around posters or photos.
(See "Borderless Printing on Paper of Equivalent Size.")
(See "Borderless Printing by Resizing Originals to Fit the Roll Width.")
(See "Borderless Printing at Actual Size.")

* Banner printing
You can print multiple pages as a single continuous image, without margins between pages.
(See "Printing Multiple Pages Continuously.")

* 90-degree rotation before printing
Originals in portrait orientation are rotated 90 degrees when possible to use paper more efficiently.
(See "Conserving Roll Paper by Rotating Originals 90 Degrees.")

* Enlarged/reduced printing
You can freely adjust the size of originals by enlarging or reducing originals before printing.
(See "Resizing Originals to Match the Paper Size.")
(See "Resizing Originals to Fit the Roll Width.")
(See "Resizing Originals by Entering a Scaling Value.")

* Free Layout function
Print multiple documents from multiple applications (such as word-processing programs, spreadsheet programs, and so
on) next to each other.
(See "Printing Multiple Originals Next to Each Other.")

Printing Options Using Rolls and Sheets iPF815
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Sheet printing

Sheets refer to individual sheets of paper.
Insert the sheet between the Platen and the Paper Retainer.

* Enlarged/reduced printing
You can freely adjust the size of originals by enlarging or reducing originals before printing.
(See "Resizing Originals to Match the Paper Size.")
(See "Resizing Originals by Entering a Scaling Value.")

* Free Layout function
Print multiple documents from multiple applications (such as word-processing programs, spreadsheet programs, and so
on) next to each other.
(See "Printing Multiple Originals Next to Each Other.")

'Loading and Printing on Rolls

These are the basic steps for loading and printing on rolls.
Follow these steps to switch to a new roll or a roll of a different type or width before printing.

Note
* The procedure varies depending on the ManageRemainRoll setting in the printer menu and whether or not a
barcode has been printed on the loaded roll. (See "Keeping Track of the Amount of Roll Paper Left.")

e Steps 6 and 7 are unnecessary if ManageRemainRoll is On and a barcode has been printed on the roll.
* Step 7 is unnecessary if ManageRemainRoll is Off.

* When Width Detection in the printer menu is Off, after you have selected the type of paper in step 6, you
will need to enter the roll width. (See "Main Menu Settings.")

* For details on supported sizes and types of rolls, see Paper Sizes or the Paper Reference Guide. (See "Paper

Sizes.") (See "Types of Paper.")

* If you are not using the optional Media Take-up Unit when printing long documents such as banners, spread
a clean cloth or paper on the floor. Use the Stationary Output Stacker to prevent long printed documents from
being soiled by the floor after they are printed. (See "Using the Stationary Output Stacker.")

¢ If you prefer to wait for the ink to dry after printing and simply eject the document, you can deactivate auto-
matic cutting and cut the paper manually. (See "Specifying the Cutting Method for Rolls.")

1. Turn the printer on. (See "Turning the Printer On and Off.")

iPF815 Loading and Printing on Rolls
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2. Selectaroll as the paper source. (See "Selecting the Paper Source.")

3 « Remove any loaded paper that will not be used.
* Rolls (See "Removing the Roll from the Printer.")

* Sheets (See "Removing Sheets.")

Loading and Printing on Rolls iPF815
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4. Load the roll on the Roll Holder. (See "Attaching the Roll Holder to Rolls.")

5. Load the roll in the printer. (See "Loading Rolls in the Printer.")

Note

* Before borderless printing, make sure the blue Switch on the platen is set toward the ® side. (See
"Setting the Blue Switch on the Platen.")

iPF815 Loading and Printing on Rolls
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6. Select the type of paper. (See "Selecting the Paper Type (Roll).")

J 2
ey

Stop,
Load/Eject (1sac.)

® ©

OHoo

7. Specify the paper length. (See "Specifying the Paper Length (Roll).")

8. Complete settings in the printer driver for the type of paper and other details.

* Specifying Paper in the Printer Driver (Windows)
* Specifying Paper in the Printer Driver (Mac OS X)

Loading and Printing on Rolls iPF815
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@ Important

* Confirm the type of paper loaded in the printer and specify the same type in the printer driver.

If the type of paper does not match, an error message is displayed and the printing quality may be
affected, or printing may not be possible.

* The paper is too small.
* Papr Type Mismatch

9. Send the print job.

* Printing in Windows
* Printing from Mac OS X

iPF815

Loading and Printing on Rolls
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Start printing.

'Loading and Printing on Sheets

These are the basic steps for loading sheets and then printing.
Follow the steps below to load and print on sheets.

Note
* For details on supported types and sizes of paper, see Paper Sizes or the Paper Reference Guide. (See

"Paper Sizes.") (See "Types of Paper.")

1. Tum the printer on. (See "Turning the Printer On and Off.")

Claan
{as'acﬁg

Stay)
I Load/Elect {1sec

o)

2. Remove any loaded paper that will not be used. (See "Removing Sheets.")

3 « Complete settings in the printer driver for the type of paper and other details.
* Specifying Paper in the Printer Driver (Windows)

Loading and Printing on Sheets iPF815
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* Specifying Paper in the Printer Driver (Mac OS X)

4. Send the print job.
¢ Printing in Windows
* Printing from Mac OS X

5. Load the sheet. (See "Loading Sheets in the Printer.")

Note

* If you will load a sheet before sending a print job, after you load the sheet, the printer automatically
shows a menu for selection of the type of paper on the control panel Display Screen. Select the type
of paper at this point.
(See "Selecting the Paper Type (Sheet).")

* If you select a type of paper for which Media Width Detection is deactivated ( Off is selected), you
must advance the paper manually to the position for printing. (See "Manually Loading Paper to the
Position for Printing.")

iPF815 Loading and Printing on Sheets

Downloaded from ManualsPrinter.com Manuals



http://www.manualsprinter.com

10

Basic Printing Workflow > Printing procedure >

Start printing.

'Printing in Windows

Print from the application menu.

Important
@ * We recommend exiting unnecessary applications before printing. Running several applications while printing
may interrupt the transfer of print data and affect printing quality.

1 « In the source application, select Print from the File menu to display the dialog box for printing conditions.

Printing in Windows iPF815
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2. After confirming that the printer is selected in the dialog box, click Print or OK to start printing.

Note

e The appearance of the dialog box varies depending on the software application. In most cases, the
dialog box includes basic printing options and enables you to choose the printer, specify the range of
pages, number of copies, and so on.
Example: Print dialog box displayed by the application

* If another printer is selected, select the printer you want to use under Select Printer or in the dialog
box displayed after clicking Printer.

Settings for many printing methods (including enlarged or reduced printing, borderless printing, and so on) are displayed in

the printer driver dialog box. There are two ways to access the printer driver dialog box, as follows.

* From the application
(See "Accessing the Printer Driver Dialog Box from Applications (Windows).")

* From the operating system menu
(See "Accessing the Printer Driver Dialog Box from the Operating System Menu (Windows).")

'Printing from Mac OS X

Print from the application menu after registering the printer.

Important
@ * We recommend exiting unnecessary applications before printing. Running several applications while printing
may interrupt the transfer of print data and affect printing quality.

Registering the printer

Before printing, you must register the printer in imagePROGRAF PrinterSetup.app.
For instructions on registering the printer, see "Configuring the Printer Driver Destination ."

iPF815 Printing from Mac OS X
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Important
@ * During this setup process, the printer will not be listed among available printers if it is off or disconnected.

Printing from the application software

1 « In the application software, select Print from the File menu to display the dialog box for printing conditions.

Note
 This dialog box includes basic printing options and enables you to choose the printer, specify the
range of pages, number of copies, and so on.

2. Select the printer in the Printer list.

3 o Click Print to start printing.
As shown in the following illustration, you can switch to other panes in this dialog box to complete settings for vari-
ous methods of printing, including enlarged and reduced printing, borderless printing, and so on.

Printing from Mac OS X iPF815
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Canceling print jobs

Canceling Print Jobs from the Control PAnEl ............cc.uiiiiiiiiiiiii e e e e e 13
Canceling Print JOBS from WINAOWS .........oouiiiiie ittt e e e e e st tae e e e e e st ae e e e e e e nnbeeeaeeeennnrees 14
15

Canceling Print JObS from Mac OS X ....coiiiiiiiiii ittt e e et ee e e e e st e e e e sntee e e e e snnaeeeeeanbaeeeeennnees

'Canceling Print Jobs from the Control Panel

Hold down the Stop button for a second or more to cancel print jobs or ink drying in progress when the printer is online,

offline, or in Menu mode.

Stop
I Load/Eject (1sec.)

Printer operation varies depending on the status when you hold down the Stop button for a second or more during printing.

¢ If you press the Stop button before printing starts
Holding down the Stop button for a second or more before printing cancels the print job and brings the printer online.

When the roll is selected as the paper source, the printer goes online, and when sheet is selected, the printer goes off-

line.

iPF815 Canceling Print Jobs from the Control Panel
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* If you press the Stop button during printing
Holding down the Stop button for a second or more during printing stops printing immediately.

* If you press the Stop button when printing is paused
Holding down the Stop button for a second or more when printing is paused cancels the print job.

'Canceling Print Jobs from Windows

In the printer window, you can cancel jobs that are being sent to the printer.
Using imagePROGRAF Status Monitor, you can cancel print jobs that have already been received by the printer or that are
currently being printed.

1 « Click the printer icon in the taskbar to display the printer window.

Note

* You can also display this window by double-clicking the printer icon in the Printers and Faxes (or
Printers ) folder, accessible through the Windows start menu.

14 2. Right-click the job to cancel and select Cancel.

Canceling Print Jobs from Windows iPF815
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3. If the job to cancel is not shown in the printer window (that is, if the print data has already been received by the
printer), double-click the taskbar icon to display imagePROGRAF Status Monitor.

4. On the Printer Status sheet, click Cancel Job.

2 Canon, iPFxoon

Option  Help

Ink Levels :
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Fioll Paper 1 17-in. Roll [431.8mm] Plain Faper Q 80.0m/ 262 ftSin

Note

* The screen may differ slightly depending on the model you are using.

'Canceling Print Jobs from Mac OS X

In the printer window, you can cancel jobs that are being sent to the printer.
Otherwise, you can cancel jobs from imagePROGRAF Printmonitor if they have been received by the printer or are current-

ly being printed.

Note

* Print jobs are shown in the printer window while they are being sent from the computer. After transmission,

jobs are not displayed even during printing.

* Print jobs are displayed in the imagePROGRAF Printmonitor window from the moment the printer starts re-
ceiving the print data until the moment printing is finished. They are not displayed before print data is sent to
the printer, even if the computer has started preparing the print data.

1 o Click the printer icon in the Dock to display the printer window.

iPF815
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Basic Printing Workflow > Canceling print jobs >

2. Click Pause Printer to stop printing.

3. If there are no jobs in the printer window that can be canceled, (that is, if the print data has already been sent to the
printer), click Utility to display imagePROGRAF Printmonitor.

Canceling Print Jobs from Mac OS X iPF815
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4. Select the print job to cancel and click to delete the print job.

Note
* The screen may differ slightly depending on the model you are using.

The job sent to the printer is canceled.

5. Exit imagePROGRAF Printmonitor. In the printer window, click Start Jobs.

Important
@ » Always follow these steps if you cancel print jobs from imagePROGRAF Printmonitor. If you do not
restart job processing, the next job cannot be printed.

17
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Working With Various Print Jobs >

Working With Various Print Jobs

Printing CAD Drawings
Printing Photos and Images

Printing Office Documents

19
30
38

Downloaded from ManualsPrinter.com Manuals

iPF815


http://www.manualsprinter.com

Working With Various Print Jobs > Printing CAD Drawings >

Printing CAD Drawings
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'Printing CAD Drawings

Using this printer, you can print fine lines and text clearly and sharply. It's easy to produce highly precise drawings from
CAD applications.

Note

* In Windows, you can print highly precise drawings using the provided imagePROGRAF HDI Driver for Au-
toCAD/AutoCAD LT.
For details on the HDI driver, see the HDI Driver .

For instructions on CAD printing, refer to the following topics, as appropriate for your computer and operating system.

* Printing Line Drawings and Text (Windows)
* Printing Line Drawings and Text (Mac OS X)

'Printing Line Drawings and Text

Printing is easy when you simply choose the type of original to print.

Easy Settings

Simply choose the printing application in the list for optimal printing results.

Print Target
Choose presets that match the type of document to be printed.

Print targets for line drawings and text

Print Target Description

CAD (Color Line Draw- Settings optimized to print intricate lines in CAD draw-
ing) ings clearly.

iPF815 Printing CAD Drawings
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Print Target Description
CAD (Monochrome Line | Settings optimized to print black lines in CAD drawings
Drawing ) clearly.
Perspective, GIS Settings optimized for printing 3D CAD drawings, per-

spective drawings, and maps, including GIS maps.

2 Note

* You can check the settings values for each print target by clicking View Settings.

* You can also fine-tune these values as needed. ( Advanced Settings )
For details on Advanced Settings, see "Giving Priority to Particular Graphic Elements and Colors for

Printing "

Print Quality

Choose the print quality.
The printing mode is determined by a combination of the print quality and resolution.

Print Quality Description

Highest A setting for printing at the highest resolution when quality is most important.
Printing takes longer and consumes more ink than in other modes, but this mode
offers superior printing quality.

High Choose this setting to print at high resolution when quality is most important.
Printing takes longer and consumes more ink than in Standard or Draft modes,
but this mode offers exceptional printing quality.

Standard Choose this setting to print at standard resolution when quality and speed are both
important.
Printing takes less time than in Highest or High mode.

Draft Choose this setting to print faster.
Printing in draft mode can help you work more efficiently when checking layouts.

For instructions on printing line drawings and text, refer to the following topics, as appropriate for your computer and oper-
ating system.

* Printing Line Drawings and Text (Windows)

50 * Printing Line Drawings and Text (Mac OS X)

'Printing Line Drawings and Text (Windows)

This topic describes how to print line drawings based on the following example.

* Document: CAD drawing
* Page size: A3 (297.0 X 420.0 mm [11.7 x 16.5 in])
* Paper: Roll paper

Printing Line Drawings and Text (Windows) iPF815
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* Paper type: Plain Paper
* Roll paper width: A2/A3 roll (420.0 mm [16.5 in])

1 « Choose Print in the application menu.

2. Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications (Windows) ")

3. Make sure the Main sheet is displayed.

4. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.

5. After confirming that L) Easy Settings is selected, click CAD (Color Line Drawing) or CAD (Monochrome Line
Drawing ) in the = Print Target list.

Note
* You can check the settings values selected in the = Print Target list by clicking (= View Settings.

iPF815 Printing Line Drawings and Text (Windows)
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6. Click the Page Setup tab to display the Page Setup sheet.

7. In A Page Size, click the size of the original as specified in the application. In this case, click ISO A3.
8. Select and click a roll paper in the L Paper Source list.
9. Select the width of the loaded roll in the VI Roll Paper Width list—in this case, ISO A2/A3 Roll (420.0mm).

1 0. Specify additional printing conditions.
For details on available printing conditions, see "Printer Driver Settings (Windows) "

1 1 « Confirm the print settings and print as desired.

Note
* For tips on confirming print settings, see "Confirming Print Settings (Windows) "

'Printing Line Drawings and Text (Mac OS X)
22

This topic describes how to print line drawings based on the following example.
* Document: CAD drawing
* Page size: A3 (297.0 x 420.0 mm [11.7 x 16.5 in])
¢ Paper: Roll
* Paper type: Plain Paper
* Roll paper width: A2/A3 roll (420.0 mm [16.5 in])

Printing Line Drawings and Text (Mac OS X) iPF815
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1 o This sets the 5 Format for and  Paper Size.

Note

* The configuration method varies depending on the OS and application software you are using.
If Page Setup is displayed in the application menu, the settings are configured by opening the Page
Attributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the /A Printer list.
3. In the = Paper Size list, click the size of the original. In this case, click ISO A3.
4. If you configured the settings using the Page Attributes dialog box, click " OK to close the dialog box, and then

select Print from the application software menu.

23
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Working With Various Print Jobs > Printing CAD Drawings >

5. Access the Main pane.

6. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.

7. After confirming that L) Easy Settings is selected, click CAD (Color Line Drawing) or CAD (Monochrome Line
Drawing ) in the = Print Target list.

Note
* You can check the settings values selected in the = Print Target list by clicking (= View set..

8. Make your selection in the  Print Quality list.

Printing Line Drawings and Text (Mac OS X) iPF815
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9. Access the Page Setup pane.

1 0. Select and click a roll paper in the /A Paper Source list.

1 1 « Make sure the width of the loaded roll is displayed in the = Roll Width list—in this case, ISO A2/A3 (420.0mm).

Note

o If the width of the roll loaded in the printer is not shown in = Rell Width, click L Printer Informa-
tion on the Main pane to update the printer information.

25
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12. Make sure ( Page Size on the Page Setup pane shows the original size as specified in _ Paper Size in the Page
Attributes dialog box—in this case, ISO A3.

13 » Specify additional printing conditions.
For details on available printing conditions, see "Printer Driver Settings (Mac OS X) "
1 4. Confirm the print settings, and then click V! Print to start printing.

Note
* For tips on confirming print settings, see "Confirming Print Settings (Mac OS X) "

'Specifying Colors and Printing CAD Drawings

You can complete color settings when Color (CAD) is selected in Color Mode.
Colors can be adjusted before printing as follows when Color Compatibility is selected.

Note

* Color (CAD) is displayed when you select Advanced Settings on the Main sheet and set Print Priority to
Line Drawing/Text.

Color Compatibility
Color Setting Item

26
Color Setting Description
Color (CAD) 1 Print in standard colors.
Color (CAD) 2 Print in brighter colors.
Color (CAD) 3 Print emulating the Canon BJ-W3000/W3050, in colors resembling colors pro-
duced by these printers.
Color (CAD) 4 Print emulating the HP Designjet 500/800, in colors resembling colors produced by

these printers.

Specifying Colors and Printing CAD Drawings iPF815
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Color Setting Description
Color (CAD) 5 Print emulating the HP Designjet 1000, in colors resembling colors produced by
this printer.
Color (CAD) 6 Print emulating the HP Designjet 4000/4500, in colors resembling colors produced
by these printers.

Important
@ * If you have selected Color (CAD) 3, Color (CAD) 4, Color (CAD) 5, or Color (CAD) 6, it is not possible
to match the colors and image quality produced by the specified printer exactly.

For instructions on configuring Color Compatibility, refer to the following topics.

 Specifying Colors and Printing CAD Drawings (Windows)

'Specifying Colors and Printing CAD Drawings (Windows)
You can complete color settings when Color (CAD) is selected in Color Mode.

Note
* Color (CAD) is displayed when you select Advanced Settings on the Main sheet and set Print Priority to
Line Drawing/Text.

1 o Click start > Printers and Faxes (or Printers ).

2. Select the printer, and then display the printer properties dialog box.

iPF815 Specifying Colors and Printing CAD Drawings (Windows)
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3 « Click the Device Settings tab to display the Device Settings sheet.

4. Click A Color Compatibility to display the Color Compatibility dialog box.

5. Select the desired color settings in the /A Color Compatibility list.
Note
* For details on color settings, see "Specifying Colors and Printing CAD Drawings "

For printing instructions, refer to the following topic.

» Choosing the Document Type and Printing Conditions (Windows)

28 'HP-GLIZ Printing

This printer supports the original Canon GARO printer control language as well as HP-GL/2 and HP RTL(*1 )
emulation.(*2 ) When printing from applications that support HP-GL/2 output, specify HP-GL/2 in the applica-
tion's plotter output settings.

Note
* For instructions on configuring these settings, refer to the software documentation.

HP-GL/2 Printing iPF815
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The printer automatically switches to the corresponding processing depending on whether a GARO, HP-GL/2, or HP RTL
job is received. Configure the optional settings for HP-GL/2 emulation on the printer control panel. (See "Main Menu Set-

tings.")

This printer can emulate the following printers using HP-GL/2 emulation.
Emulated Printers
Canon W3000 and W3050(*3 )
Hewlett-Packard | Designjet 450c, Designjet 750c Plus, and Designjet 750c

*1: HP-GL/2: Hewlett-Packard Graphics Language 2; HP RTL: Hewlett-Packard Raster Transfer Language
*2: It may not be possible to print jobs with excessively large amounts of data correctly.
*3: Layout templates are not supported.

iPF815 HP-GL/2 Printing
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Printing Photos and Images
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'Printing Photos and Images

Printing is easy when you simply choose the print target.

Easy Settings
2 Simply choose the printing application in the list for optimal printing results.

Print Target
Choose presets that match the type of document to be printed.

Print targets for photos and images

Print Target Description

Poster The best setting for posters. Prints using vivid and high
impact colors.

Photo (Color) Suitable for printing photographic images captured with a
digital camera.

Faithful Color Reproduc- | Prints by minimizing color differences. Suitable for when
tion the printing results are too vivid or when printing scanned
images.

Caution

* Depending on the Media Type setting, some Print Target options may not be available.
30

Note

* You can check the settings values for each print target by clicking View Settings.

* You can also fine-tune these values as needed. ( Advanced Settings )
For details on Advanced Settings, see "Giving Priority to Particular Graphic Elements and Colors for

Printing "

Printing Photos and Images iPF815
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Print Quality

Choose the print quality.
The printing mode is determined by a combination of the print quality and resolution.

Print Quality Description

Highest A setting for printing at the highest resolution when quality is most important.
Printing takes longer and consumes more ink than in other modes, but this mode
offers superior printing quality.

High Choose this setting to print at high resolution when quality is most important.
Printing takes longer and consumes more ink than in Standard or Draft modes,
but this mode offers exceptional printing quality.

Standard Choose this setting to print at standard resolution when quality and speed are both

important.

Printing takes less time than in Highest or High mode. 2
Draft Choose this setting to print faster.

Printing in draft mode can help you work more efficiently when checking layouts.

For instructions on printing photos and images, refer to the following topics, as appropriate for your computer and operating
system.

* Printing Photos and Images (Windows)
* Printing Photos and Images (Mac OS X)

'Printing Photos and Images (Windows)

This topic describes how to print photos based on the following example.
* Document: Photo image from a digital camera
» Page size: 10x12 inches (254.0x304.8 mm)
* Paper: Roll
* Paper type: Premium Glossy Paper 200
* Roll paper width: 10 inches (254.0 mm)

1 o Choose Print in the application menu.

2. Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications (Windows) ")

31
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3. Make sure the Main sheet is displayed.

4. In the A Media Type list, select the type of paper that is loaded. In this case, click Premium Glossy Paper 200.
In the A Media Type, choose the type of paper used for printing, such as Glossy Paper, Coated Paper, and so on.
Make sure the paper you select is loaded in the printer.

Note

* The paper type setting in the printer driver and related software (as well as on the Control Panel ) is
updated when you install the Media Configuration Tool from the User Software CD-ROM or if you
change paper information by using the Media Configuration Tool. For details, see Media Configura-

tion Tool EXWTTS) .

5. After confirming that L Easy Settings is selected, click Photo (Color) in the = Print Target list.

Note
* You can check the settings values selected in the = Print Target list by clicking (= View Settings.

32
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6. Click the Page Setup tab to display the Page Setup sheet.

7. In the /A Page Size list, click the size of the original as specified in the application. In this case, click 10"x12".
8. Select and click a roll paper in the L Paper Source list.
9. Select the width of the loaded roll in the IVl Roll Paper Width list—in this case, 10-in. Roll (254.0mm).

1 0. Specify additional printing conditions.
For details on available printing conditions, see "Printer Driver Settings (Windows) "

1 1 « Confirm the print settings and print as desired.

Note
* For instructions on confirming print settings, see "Confirming Print Settings (Windows) GaZ¢1[) "

'Printing Photos and Images (Mac OS X)

This topic describes how to print photos based on the following example.
* Document: Photo image from a digital camera
e Page size: 10x12 inches (254.0x304.8 mm)
* Paper: Roll paper
* Paper type: Premium Glossy Paper 200
* Roll paper width: 10 inches (254.0 mm)

iPF815 Printing Photos and Images (Mac OS X)
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Working With Various Print Jobs > Printing Photos and Images >

1 o This sets the 5 Format for and  Paper Size.

Note

* The configuration method varies depending on the OS and application software you are using.
If Page Setup is displayed in the application menu, the settings are configured by opening the Page
Attributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the /A Printer list.
3. In the = Paper Size list, click the size of the original. In this case, click 10"x12".

4. If you configured the settings using the Page Attributes dialog box, click " OK to close the dialog box, and then
select Print from the application software menu.

Printing Photos and Images (Mac OS X) iPF815
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5. Access the Main pane.

6. In the A Media Type list, select the type of paper that is loaded. In this case, click Premium Glossy Paper 200.
Make sure the paper you select is loaded in the printer.

Note

* The types of paper indicated in the printer driver and related software (as well as on the Control Pan-
el ) are updated when you install the Media Configuration Tool from the User Software CD-ROM or
if you change paper information by using the Media Configuration Tool. For details, see Media Con-
figuration Tool .

7. After confirming that L) Easy Settings is selected, click Photo (Color) in the = Print Target list.

Note
* For information on settings optimized for printing photos and images, see "Printing Photos and Im-

ages :

* You can check the settings values selected in the = Print Target list by clicking (= View set..

8. Make your selection in the I~ Print Quality list.

35
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9. Access the Page Setup pane.

1 0. Select and click a roll paper in the /A Paper Source list.

1 1 « Make sure the width of the loaded roll is displayed in the = Roll Width list—in this case, 10 in. (254.0mm).

Note

* If the width of the roll loaded in the printer is not shown in = Rell Width, click L Printer Informa-
tion on the Main pane to update the printer information.

Printing Photos and Images (Mac OS X) iPF815
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12. Make sure ( Page Size on the Page Setup pane shows the original size as specified in _ Paper Size in the Page
Attributes dialog box—in this case, 10"x12".

13 » Specify additional printing conditions.
For details on available printing conditions, see "Printer Driver Settings (Mac OS X) "

1 4. Confirm the print settings, and then click V! Print to start printing.

Note
* For tips on confirming print settings, see "Confirming Print Settings (Mac OS X) "

37
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Printing Office Documents
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'Printing Office Documents

Printing is easy when you simply choose the type of original to print.

Easy Settings
2 Simply choose the printing application in the list for optimal printing results.

Print Target
Choose presets that match the type of document to be printed.

Print targets for office documents

Print Target Description

Office Document Settings optimized for clear printing of office documents
such as handouts.

Note
* You can check the settings values for each print target by clicking View Settings.
* You can also fine-tune these values as needed. (Advanced Settings)
For details on Advanced Settings, see "Giving Priority to Particular Graphic Elements and Colors for

Printing "

Print Quality

Choose the print quality.
The printing mode is determined by a combination of the print quality and resolution.

Print Quality Description

Highest A setting for printing at the highest resolution when quality is most important.
38 Printing takes longer and consumes more ink than in other modes, but this mode
offers superior printing quality.

High Choose this setting to print at high resolution when quality is most important.
Printing takes longer and consumes more ink than in Standard or Draft modes,
but this mode offers exceptional printing quality.

Standard Choose this setting to print at standard resolution when quality and speed are both
important.
Printing takes less time than in Highest or High mode.

Draft Choose this setting to print faster.
Printing in draft mode can help you work more efficiently when checking layouts.

Printing Office Documents iPF815
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For instructions on printing office documents, refer to the following topics, as appropriate for your computer and operating
system.

* Printing Office Documents (Windows)
* Printing Office Documents (Mac OS X)

'Printing Office Documents (Windows)

This topic describes how to print office documents based on the following example.

* Document: Office document created using word-processing or spreadsheet programs

e Page size: A4 (210.0 x 297.0 mm [8.3 x 11.7 in])

 Paper: Sheets

* Paper type: Plain Paper 2
 Paper size: A4 (210.0 x 297.0 mm [8.3 x 11.7 in])

1 « Choose Print in the application menu.

2. Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications (Windows) ")

3. Make sure the Main sheet is displayed.

39

4. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.

iPF815 Printing Office Documents (Windows)
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5. After confirming that L) Easy Settings is selected, click Office Document in the = Print Target list.

Note
* You can check the settings values selected in the = Print Target list by clicking (= View Settings.

6. Click the Page Setup tab to display the Page Setup sheet.

7. In the A Page Size list, click the size of the original as specified in the application. In this case, click ISO A4.
8. Click Cut Sheet in the L. Paper Source list.

9. Specify additional printing conditions.
For details on available printing conditions, see "Printer Driver Settings (Windows) "

1 0. Confirm the print settings and print as desired.

Note
* For tips on confirming print settings, see "Confirming Print Settings (Windows) "

40

'Printing Office Documents (Mac OS X)

This topic describes how to print office documents based on the following example.
* Document: Office document created using word-processing or spreadsheet programs
e Page size: A4 (210.0 x 297.0 mm [8.3 x 11.7 in])
* Paper: Sheets
* Paper type: Plain Paper

Printing Office Documents (Mac OS X) iPF815
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* Paper size: A4 (210.0 x 297.0 mm [8.3 x 11.7 in])

1 o This sets the 5 Format for and © Paper Size.

Note

* The configuration method varies depending on the OS and application software you are using.
If Page Setup is displayed in the application menu, the settings are configured by opening the Page
Attributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the /A Printer list.

3. In the = Paper Size list, click the size of the original. In this case, click ISO A4 - for Paper Tray (Large Mar-
gins).

4. If you configured the settings using the Page Attributes dialog box, click I~ OK to close the dialog box, and then
select Print from the application software menu.

iPF815 Printing Office Documents (Mac OS X)
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5. Access the Main pane.

6. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.

7. After confirming that L) Easy Settings is selected, click Office Document in the = Print Target list.

Note
* You can check the settings values selected in the = Print Target list by clicking (5 View set..

8. Make your selection in the = Print Quality list.

Printing Office Documents (Mac OS X)
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9. Access the Page Setup pane.

1 0. Click Cut Sheet in the /~ Paper Source list.

1 1. Make sure the  Page Size setting matches the original size as selected in _ Paper Size in the Page Attributes
dialog box—in this case, ISO A4 - for Paper Tray (Large Margins).

43

1 2. Specify additional printing conditions.
For details on available printing conditions, see "Printer Driver Settings (Mac OS X) "

iPF815 Printing Office Documents (Mac OS X)
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Working With Various Print Jobs > Printing Office Documents >

13 « Confirm the print settings, and then click IVl Print to start printing.

Note
* For tips on confirming print settings, see "Confirming Print Settings (Mac OS X) "

Printing Office Documents (Mac OS X)
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Enhanced Printing Options

Adjusting Images

Choosing Paper for Printing

Printing enlargements or reductions
Printing at full size

Borderless Printing

Printing banners or at other non-standard sizes
Tiling and multiple pages per sheet
Centering originals

Conserving roll paper

Using PosterArtist to Compose Originals
Checking Images Before Printing

Other useful settings

46
64
65
85

100

115

133

154

167

181

184

186
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Adjusting Images
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Giving Priority to Particular Graphic Elements and Colors for Printing ............ccccocoeeiiiiiieie e, 55
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'Adjusting the Color in the Printer Driver

Color settings specified in the application for your documents are essentially given priority over other settings for each print
job, but further color adjustment is possible in the printer driver.

3 Color Mode
Choose how the printer driver processes color, as desired.
The available options vary depending on the color mode.
Color Mode Description Color Adjustment

Color Print in color. You can adjust the color balance and color-
matching method.

Monochrome Print in grayscale. You can adjust the color balance.

Color (CAD) A color mode optimized for line You can adjust the color balance.
drawings (2D-CAD). Lines in
red, yellow, and other colors are
printed especially clearly.

Monochrome (BK ink) A color mode for printing line You can adjust the color balance.
drawings. Only Black ink is used.

Monochrome Bitmap Print in a color mode for CAD, No color adjustment is supported.
using Color Ink, with all non-
white portions printed in black.

No color correction (*1) Prints without performing color- You can adjust the color balance.
matching in the printer driver.

*1: If No color correction is selected, the Matching sheet / Matching pane is not displayed.

Color Adjustment

You can adjust colors separately for images, graphics, and text documents.

46 Adjustment ltem Description
Cyan Fine-tune color tones by adjusting the levels of Cyan, Magenta, and Yellow.
Magenta
Yellow
Gray Tone Adjust the grayscale, in a range from cool, blue tones to warm, red tones.
Brightness Adjust the brightness of printed images while keeping the darkest and lightest por-
tions intact.
Adjusting the Color in the Printer Driver iPF815
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Adjustment Item

Contrast

Saturation

Note

* Click Object Adjustment to open the Object Adjustment dialog box, which allows you to select the color

Description

Adjust the contrast of the darkest and lightest portions relative to each other.
For soft gradation, decrease the contrast. For hard gradation, increase the contrast.

Adjust the level of color saturation, in a range from subdued to vivid.

adjustment target from Image, Graphics, and Text.

Matching

You can choose the color-matching mode and method.

By adjusting the color-matching mode and method, you can make printed colors match the colors of on-screen images more

closely.

Matching Mode
Driver Matching Mode

ICC Matching Mode

Driver ICM Mode

Host ICM Mode

ColorSync

Matching Method
Auto

Perceptual

Description

Enables printing of optimal color tones
using a driver specific color profile.

Enables color matching using ICC pro-
files.

Select this if you want to print by speci-
fying the input profile, printer profile,
and matching method in detail.

Enables color matching by the printer
driver using the ICM function of printer
driver.

Select this if you want to print by only
specifying the matching method.

Enables color matching by the host
computer using the ICM function of
Windows.

Select this if you want to print from an
application that supports the ICM func-
tion.

Enables color matching by using the
ColorSync function of Mac OS.

Select this if you want to perform soft
proofing using ColorSync before print-
ing.

Description

Color-matching optimized for images,
graphics, or text.

Color-matching optimized for printing
typical photos attractively. Smooth gra-
dation is a feature. This is also an easy-
to-use mode when performing color ad-
justment using application software.

Remarks

You should normally select this mode.

This allows you to use ICC profiles for
digital cameras and scanners, ICC pro-
files created using the profile creation
tool, etc.

Available when using Windows.

Available when using Mac OS.

Remarks

The available options and their display
order vary depending on your selected
color-matching mode, as well as the op-
erating system.

iPF815
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Matching Method Description Remarks
Colorimetric Color-matching optimized for printing The available opti(')ns and their display
image data with accurate colors in input | order vary df:pendlng on your selected
color space. This is the easiest-to-use color-matching mode, as well as the op-

mode when you want to adjust the color | erating system.
and print. However, gradation may be

lost for colors of wider range than the

color reproduction range of the printer.

Generally, this is also called relative

colorimetric.
Colorimetric (No Wht-pnt The processing method of color-match-
Corr) ing is identical to Colorimetric. Use this

when you want to further reproduce the
target paper material color of the image
data. Generally, this also is called abso-
lute colorimetric.

3 Saturation Color-matching optimized for printing
posters, etc., vividly.

Note

* Be sure to calibrate your monitor colors correctly if you adjust the colors for printing. If monitor colors are
not calibrated correctly, you may not obtain the desired printing results. For instructions on monitor calibra-
tion, refer to the documentation for your monitor and operating system.

For instructions on color adjustment, refer to the following topics, as appropriate for your computer and operating system.

* Fine-Tuning Colors of Photos and Images (Windows)
* Fine-Tuning Colors of Photos and Images (Mac OS X)

'Fine-Tuning Colors of Photos and Images (Windows)

You can specify your own print settings instead of using the Print Target presets. This topic describes how to fine-tune the
color tone of photos before printing.

1 o Choose Print in the application menu.

2. Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications (Windows) ")

48

Fine-Tuning Colors of Photos and Images (Windows) iPF815

Downloaded from ManualsPrinter.com Manuals



http://www.manualsprinter.com

Enhanced Printing Options > Adjusting Images >

3. Make sure the Main sheet is displayed.

4. In the A Media Type list, select the type of paper that is loaded.

5. Click U Advanced Settings to switch the print mode.

6. Click Color in the (5 Color Mode list.

iPF815 Fine-Tuning Colors of Photos and Images (Windows)
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7. Click Il Color Settings to display the Color Settings dialog box.

8. On the Color Adjustment sheet, adjust the color tones, brightness, and so on as desired.

Adjustment Item Description
Cyan Fine-tune color tones by adjusting the levels of Cyan, Magenta, and Yellow.
Magenta
Yellow
Gray Tone Adjust the gray tone to suit the images of monochrome photos. Choose cool black

(tinged with blue), pure black (neutral), warm black (tinged with red), and so on.
Select the color tone in the color region or from the list.

Brightness Adjust the brightness of printed images while keeping the darkest and lightest por-
tions intact.
Contrast Adjust the contrast of the darkest and lightest portions relative to each other.
For soft gradation, decrease the contrast. For hard gradation, increase the contrast.
Saturation Adjust the level of color saturation, in a range from subdued to vivid.
Note
50 ¢ Click Object Adjustment to open the Object Adjustment dialog box, which allows you to select the

color adjustment target from Image, Graphics, and Text.

9. Close the Color Settings dialog box.

Fine-Tuning Colors of Photos and Images (Windows) iPF815
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1 0. Click the Page Setup tab to display the Page Setup sheet.

1 1 « Confirm the settings of /\ Page Size, .- Paper Source, and so on.

1 2. Confirm the print settings and print as desired.

Note
* For tips on confirming print settings, see "Confirming Print Settings (Windows) "
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'Fine-Tuning Colors of Photos and Images (Mac OS X)

You can specify your own print settings instead of using the Print Target presets. This topic describes how to fine-tune the
color tone of photos before printing.

1 o This sets the 5 Format for and  Paper Size.

Note

* The configuration method varies depending on the OS and application software you are using.
If Page Setup is displayed in the application menu, the settings are configured by opening the Page
Attributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the /A Printer list.
52 3. Choose the original size in the I~ Paper Size list.

4. If you configured the settings using the Page Attributes dialog box, click " OK to close the dialog box, and then
select Print from the application software menu.

Fine-Tuning Colors of Photos and Images (Mac OS X) iPF815
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5. Access the Main pane.

6. In the A Media Type list, select the type of paper that is loaded.

7. Click U Advanced Settings to switch the print mode.

8. click Color in the H Color Mode list.

iPF815 Fine-Tuning Colors of Photos and Images (Mac OS X)
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9. Click ! Set to display the Color Settings dialog box.

1 O. On the Color Adjustment pane, adjust the color tones, brightness, and so on as desired.

Adjustment ltem Description
Cyan Fine-tune color tones by adjusting the levels of Cyan, Magenta, and Yellow.
Magenta
Yellow
Gray Tone Adjust the gray tone to suit the images of monochrome photos. Choose cool black

(tinged with blue), pure black (neutral), warm black (tinged with red), and so on.
Select the color tone in the color region or from the list.

Brightness Adjust the brightness of printed images while keeping the darkest and lightest por-
tions intact.
Contrast Adjust the contrast of the darkest and lightest portions relative to each other.
For soft gradation, decrease the contrast. For hard gradation, increase the contrast.
Saturation Adjust the level of color saturation, in a range from subdued to vivid.
Note
54 * Click Object Adjustment to open the Object Adjustment dialog box, which allows you to select the

color adjustment target from Images, Graphics, and Text.

1 1 o Click OK to close the Color Settings dialog box.

Fine-Tuning Colors of Photos and Images (Mac OS X) iPF815
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12. Access the Page Setup pane.

13. Confirm the settings of /A Paper Source and _ Page Size.

1 4. Confirm the print settings, and then click IVl Print to start printing.

Note
* For tips on confirming print settings, see "Confirming Print Settings (Mac OS X) "

'Giving Priority to Particular Graphic Elements and Colors for Printing

You can specify detailed print settings as desired for the quality level, colors, and other criteria.

Advanced Settings

For printing results that appear just as expected for your original, you can specify which graphic elements and colors to
prioritize for printing.

Note

 Easy Settings are also available, providing convenient presets. To use the presets, simply choose the printing
application.

For details on Easy Settings, refer to the following topics.
« Printing Photos and Images

* Printing Line Drawings and Text

* Printing Office Documents

55

Print Priority

Choose the graphic elements that you want to emphasize for printing.
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Print Priority (*1)

Image

Line Drawing/Text

Office Document

Description

A setting for posters or other documents made up mainly of photos or images, or
for emphasizing photos or images in printed documents.

Choose this setting for CAD drawings made up mainly of intricate lines, or wall

newspapers and other notices with a large amount of text. Suitable for emphasizing

detailed text in printed documents.

However, the quality may not be sufficient when printing photos or images that re-

quire a lot of color coverage. In this case, choose Image instead.

Choose this setting for better legibility of documents combining text and graphics,
such as documents and presentation material created with typical office applica-

tions.

*1: Options suitable for the selected type of paper are listed under Print Priority.

Print Quality
3 Choose the print quality.

The printing mode is determined by a combination of the print quality and resolution.

Print Quality (*1)
Highest

High

Standard

Draft

Description

A setting for printing at the highest resolution
when quality is most important. Printing takes
longer and consumes more ink than in other
modes, but this mode offers superior printing
quality.

Choose this setting to print at high resolution
when quality is most important.

Printing takes longer and consumes more ink
than in Standard or Draft modes, but this
mode offers exceptional printing quality.

Choose this setting to print at standard resolu-
tion when quality and speed are both impor-
tant.

Printing takes less time than in Highest or
High mode.

Choose this setting to print faster.
Printing in draft mode can help you work
more efficiently when checking layouts.

*1: Options suitable for the selected Print Priority are listed under Print Quality.

Color Settings

- Setting ltem

Color Mode (*1)

Print Priority

Image

Image
Line Drawing/Text

Image
Line Drawing/Text
Office Document

Image
Line Drawing/Text

Options Description
Color Choose whether to print in color or mono-
Monochrome chrome.
Color (CAD) (See "Adjusting the Color in the Printer
Monochrome (BK ink) Driver ")

Monochrome Bitmap
No color correction

Giving Priority to Particular Graphic Elements and Colors for Printing
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Setting ltem
Color Adjustment

Color-Matching Modes

Color-Matching Method (*2)

Options Description
Cyan You can adjust the levels of cyan, magenta,
Magenta and yellow as well as the brightness, contrast,
Yellow saturation, and gray tones.
Gray Tone If you choose Monochrome or Monochrome
Brightness (BK ink) in Color Mode only Brightness
Contrast and Contrast can be adjusted.
Saturation Image, Graphics, and Text are available as

Object Adjustment options.

Driver Matching Mode Choose the color-matching mode.
ICC Matching Mode

Driver ICM Mode (Windows)
Host ICM Mode (Windows)
ColorSync (Mac OS X)

Auto Choose the color-matching method. The
Perceptual available options vary depending on your se-
Colorimetric lection in Color-Matching Mode.
Colorimetric (No Wht-pnt

Corr)

Saturation

*1: Options suitable for the selected Print Priority are listed under Color Mode.
*2: The order of options displayed varies depending on the operating system.

Enhancing printing quality

Setting Item

Unidirectional Printing
Thicken Fine Lines

Sharpen Text
Reduce Print Unevenness (*1)

Economy Printing

*1: Displayed in Mac OS X.

Note

Description

Choosing unidirectional printing can improve printing results if lines are printed
crooked or images are uneven. However, this takes more time than regular printing.

Choose this option to make fine lines clearer in CAD drawings or similar docu-
ments.

Choose this option to print intricate text more distinctly.

Choose this option to counteract uneven printing.

When this mode is selected, less ink is consumed than in regular printing, but the
quality is diminished.

Select this mode if you want to conserve ink when checking drawings, for example.

Depending on the Media Type and Print Quality settings, this mode may not be
available.

* To print at a higher level of quality, in the printer driver, choose High or Highest in Print Quality, and
choose Unidirectional Printing as the direction of printing.

For instructions on specifying the print quality and color settings before printing, refer to the following topics, as appropri-

ate for your computer and operating system.

* Choosing the Document Type and Printing Conditions (Windows)
» Choosing the Document Type and Printing Conditions (Mac OS X)

iPF815 Giving Priority to Particular Graphic Elements and Colors for Printing
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'Choosing the Document Type and Printing Conditions (Windows)

You can specify your own print settings instead of using the Print Target presets. As an example, this topic describes how
to print CAD drawings as clearly as possible, with sharp lines and text.

1 « Choose Print in the application menu.

2. Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications (Windows) ")

3. Make sure the Main sheet is displayed.

4. In the A Media Type list, select the type of paper that is loaded.

Choosing the Document Type and Printing Conditions (Windows) iPF815
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5. Click U Advanced Settings to switch the print mode.

6. Click Line Drawing/Text in the = Print Priority list.

7]. Click High (1200dpi) in the F Print Quality list.

Note

* Options displayed in the ~ Print Quality list vary depending on the paper type.

8. Click Color (CAD) in the (5 Color Mode list.

9. To adjust the color, click I Color Settings.

Note

* For instructions on adjusting color, see "Adjusting the Color in the Printer Driver "

1 0. Select the . Sharpen Text check box.

iPF815
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Enhanced Printing Options > Adjusting Images >

1 1 o Click the Page Setup tab to display the Page Setup sheet.

12. Confirm the settings of /A Page Size, . Paper Source, and so on.

13 o Confirm the print settings and print as desired.

Note
* For tips on confirming print settings, see "Confirming Print Settings (Windows) "

Choosing the Document Type and Printing Conditions (Windows)
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'Choosing the Document Type and Printing Conditions (Mac OS X)

You can specify your own print settings instead of using the Print Target presets. As an example, this topic describes how
to print CAD drawings as clearly as possible, with sharp lines and text.

1 o This sets the 5 Format for and © Paper Size.

Note

* The configuration method varies depending on the OS and application software you are using.
If Page Setup is displayed in the application menu, the settings are configured by opening the Page
Attributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the /A Printer list.
3. Choose the original size in the I~ Paper Size list. 61

4. If you configured the settings using the Page Attributes dialog box, click " OK to close the dialog box, and then
select Print from the application software menu.

iPF815 Choosing the Document Type and Printing Conditions (Mac OS X)
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5. Access the Main pane.

6. In the A Media Type list, select the type of paper that is loaded.

7. Click U Advanced Settings to switch the print mode.

8. Click Line Drawing in the = Print Priority list.

Choosing the Document Type and Printing Conditions (Mac OS X)
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9. Click High(1200dpi) in the F Print Quality list.

Note
* Options displayed in the ~ Print Quality list vary depending on the type of paper.

1 0. Click Color (CAD) in the | Color Mode list.

1 1 « To adjust the color, click | Set.

Note
* For instructions on adjusting color, see "Adjusting the Color in the Printer Driver "

12. Access the Page Setup pane.

13. Confirm the settings of /A Paper Source and  Page Size.

1 4. Confirm the print settings, and then click IVl Print to start printing.

Note
* For tips on confirming print settings, see "Confirming Print Settings (Mac OS X) "

iPF815 Choosing the Document Type and Printing Conditions (Mac OS X)
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Choosing Paper for Printing

Choosing @ Paper fOr PINTING .....coooiiiiiiie ittt e e et e e e e e ettt e e e e e snnbae e e e e e snseeeaeeesssaeeeeenannees 64
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'Choosing a Paper for Printing

Choosing the right paper for your particular printing application will give you the best printing results.

Media Type

The printer and printer driver offer print settings optimized for various paper characteristics.

Note
3 * For information on the types of paper the printer supports, refer to the Paper Reference Guide.(See "Types of

Paper ")

* The types of paper indicated in the printer driver and related software (as well as on the Control Panel ) are
updated when you install the Media Configuration Tool from the User Software CD-ROM or if you change
paper information by using the Media Configuration Tool. For information about the Media Configuration
Tool, see the Media Configuration Tool (Windows) or Media Configuration Tool
(Macintosh).

e An error message may be displayed on the printer Control Panel if the type of paper as specified in the print-
er driver does not match the type specified on the printer. Although you can print under these conditions, the
printing results may not be suitable.

If the paper type is not listed for selection

If the type of paper loaded cannot be selected, try specifying glossy paper or proofing paper as a special paper (Special 1 to
Special 5, in this order). BK ( Black Ink ) is used as the black ink. Try specifying other types of paper as Special 6 to Spe-
cial 10. MBK ( Matte Black Ink ) is used as the black ink. Note that higher numbers in this setting enable more vivid colors

but may also cause colors to run together.
For instructions on specifying the type of paper before printing, refer to the following topics.

« Selecting the Paper Type (Roll)
« Selecting the Paper Type (Sheet)

'Specifying Paper in the Printer Driver

If you replace the paper, complete the printer driver settings for the paper type and size.
For instructions on configuring paper settings in the printer driver, refer to the following topics, as appropriate for your

computer and operating system.
* Specifying Paper in the Printer Driver (Windows)
* Specifying Paper in the Printer Driver (Mac OS X)

64
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Printing enlargements or reductions
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Resizing Originals to Match the Paper Size (WINAOWS) ........ccooiiiiiiiiiiiiieee e 65
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'Resizing Originals to Match the Paper Size

You can freely adjust the size of originals by enlarging or reducing them as desired.

Enlarged/Reduced Printing

Enlarge or reduce the original in the printer driver, as desired.

Fit Paper Size

Enlarge or reduce the original to match the size of the paper you are using.

For instructions on resizing originals to match the paper size, refer to the following topics, as appropriate for your computer
and operating system.

* Resizing Originals to Match the Paper Size (Windows)
 Resizing Originals to Match the Paper Size (Mac OS X)

Note

* For better printing results when enlarging photos from a digital camera in TIFF or JPEG format, use an im-
age-editing application software such as Adobe Photoshop to specify an image resolution of 150 dpi or more
at actual size.

'Resizing Originals to Match the Paper Size (Windows)

This topic describes how to enlarge originals before printing to match the paper size, based on the following example.

* Document: Any Type

iPF815 Resizing Originals to Match the Paper Size
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* Page size: A4 (210.0x297.0mm)/Letter (8.3 x 11.7 in)
* Paper: Roll

* Paper type: Plain Paper

* Roll paper width: A2/A3 roll (420.0 mm [16.5 in])

1 o Choose Print in the application menu.

2. Select the printer in the dialog box, and then open the printer driver dialog box.(See "Accessing the Printer Driver
Dialog Box from Applications (Windows) ")

3. Make sure the Main sheet is displayed.

4. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.

5. Select the printing application in the = Print Target list.

Resizing Originals to Match the Paper Size (Windows) iPF815
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6. Click the Page Setup tab to display the Page Setup sheet.

7. Select and click a roll paper in the . Paper Source list.
8. Select the width of the loaded roll in the VI Roll Paper Width list—in this case, ISO A2/A3 Roll (420.0mm).
9. In the /A Page Size list, click the size of the original as specified in the application. In this case, click ISO A4.
1 0. Select the © Enlarged/Reduced Printing check box.
1 1 o Select the L) Fit Paper Size check box.
12. Click 1S0 A3 in the G Paper Size list.

13 o Confirm the print settings and print as desired.

Note
* For tips on confirming print settings, see "Confirming Print Settings (Windows) "

'Resizing Originals to Match the Paper Size (Mac OS X)

This topic describes how to enlarge originals before printing to match the paper size, based on the following example.

e Document: Any Type
* Page size: A4 (210.0 x 297.0 mm [8.3 x 11.7 in])
* Paper: Roll paper

iPF815 Resizing Originals to Match the Paper Size (Mac OS X)
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* Paper type: Plain Paper
* Roll paper width: A2/A3 roll (420.0 mm [16.5 in])

1 o This sets the 5 Format for and  Paper Size.

Note

* The configuration method varies depending on the OS and application software you are using.
If Page Setup is displayed in the application menu, the settings are configured by opening the Page
Attributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the /A Printer list.
3. In the = Paper Size list, click the size of the original. In this case, click ISO A4.

4. If you configured the settings using the Page Attributes dialog box, click " OK to close the dialog box, and then
select Print from the application software menu.

Resizing Originals to Match the Paper Size (Mac OS X) iPF815
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5. Access the Main pane.

« Inthe A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.

7. Make your selection in the = Print Target list.
8. Make your selection in the I~ Print Quality list.

« Access the Page Setup pane.

1 0. Select and click a roll paper in the /A Paper Source list.

iPF815 Resizing Originals to Match the Paper Size (Mac OS X)
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1 1 « Make sure the width of the loaded roll is displayed in the = Roll Width list—in this case, ISO A2/A3 (420.0mm).

Note

o If the width of the roll loaded in the printer is not shown in = Rell Width, click L Printer Informa-
tion on the Main pane to update the printer information.

12. Make sure  Page Size on the Page Setup pane shows the original size as specified in _ Paper Size in the Page
Attributes dialog box—in this case, ISO A4.

13 « Select the L) Enlarged/Reduced Printing check box.

14. Make sure = Fit Paper Size is selected.

Resizing Originals to Match the Paper Size (Mac OS X) iPF815
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15. Click 1SO A3 in the | Paper Size list.

1 6. Confirm the print settings, and then click IVl Print to start printing.

Note
* For tips on confirming print settings, see "Confirming Print Settings (Mac OS X) "

'Resizing Originals to Fit the Roll Width

You can freely adjust the size of originals by enlarging or reducing them as desired.

Enlarged/Reduced Printing

Enlarge or reduce the original in the printer driver, as desired.

Fit Roll Paper Width

Enlarge or reduce the original as a whole to match the roll paper width, as desired.

For instructions on resizing originals to match the roll paper width, refer to the following topics, as appropriate for your
computer and operating system.

* Resizing Originals to Fit the Roll Width (Windows)
* Resizing Originals to Fit the Roll Width (Mac OS X)

Note

* For better printing results when enlarging photos from a digital camera in TIFF or JPEG format, use an im-
age-editing application software such as Adobe Photoshop to specify an image resolution of 150 dpi or more
at actual size.

'Resizing Originals to Fit the Roll Width (Windows)

This topic describes how to enlarge originals before printing to match the roll width, based on the following example.
* Document: Any type
* Page size: A4 (210.0x297.0 mm)/Letter (8.3 x 11.7 in)

iPF815 Resizing Originals to Fit the Roll Width
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 Paper: Roll
* Paper type: Plain Paper
* Roll paper width: 16 inches (406.4 mm)

1 « Choose Print in the application menu.

2. Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications (Windows) ")

3. Make sure the Main sheet is displayed.

4. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.

5. Select the printing application in the L= Print Target list.

Resizing Originals to Fit the Roll Width (Windows) iPF815
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6. Click the Page Setup tab to display the Page Setup sheet.

7. Select and click a roll paper in the . Paper Source list.

8. In the A Page Size list, click the size of the original as specified in the application. In this case, click ISO A4 or
Letter (8.5"x11").
9. Select the (~ Enlarged/Reduced Printing check box.

Note
e If the  Enlarged/Reduced Printing check box is not displayed on the Page Setup sheet, clear the

Borderless Printing check box.
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10. ciick E Fit Roll Paper Width.

Note

* After you click = Fit Roll Paper Width, the Information dialog box is displayed. Select the width
of the loaded roll in the Roll Paper Width list and click OK.

e Make sure the roll paper width you specify matches the width of the loaded roll.

1 1 o Confirm the print settings and print as desired.

Note
* For tips on confirming print settings, see "Confirming Print Settings (Windows) "

'Resizing Originals to Fit the Roll Width (Mac OS X)

This topic describes how to enlarge originals before printing to match the roll width, based on the following example.
* Document: Any Type
e Page size: A4 (210.0 x 297.0 mm [8.3 x 11.7 in])
74 * Paper: Roll paper
* Paper type: Plain Paper
* Roll paper width: 16 inches (406.4 mm)

Resizing Originals to Fit the Roll Width (Mac OS X) iPF815
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1 o This sets the 5 Format for and  Paper Size.

Note

* The configuration method varies depending on the OS and application software you are using.
If Page Setup is displayed in the application menu, the settings are configured by opening the Page
Attributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the /A Printer list.
3. In the = Paper Size list, click the size of the original. In this case, click ISO A4.
4. If you configured the settings using the Page Attributes dialog box, click " OK to close the dialog box, and then

select Print from the application software menu.
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5. Access the Main pane.

« Inthe A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.

7. Make your selection in the = Print Target list.
8. Make your selection in the I~ Print Quality list.

« Access the Page Setup pane.

1 0. Select and click a roll paper in the /A Paper Source list.

Resizing Originals to Fit the Roll Width (Mac OS X)
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1 1 « Make sure the width of the loaded roll is displayed in the = Roll Width list—in this case, 16 in. (406.4mm).

Note

o If the width of the roll loaded in the printer is not shown in = Rell Width, click L Printer Informa-
tion on the Main pane to update the printer information.

12. Make sure the ( Page Size setting matches the original size as selected in _ Paper Size in the Page Attributes
dialog box—in this case, ISO A4.

13 « Select the L) Enlarged/Reduced Printing check box.
1 4. Click I~ Fit Roll Paper Width.

1 5. Confirm the print settings, and then click IVl Print to start printing.

Note
* For tips on confirming print settings, see "Confirming Print Settings (Mac OS X) "

'Resizing Originals by Entering a Scaling Value

You can freely adjust the size of originals by enlarging or reducing them as desired.

77
Enlarged/Reduced Printing

Enlarge or reduce the original in the printer driver, as desired.

iPF815 Resizing Originals by Entering a Scaling Value
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Scaling

Enlarge or reduce originals by a particular amount, as desired.

For instructions on entering a scaling value to resize originals, refer to the following topics, as appropriate for your comput-
er and operating system.
3 * Resizing Originals by Entering a Scaling Value (Windows)
 Resizing Originals by Entering a Scaling Value (Mac OS X)

Note

e For better printing results when enlarging photos from a digital camera in TIFF or JPEG format, use an im-
age-editing application software such as Adobe Photoshop to specify an image resolution of 150 dpi or more
at actual size.

'Resizing Originals by Entering a Scaling Value (Windows)

This topic describes how to enlarge originals before printing by entering a scaling value, based on the following example.
e Document: Any Type
» Page size: A4 (210.0 x 297.0 mm [8.3 x 11.7 in])
* Paper: Roll paper
* Paper type: Plain Paper
* Roll paper width: A2/A3 roll (420.0 mm [16.5 in])

@ Important
* In borderless printing, you cannot resize originals by entering a scaling value.

1 « Choose Print in the application menu.

2. Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-

-8 er Dialog Box from Applications (Windows) ")

Resizing Originals by Entering a Scaling Value (Windows) iPF815
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3. Make sure the Main sheet is displayed.

4. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.
5. Select the printing application in the = Print Target list.

6. Click the Page Setup tab to display the Page Setup sheet.

iPF815 Resizing Originals by Entering a Scaling Value (Windows)
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7. Select and click a roll paper in the L. Paper Source list.
8. Select the width of the loaded roll in the VI Roll Paper Width list—in this case, ISO A2/A3 Roll (420.0mm).
9. In the /A Page Size list, click the size of the original as specified in the application. In this case, click ISO A4.
1 0. Select the & Enlarged/Reduced Printing check box.
11. Click 10 A4 in the G Paper Size list.

12. Click I~ Scaling and enter 120.

Note

* You can specify enlargement that exceeds the paper size, but in this case, the portions off the bottom
and right edges of the paper will not be printed.

* If the original size after enlargement or reduction is smaller than the paper size, the original is printed
in the upper-left corner. In this case, you can center originals by selecting = Print Centered on the
Layout sheet.

13 o Confirm the print settings and print as desired.

Note
* For tips on confirming print settings, see "Confirming Print Settings (Windows) "

'Resizing Originals by Entering a Scaling Value (Mac OS X)

This topic describes how to enlarge originals before printing by entering a scaling value, based on the following example.

* Document: Any Type

Resizing Originals by Entering a Scaling Value (Mac OS X) iPF815
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* Page size: A4 (210.0 x 297.0 mm [8.3 x 11.7 in])
* Paper: Roll paper

* Paper type: Plain Paper

* Roll paper width: A2/A3 roll (420.0 mm [16.5 in])

1 o This sets the 5 Format for and © Paper Size.

Note

* The configuration method varies depending on the OS and application software you are using.
If Page Setup is displayed in the application menu, the settings are configured by opening the Page
Attributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the /A Printer list.

81
3. In the = Paper Size list, click the size of the original. In this case, click ISO A4.

4. If you configured the settings using the Page Attributes dialog box, click " OK to close the dialog box, and then
select Print from the application software menu.

iPF815 Resizing Originals by Entering a Scaling Value (Mac OS X)
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5. Access the Main pane.

« Inthe A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.

7. Make your selection in the = Print Target list.
8. Make your selection in the I~ Print Quality list.

« Access the Page Setup pane.

1 0. Select and click a roll paper in the /A Paper Source list.

Resizing Originals by Entering a Scaling Value (Mac OS X)
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1 1 « Make sure the width of the loaded roll is displayed in the = Roll Width list—in this case, ISO A2/A3 (420.0mm).

Note

o If the width of the roll loaded in the printer is not shown in = Rell Width, click L Printer Informa-
tion on the Main pane to update the printer information.

12. Make sure the  Page Size setting matches the original size as selected in © Paper Size in the Page Attributes
dialog box—in this case, ISO A4.

83

13 « Select the L) Enlarged/Reduced Printing check box.
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14. Click (5 Scaling and enter 120.

Note

* You can specify enlargement that exceeds the paper size, but in this case, the portion off the edge of
the paper will not be printed.

* If the original size after enlargement or reduction is smaller than the paper size, the original is printed

in the upper-left corner. In this case, you can center originals by selecting the ) Print Centered
check box.

1 5. Confirm the print settings, and then click IVl Print to start printing.

Note
* For tips on confirming print settings, see "Confirming Print Settings (Mac OS X) "

Resizing Originals by Entering a Scaling Value (Mac OS X) iPF815
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Printing at full size

Printing 0N OVEISIZEA PAPET ........oviiiiiiiiieiie ettt e e e ettt e e e s e et e e e e e e s ntbaeeeeeannsbeeeaeeeassaeeaeeeannnees 85
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Borderless Printing at Actual Size (WINAOWS) .......cooiiiiiiiiiiie et 92
Borderless Printing at Actual Size (Mac OS X) ....c.uuiiiiiiiiiiiie ettt snee e 95

'Printing on Oversized Paper

Except in borderless printing, the actual printing area corresponds to your selected paper size minus the space for a margin

(See "Print Area "). To print documents or images you prepare without a margin at actual size, use an oversized

paper size.

For example, to print a A4-sized original without a margin at A4 size, print it on paper larger than A4 size and cut away the 3
excess margin.

Note
* If you prepare an original for printing without a margin and print it on paper of regular size, the image near
the edge will not be printed.

Oversize

The margin required by the printer is added around the outside of a regular paper size. For example, when printing a A4-
sized original (210x297 mm), you have the following options.

* (a) Regular paper size: Gray area not printed
 (b) Page Size

* (c) Oversized paper size: Print area matches the page size (b) 85

Important
@ » When printing on oversize paper, load paper larger than the page size—a size that includes the margin re-
quired by the printer.

* Sheets: Load paper that is at least 6 mm (0.24 in) wider and 26 mm (1 in) higher than the page size
* Rolls: Load paper that is at least 6 mm (0.24 in) wider and 6 mm (0.24 in) higher than the page size

iPF815 Printing on Oversized Paper
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Note
e Paper larger than the maximum size supported by the printer cannot be used as paper for oversized printing.
(See "Paper Sizes ")

* To specify a non-standard paper size in oversized printing, register the paper size as a Custom Paper Size.
Oversized printing is not available with Custom Size.(See "Printing on Non-Standard Paper

Sizes BEFD) ")

For instructions on oversized printing, refer to the following topics, as appropriate for your computer and operating system.

» Printing at Full Size (Windows)
* Printing at Full Size (Mac OS X)

'Printing at Full Size (Windows)

This topic describes how to print at full size based on the following example. (Oversized Printing)

* Document: Any Type

* Page Size: A4 (210.0%297.0 mm)/Letter (8.3 x 11.7 in)
* Paper: Roll

* Paper type: Plain Paper

* Roll paper width: A2/A3 roll (420.0 mm [16.5 in])

1 « Choose Print in the application menu.

2. Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications (Windows) ")

3. Make sure the Main sheet is displayed.

86
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4. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.

5. Click the Page Setup tab to display the Page Setup sheet.

6. Click U Size Options to display the Paper Size Options dialog box.
7. In the Paper Size Options dialog box, select the Oversize check box in Display Series.
8. Click OK to close the Paper Size Options dialog box.
9. Click Oversize - ISO A4 in the /A Page Size list.
1 0. Select and click a roll paper in the . Paper Source list.
1 1 o Select the width of the loaded roll in the V! Roll Paper Width list—in this case, ISO A2/A3 Roll (420.0mm).

1 2. Confirm the print settings and print as desired.

Note 87
* For tips on confirming print settings, see "Confirming Print Settings (Windows) "

'Printing at Full Size (Mac OS X)

This topic describes how to print at full size based on the following example. (Oversized Printing)

* Document: Any Type

iPF815 Printing at Full Size (Mac OS X)
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* Page size: A4 (210.0 x 297.0 mm [8.3 x 11.7 in])
* Paper: Roll paper

* Paper type: Plain Paper

* Roll paper width: A2/A3 roll (420.0 mm [16.5 in])

1 o This sets the 5 Format for and © Paper Size.

Note

* The configuration method varies depending on the OS and application software you are using.
If Page Setup is displayed in the application menu, the settings are configured by opening the Page
Attributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the /A Printer list.
3. In I~ Paper Size, click the size of the original. In this case, click ISO A4 - Oversize.

4. If you configured the settings using the Page Attributes dialog box, click - OK to close the dialog box, and then
select Print from the application software menu.

Printing at Full Size (Mac OS X) iPF815
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5. Access the Main pane.

« Inthe A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.

7. Make your selection in the = Print Target list.
8. Make your selection in the I~ Print Quality list.

« Access the Page Setup pane.

1 0. Select and click a roll paper in the /A Paper Source list.

iPF815 Printing at Full Size (Mac OS X)
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1 1 « Make sure the width of the loaded roll is displayed in the = Roll Width list—in this case, ISO A2/A3 (420.0mm).

Note

o If the width of the roll loaded in the printer is not shown in = Rell Width, click L Printer Informa-
tion on the Main pane to update the printer information.

12. Make sure _ Page Size shows the original size as specified in  Paper Size in the Page Attributes dialog box—in
this case, ISO A4 - Oversize.

13 « Confirm the print settings, and then click V| Print to start printing.

Note
* For tips on confirming print settings, see "Confirming Print Settings (Mac OS X) "

Printing at Full Size (Mac OS X) iPF815
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'Borderless Printing at Actual Size

Take advantage of borderless printing to print documents such as posters (made up mainly of photos or images) without a
surrounding margin, or border.

Borderless Printing

In regular printing, a margin required by the printer is added around the original. With borderless printing, you can print
documents without the margin, so that the printed image covers the entire surface of the paper.

@ Important
* Borderless printing is only available with rolls.

* Paper you can use for borderless printing is restricted to particular types of paper and rolls of particular
widths. For information on types of paper compatible with borderless printing, refer to the Paper Reference
Guide. (See "Types of Paper ")

* Paper incompatible with the printer's auto cut function can be printed without borders on the left and right
sides only.

 These features cannot be used in combination with borderless printing: special page layouts, centering origi-
nals, and printing cut lines on rolls.

* If Fit Paper Size or Print Image with Actual Size (Windows only) is selected when performing borderless
printing, Rotate Page 90 degrees (Conserve Paper) cannot be selected.

* When borderless printing is used, the edge of the paper is cut during printing. Thus, ink density may be un-
even at the edges. If you require higher image quality, specify No in Auto Cut in the printer driver. In this
case, the paper can be printed without borders on the left and right sides only. After ejecting and cutting the
printed document, use scissors to cut away the top and bottom edges.

By factory default, the ink drying time is disabled for all paper. When you are using paper that takes longer
for ink to adhere for borderless printing and the Cutter Unit touches printing surfaces that are not dry yet, it
may damage the paper or the edge of the document that is cut, depending on frequency of use. In this case,
follow these steps to change the ink drying time.

1. On the Main sheet of the printer driver, click Settings in Media Type.
2. Select the ink drying time in the Between Pages list of Drying Time.

* Before borderless printing, make sure the blue Switch on the platen is set toward the ® side. (See "Setting
the Blue Switch on the Platen.")

Borderless Printing Method

Choose the method of borderless printing that suits the original, as desired.

iPF815 Borderless Printing at Actual Size
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Print Image with Actual Size

Prints originals at actual size, without enlarging or reducing them. Originals must be prepared in a size that exceeds the
dimensions of the paper by 3 mm (0.12 in) on each side.

Note
3 * Not all page sizes are available.

* Even if you prepare originals of the same size as the paper size, the originals are automatically enlarged
when you print borderlessly in combination with resizing originals to match the paper size. This may affect
image quality. When image quality is most important, make the original 3 mm longer on each side than the
paper size so that the image can be printed at actual size in borderless printing.

For instructions on borderless printing of photos and images at actual size, refer to the following topics, as appropriate for
your computer and operating system.

* Borderless Printing at Actual Size (Windows)
* Borderless Printing at Actual Size (Mac OS X)

'Borderless Printing at Actual Size (Windows)

This topic describes how to print borderlessly at actual size based on the following example.
* Document: Any type
* Page size: 10x12 inches (254.0x304.8 mm)
 Paper: Roll
* Paper type: Heavyweight Coated Paper
* Roll paper width: 10 inches (254.0 mm)

1. Create the original in the source application 3 mm (0.12 in) larger on each side than 254.0x304.8 mm (10 % 12 in)
—that is, 260.0%310.8 mm (10.2 x 12.2 in)

Note
92 :
* If you can specify the margin, as in Microsoft Word, set the margin at 0 mm. For instructions on
specifying the margin, refer to the software documentation.

* The extra 3 mm (0.12 in) on each side will not be printed. Create the original so that it fits inside the
paper area to be printed on.

2. Choose Print in the application menu.

Borderless Printing at Actual Size (Windows) iPF815
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3 « Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications (Windows) ")

4. Make sure the Main sheet is displayed.

5. In the A Media Type list, select the type of paper that is loaded. In this case, click Heavyweight Coated Paper.

6. Select the print target in the = Print Target list.

iPF815 Borderless Printing at Actual Size (Windows)
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7. Click the Page Setup tab to display the Page Setup sheet.

8. In the A Page Size list, click the size of the original as specified in the source application. In this case, click
10"x12".

9. Select and click a roll paper in the L Paper Source list.

1 0. Select the 5 Borderless Printing check box to display the Information dialog box.

Borderless Printing at Actual Size (Windows) iPF815
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1 1 o Select the width of the loaded roll in the Roll Paper Width list—in this case, click 10-in. Roll (254.0mm).
1 2. Click OK to close the Information dialog box.
13 « In C Borderless Printing Method, click - Print Image with Actual Size.

1 4. Confirm the print settings and print as desired.

Note
* For tips on confirming print settings, see "Confirming Print Settings (Windows) "

'Borderless Printing at Actual Size (Mac OS X)

This topic describes how to print borderlessly at actual size based on the following example.
e Document: Any Type
* Page size: 10 % 12 inches (254.0%x304.8 mm)—Borderless
* Paper: Roll paper
* Paper type: Heavyweight Coated Paper
* Roll paper width: 10 inches (254.0 mm)

iPF815 Borderless Printing at Actual Size (Mac OS X)
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1 o This sets the 5 Format for and  Paper Size.

Note

* The configuration method varies depending on the OS and application software you are using.
If Page Setup is displayed in the application menu, the settings are configured by opening the Page
Attributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the /A Printer list.

3. In the I~ Paper Size list, choose a paper size supported for borderless printing. Here, click 10"x12" - Borderless.

Note
* Paper sizes supported for borderless printing are indicated by —Borderless.

96
4. If you configured the settings using the Page Attributes dialog box, click " OK to close the dialog box, and then

select Print from the application software menu.

Borderless Printing at Actual Size (Mac OS X) iPF815
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5. Access the Main pane.

« Inthe A Media Type list, select the type of paper that is loaded. In this case, click Heavyweight Coated Paper.

7. Make your selection in the = Print Target list.
8. Make your selection in the I~ Print Quality list.

« Access the Page Setup pane.

1 0. Select and click a roll paper in the /A Paper Source list.

iPF815 Borderless Printing at Actual Size (Mac OS X)
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Enhanced Printing Options > Printing at full size >

1 1 « Confirm that the roll paper width matches the paper size.

Make sure the width of the loaded roll is displayed in the 5 Roll Width list—in this case, 10 in. (254.0mm).

Note

e If the width of the roll loaded in the printer is not shown in = Roll Width, click L Printer Informa-

tion on the Main pane to update the printer information.

12. Make sure the  Page Size setting matches the original size as selected in
dialog box—in this case, 10"'x12" - Borderless.

Paper Size in the Page Attributes

Borderless Printing at Actual Size (Mac OS X)
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13 « Confirm the print settings, and then click IVl Print to start printing.

Note
* For tips on confirming print settings, see "Confirming Print Settings (Mac OS X) "

iPF815 Borderless Printing at Actual Size (Mac OS X)
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Borderless Printing

Borderless Printing on Paper of EQUIVAIENT SIZE ..........uiiiiiiiiiiie ettt 100
Borderless Printing by Resizing Originals to Match the Paper Size (Windows) ........ccccocccvveiiiiiiiene e, 101
Borderless Printing by Resizing Originals to Match the Paper Size (Mac OS X) ......cccccceveeiiiiiieeee e, 103

Borderless Printing by Resizing Originals to Fit the Roll Width ............ccoooiiiiiii e, 107
Borderless Printing by Resizing Originals to Fit the Roll Width (Windows) ..........cccccceiiiiiiiin e, 108
Borderless Printing by Resizing Originals to Fit the Roll Width (Mac OS X) ......cccccciviiiiiiiee e, 110

'Borderless Printing on Paper of Equivalent Size

Take advantage of borderless printing to print documents such as posters (made up mainly of photos or images) without a
surrounding margin, or border.

Borderless Printing

In regular printing, a margin required by the printer is added around the original. With borderless printing, you can print
documents without the margin, so that the printed image covers the entire surface of the paper.

@ Important
* Borderless printing is only available with rolls.

 Paper you can use for borderless printing is restricted to particular types of paper and rolls of particular
widths. For information on types of paper compatible with borderless printing, refer to the Paper Reference
Guide. (Refer to "Types of Paper ")

Paper incompatible with the printer's auto cut function can be printed without borders on the left and right
sides only.

 These features cannot be used in combination with borderless printing: special page layouts, centering origi-
nals, and printing cut lines on rolls.

* If Fit Paper Size or Print Image with Actual Size (Windows only) is selected when performing borderless
printing, Rotate Page 90 degrees (Conserve Paper) cannot be selected.

* When borderless printing is used, the edge of the paper is cut during printing. Thus, ink density may be
slightly uneven at the edges. If you require higher image quality, specify No in Auto Cut in the printer driv-
er. In this case, the paper can be printed without borders on the left and right sides only. Cut the printed docu-
ment ejected from the printer, then use scissors to cut away the edges on the top and bottom.

By factory default, the ink drying time is disabled for all paper. When you are using paper that takes longer
for ink to adhere for borderless printing and the Cutter Unit touches printing surfaces that are not dry yet, it
may damage the paper or the edge of the document that is cut, depending on frequency of use. In this case,
follow these steps to change the ink drying time.

1. On the Main sheet of the printer driver, click Settings in Media Type.
100 2. Select the ink drying time in the Between Pages list of Drying Time.

* Before borderless printing, make sure the blue Switch on the platen is set toward the e side. (See "Setting
the Blue Switch on the Platen.")

Borderless Printing Method

Choose the method of borderless printing that suits the original, as desired.

Borderless Printing on Paper of Equivalent Size iPF815
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Fit Paper Size

Enlarge or reduce the original to match the size of the paper you are using.

Note
¢ The printer driver automatically enlarges originals 3 mm (0.12 in) past the dimensions of the paper on each
side. The 3 mm portion beyond the edge on each side is not printed.

For instructions on borderless printing of photos, images, and other documents to match the paper size, refer to the follow-
ing topics, as appropriate for your computer and operating system.

» Borderless Printing by Resizing Originals to Match the Paper Size (Windows)
 Borderless Printing by Resizing Originals to Match the Paper Size (Mac OS X)

'Borderless Printing by Resizing Originals to Match the Paper Size (Windows)
This topic describes how to enlarge originals before borderless printing to match the paper size, based on the following
example.
* Document: Any type
» Page size: 10x12 inches (254.0x304.8 mm)
* Paper: Roll
* Paper type: Heavyweight Coated Paper
* Roll paper width: 10 inches (254.0 mm)

1 « In the application, create an original that takes up the entire space of the paper size.

Note
* If you can specify the margin, as in Microsoft Word, set the margin at 0 mm. For instructions on
specifying the margin, refer to the software documentation. 101

2. Choose Print in the application menu.

3. Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications (Windows) ")

iPF815 Borderless Printing by Resizing Originals to Match the Paper Size (Windows)
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4. Make sure the Main sheet is displayed.

5. In the A Media Type list, select the type of paper that is loaded. In this case, click Heavyweight Coated Paper.
6. Select the print target in the = Print Target list.

7. Click the Page Setup tab to display the Page Setup sheet.

102
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8. In the /A Page Size list, click the size of the original as specified in the application. In this case, click 10"x12".
9. Select and click a roll paper in the L Paper Source list.

1 0. Select the 5 Borderless Printing check box to display the Information dialog box.

1 1 o Select the width of the loaded roll in the Roll Paper Width list—in this case, click 10-in. Roll (254.0mm).
1 2. Click OK to close the Information dialog box.

13. In © Borderless Printing Method, click L Fit Paper Size.

14. Click Match Page Size in the (= Paper Size list.

1 5. Confirm the print settings and print as desired.

Note
* For tips on confirming print settings, see "Confirming Print Settings (Windows) "

'Borderless Printing by Resizing Originals to Match the Paper Size (Mac OS X)

This topic describes how to enlarge originals before borderless printing to match the paper size, based on the following
example.

e Document: Any Type
e Page size: 10%12 inches (254.0x304.8 mm)

iPF815 Borderless Printing by Resizing Originals to Match the Paper Size (Mac OS X)
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* Paper: Roll paper
* Paper type: Heavyweight Coated Paper
* Roll paper width: 10 inches (254.0 mm)

1 o This sets the 5 Format for and  Paper Size.

Note

* The configuration method varies depending on the OS and application software you are using.
If Page Setup is displayed in the application menu, the settings are configured by opening the Page
Attributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the /A Printer list.

104 3. In the I~ Paper Size list, click the size of the original. In this case, click 10"x12".

Note
* All sizes are available in borderless printing if you resize originals to match the paper size.

4. If you configured the settings using the Page Attributes dialog box, click " OK to close the dialog box, and then
select Print from the application software menu.

Borderless Printing by Resizing Originals to Match the Paper Size (Mac OS X) iPF815
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5. Access the Main pane.

« Inthe A Media Type list, select the type of paper that is loaded. In this case, click Heavyweight Coated Paper.

7. Make your selection in the = Print Target list.
8. Make your selection in the I~ Print Quality list.

« Access the Page Setup pane.

105

1 0. Select and click a roll paper in the /A Paper Source list.

iPF815 Borderless Printing by Resizing Originals to Match the Paper Size (Mac OS X)
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1 1 « Make sure the width of the loaded roll is displayed in the = Roll Width list—in this case, 10 in. (254.0mm).

Note

o If the width of the roll loaded in the printer is not shown in = Rell Width, click L Printer Informa-
tion on the Main pane to update the printer information.

12. Make sure the  Page Size setting matches the original size as selected in © Paper Size in the Page Attributes
dialog box—in this case, 10" x12".

106

13. 0n the Page Setup pane, select the D Enlarged/Reduced Printing check box.

1 4. Select the I Borderless Printing check box.

Borderless Printing by Resizing Originals to Match the Paper Size (Mac OS X) iPF815
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1 5. Click = Fit Paper Size under U Enlarged/Reduced Printing.
1 6. In [ Paper Size, click the paper size. In this case, click 10"x12" - Borderless.

1 7. Confirm the print settings, and then click IVl Print to start printing.

Note
* For tips on confirming print settings, see "Confirming Print Settings (Mac OS X) "

'Borderless Printing by Resizing Originals to Fit the Roll Width

Take advantage of borderless printing to print documents such as posters (made up mainly of photos or images) without a
surrounding margin, or border.

Borderless Printing

In regular printing, a margin required by the printer is added around the original. With borderless printing, you can print
documents without the margin, so that the printed image covers the entire surface of the paper.

@ Important
* Borderless printing is only available with rolls.

 Paper you can use for borderless printing is restricted to particular types of paper and rolls of particular
widths. For information on types of paper compatible with borderless printing, refer to the Paper Reference
Guide. (See "Types of Paper ")

* Paper incompatible with the printer's auto cut function can be printed without borders on the left and right
sides only.

* These features cannot be used in combination with borderless printing: special page layouts, centering origi-
nals, and printing cut lines on rolls.

« If Fit Paper Size or Print Image with Actual Size (Windows only) is selected when performing borderless
printing, Rotate Page 90 degrees (Conserve Paper) cannot be selected.

* When borderless printing is used, the edge of the paper is cut during printing. Thus, ink density may be un-
even at the edges. If you require higher image quality, specify No in Auto Cut in the printer driver. In this
case, the paper can be printed without borders on the left and right sides only. After ejecting and cutting the
printed document, use scissors to cut away the top and bottom edges.

* By factory default, the ink drying time is disabled for all paper. When you are using paper that takes longer
for ink to adhere for borderless printing and the Cutter Unit touches printing surfaces that are not dry yet, it
may damage the paper or the edge of the document that is cut, depending on frequency of use. In this case,
follow these steps to change the ink drying time.

1. On the Main sheet of the printer driver, click Settings in Media Type.
2. Select the ink drying time in the Between Pages list of Drying Time. 107

* Before borderless printing, make sure the blue Switch on the platen is set toward the ® side. (See "Setting
the Blue Switch on the Platen.")

Borderless Printing Method

Choose the method of borderless printing that suits the original, as desired.

iPF815 Borderless Printing by Resizing Originals to Fit the Roll Width
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Scale to fit Roll Paper Width

Enlarge or reduce the original as a whole to match the roll paper width.

3 Note

* You can combine this function with rotating pages 90 degrees before printing so that the original width (rela-
tive to portrait orientation) matches the roll paper width in borderless printing.

For instructions on borderless printing of photos, images, and other documents to match the roll paper width, refer to the
following topics, as appropriate for your computer and operating system.

* Borderless Printing by Resizing Originals to Fit the Roll Width (Windows)
» Borderless Printing by Resizing Originals to Fit the Roll Width (Mac OS X)

'Borderless Printing by Resizing Originals to Fit the Roll Width (Windows)

This topic describes how to enlarge originals before borderless printing to match the roll width, based on the following ex-
ample.

* Document: Any type

* Page size: A4 (210.0x297.0 mm)/Letter (8.3 x 11.7 in)
 Paper: Roll

* Paper type: Heavyweight Coated Paper

* Roll paper width: 10 inches (254.0 mm)

1 « In the application, create an original that takes up the entire space of the paper size.

Note
* If you can specify the margin, as in Microsoft Word, set the margin at 0 mm. For instructions on
specifying the margin, refer to the software documentation.

108

2. Choose Print in the application menu.

3. Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications (Windows) ")

Borderless Printing by Resizing Originals to Fit the Roll Width (Windows) iPF815
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4. Make sure the Main sheet is displayed.

5. In the A Media Type list, select the type of paper that is loaded. In this case, click Heavyweight Coated Paper.
6. Select the print target in the = Print Target list.

7. Click the Page Setup tab to display the Page Setup sheet.

109
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8. In the /A Page Size list, click the size of the original as specified in the application. In this case, click ISO A4 or
Letter (8.5"x11").

9. Select and click a roll paper in the L Paper Source list.

1 0. Select the 5 Borderless Printing check box to display the Information dialog box.

1 1 o Select the width of the loaded roll in the Roll Paper Width list—in this case, click 10-in. Roll (254.0mm).
1 2. Click OK to close the Information dialog box.
13. In © Borderless Printing Method, make sure = Scale to fit Roll Paper Width is selected.

1 4. Confirm the print settings and print as desired.

Note
* For tips on confirming print settings, see "Confirming Print Settings (Windows) "

10
'Borderless Printing by Resizing Originals to Fit the Roll Width (Mac OS X)

This topic describes how to enlarge originals before borderless printing to match the roll width, based on the following ex-

ample.
* Document: Any Type
* Page size: A4 (210.0 X 297.0 mm [8.3 % 11.7 in])
* Paper: Roll paper
 Paper type: Heavyweight Coated Paper

Borderless Printing by Resizing Originals to Fit the Roll Width (Mac OS X) iPF815
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 Roll paper width: 10 inches (254.0 mm)

1 o This sets the 5 Format for and © Paper Size.

Note

* The configuration method varies depending on the OS and application software you are using.
If Page Setup is displayed in the application menu, the settings are configured by opening the Page
Attributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the /A Printer list.

3. In the = Paper Size list, click the size of the original. In this case, click ISO A4.

Note
* All sizes are available in borderless printing if you resize originals to fit the roll width. 111

4. If you configured the settings using the Page Attributes dialog box, click - OK to close the dialog box, and then
select Print from the application software menu.

iPF815 Borderless Printing by Resizing Originals to Fit the Roll Width (Mac OS X)
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5. Access the Main pane.

« Inthe A Media Type list, select the type of paper that is loaded. In this case, click Heavyweight Coated Paper.

7. Make your selection in the = Print Target list.
8. Make your selection in the I~ Print Quality list.

« Access the Page Setup pane.

112

1 0. Select and click a roll paper in the /A Paper Source list.

Borderless Printing by Resizing Originals to Fit the Roll Width (Mac OS X) iPF815
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1 1 « Make sure the width of the loaded roll is displayed in the = Roll Width list—in this case, 10 in. (254.0mm).

Note

o If the width of the roll loaded in the printer is not shown in = Rell Width, click L Printer Informa-
tion on the Main pane to update the printer information.

12. Make sure the  Page Size setting matches the original size as selected in © Paper Size in the Page Attributes
dialog box—in this case, ISO A4.

113

13 « Select the L) Enlarged/Reduced Printing check box.

1 4. Select the I Borderless Printing check box.
This ensures that I~ Fit Roll Paper Width is automatically selected in L’ Enlarged/Reduced Printing.

iPF815 Borderless Printing by Resizing Originals to Fit the Roll Width (Mac OS X)
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1 5. Confirm the print settings, and then click IVl Print to start printing.

Note
* For tips on confirming print settings, see "Confirming Print Settings (Mac OS X) "

114
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Printing banners or at other non-standard sizes

Printing Vertical or Horizontal Banners (Large-Format Printing) ..........occoviiiiiiiiiii e 115
Printing Vertical or Horizontal Banners (Large-Format Printing; Windows) ..........cccccoviiiiiiiiieieee e, 116
Printing Vertical or Horizontal Banners (Large-Format Printing; Mac OS X) ......cccccciiiiiiiiie e, 120
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Printing on Non-Standard Paper Sizes (WINAOWS) .......c.coiiiiiiiiiieiiiiiiir et e e e e e e s e eenraee e e e e e ennees 124
Printing on Non-Standard Paper Sizes (Mac OS X) .....coiiiiiiiiiiiiiie ittt 129

'Printing Vertical or Horizontal Banners (Large-Format Printing)

You can create vertical or horizontal banners by printing originals that are in banner format on rolls.
Originals created in Microsoft Word or other applications in your preferred size can be enlarged to fill the width of roll
paper by completing simple printer driver settings.

Fit Roll Paper Width

You can easily create vertical or horizontal banners by automatically enlarging or reducing originals to fit the full width of
rolls.

Note
* The maximum supported roll length is 18.0 m or 19.7 yd.

For instructions on printing vertical or horizontal banners, refer to the following topics, as appropriate for your computer
and operating system.

* Printing Vertical or Horizontal Banners (Large-Format Printing; Windows)
* Printing Vertical or Horizontal Banners (Large-Format Printing; Mac OS X) 115

Important
@ * Before printing, check how much of the roll paper is left. If you have activated automatic detection of the
remaining roll paper, a warning message is displayed when there is not enough roll paper left.

* If not much ink is left, prepare replacement ink tanks.

* To print at a higher level of quality, in the printer driver, choose High or Highest in Print Quality, and
choose Unidirectional Printing as the direction of printing.

iPF815 Printing Vertical or Horizontal Banners (Large-Format Printing)
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'Printing Vertical or Horizontal Banners (Large-Format Printing; Windows)

This topic describes how to print a banner about five times as long as the roll width based on the following example.
* Document: A horizontal banner created in Microsoft Word
* Page size: Non-standard (100x500 mm [3.9%19.7 in])
* Paper: Roll
* Paper type: Plain Paper
* Roll paper width: 16 in (406.4 mm)

Follow the steps below to print a banner in either horizontal or vertical format.

1. Register a Custom Paper Size.

Banners tend to be in non-standard sizes, so register a Custom Paper Size. In this example, 100x500 mm (3.9%19.7 in)
is registered.

3 2. Inthe application, create an original in the size you registered.

3. Print the banner, using the settings that correspond to banners.
Registering a Custom Paper Size

This example describes how to register a paper size that is horizontally elongated and suitable for banners in either horizon-
tal or vertical format.

1. Display the printer driver dialog box.(See "Accessing the Printer Driver Dialog Box from the Operating System
Menu (Windows) ")

2. Click the Page Setup tab to display the Page Setup sheet.

116

3 « Select and click a roll paper in the L. Paper Source list.

Printing Vertical or Horizontal Banners (Large-Format Printing; Windows) iPF815
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« Click U Size Options to display the Paper Size Options dialog box.
« Enter a desired paper name in Custom Paper Size Name. My Horizontal Banner is used in this example.

o In Units, click mm.

o Click Add to add the paper size of My Horizontal Banner.

7. Under Paper Size, enter 100 in Width and 500 in Height.
9. Click OK to close the Paper Size Options dialog box.

1 o Close the printer driver dialog box.

Note

* You can also specify a Custom Size as the paper size. Note that Custom Size settings are not available after
you exit the application.
For more information, see "Printing on Non-Standard Paper Sizes (Windows) E&:XFZ) "

Creating the banner in the application

Follow the steps below to create the banner in Microsoft Word using the Custom Paper Size you registered.

1 « Start Microsoft Word.
2. Choose Page Setup from the File menu to display the Page Setup dialog box.

3 « Under Paper Size, click the Custom Paper Size you registered—My Horizontal Banner in this example.

Important
@ * If My Horizontal Banner is not listed, make sure this printer is selected as the printer to use.

* In applications such as Microsoft PowerPoint that do not enable you to choose registered paper sizes,
use the custom paper size setting in Custom and specify 100x500 mm (3.9%x19.7 in)

4. Set the printing orientation to horizontal.
5. Create the banner.

Printing the banner 117

Follow these steps to print the banner using the corresponding banner settings.

1 o Choose Print in the Microsoft Word menu.

2. Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications (Windows) ")

iPF815 Printing Vertical or Horizontal Banners (Large-Format Printing; Windows)
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3. Make sure the Main sheet is displayed.

4. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.
5. After confirming that L) Easy Settings is selected, click Poster in the = Print Target list.

6. Click the Page Setup tab to display the Page Setup sheet.

118
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7. In the A Page Size list, click the size you registered, My Horizontal Banner.

8. Select the  Enlarged/Reduced Printing check box.

Note
e If the © Enlarged/Reduced Printing check box is not displayed on the Page Setup sheet, clear the
Borderless Printing check box.

9. Select and click a roll paper in the L Paper Source list.
1 0. After you click = Fit Roll Paper Width, the Information dialog box is displayed.

1 1 « Select the width of the loaded roll in the Roll Paper Width list. In this case, click 16-in. Roll (406.4mm), and then
click OK.

1 2. Confirm the print settings and print as desired.

Note
* For tips on confirming print settings, see "Confirming Print Settings (Windows) "

119
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If printing is unsuccessful, you may be able to print after completing the following setting.

1 « On the Layout sheet, click J Special Settings to display the Special Settings dialog box.

2. In the FineZoom Settings list, click Yes.

Special Settings

FineZoom Seltings - [\ foc

o (X!

Application Color Matching Pricity |B
[] Enable Preview Switching C
Fast Graphic Process D)
Reduce Print Unevenness B
[¥] Adjust faint lines |

I 0k l [ Cancel ] [ Defaults ] [ Help

120 'Printing Vertical or Horizontal Banners (Large-Format Printing; Mac OS X)

This topic describes how to print a banner about five times as long as the roll width based on the following example.
* Document: An original designed for a horizontal banner
* Page Size: Non-standard (100x500 mm [3.9x19.7 in])
* Paper: Roll
* Paper type: Plain Paper
* Roll paper width: 16 inches (406.4 mm)

Printing Vertical or Horizontal Banners (Large-Format Printing; Mac OS X) iPF815
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Follow the steps below to print a banner in either horizontal or vertical format.

1. In the application, create an original in the format of a horizontal or vertical banner.

2. Register a Custom Page Sizes (Mac OS X 10.3.9-10.5)/ Custom Paper Sizes (Mac OS X 10.6).
Banners tend to be in non-standard sizes, so register a Custom Page Sizes (Mac OS X 10.3.9-10.5)/ Custom Paper
Sizes (Mac OS X 10.6) in Page Setup. In this example, 100500 mm (3.9x19.7 in) is registered.

3. Print the banner, using the settings that correspond to banners.

Note
 The following procedures are based on Mac OS X 10.5. The method of setting up non-standard paper sizes
varies depending on the version of Mac OS X.

Register a Custom Page Sizes

This example describes how to register and print using a page size that is horizontally elongated and suitable for banners in
either horizontal or vertical format.

1 o Create the document in the application.

2. Choose Print in the application menu.

3 « Select the printer in the /A Printer list.

4. Click Manage Custom Sizes in the  Paper Size list to display the Custom Page Sizes dialog box.

121
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5. Double-click Untitled in the list at left, and then enter a name for the page size you want to register. Here, enter
100%500.
If the Untitled size is not listed at left, click + below the list.

6. Under Page Size, enter 10 in Width and 50 in Height. Here, measurements are entered in centimeters.
7. Specify the margins by entering 0.3 in Printer Margins. Here, too, measurements are entered in centimeters.
8. Click OK to close the Custom Page Sizes dialog box.
9. In the © Paper Size list, click the size of the original. In this case, click 100%500, the size you registered.
1 O. In U Orientation, click the icon of the document in landscape orientation.
1 1 o Click = OK to close the dialog box.

Print the banner

Follow the steps below to print the banner using the corresponding banner settings.

1 « Choose Print in the application menu.

2. Access the Main pane.
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3 o Inthe A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.
4. Make your selection in the = Print Target list.

5. Make your selection in the = Print Quality list.
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6. Access the Page Setup pane.

7. Select and click a roll paper in the /A Paper Source list.

8. Make sure the width of the loaded roll is displayed in the = Roll Width list—in this case, 16 in. (406.4mm).

Note

o If the width of the loaded roll is not displayed in = Roll Width, click L Printer Information on the
Main pane and update the printer information.

123

9. In © Page Size, make sure 100%500 is displayed, as registered in Page Setup.
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1 0. Select the L) Enlarged/Reduced Printing check box.
11. click F Fit Roll Paper Width.

1 2. Confirm the print settings, and click VI Print to start printing.

Note
* For tips on confirming print settings, see "Confirming Print Settings (Mac OS X) "

'Printing on Non-Standard Paper Sizes

By specifying the paper size, you can print on non-standard sizes of paper.
There are two ways to print on non-standard paper sizes, as follows.

Registering non-standard paper size in the printer driver
After you register non-standard paper sizes, they are listed with standard sizes so that you can choose them anytime as nee-
ded.

Note

» These non-standard paper sizes you register in the printer driver are called Custom Paper Size in Windows
and Custom Sizes in Mac OS X.

Specifying custom paper sizes for temporary use

Because these are sizes you specify temporarily in the printer driver, the sizes will not be available after you exit the appli-
cation. If you want to set up a non-standard paper size so that it will always be available, we recommend registering the
paper size in the printer driver.

Note
» These temporary paper sizes you register on the printer are called Custom Sizes in Windows.

* This can only be configured in Windows.

For instructions on specifying non-standard paper sizes for printing, refer to the following topics, as appropriate for your
computer and operating system.

* Printing on Non-Standard Paper Sizes (Windows)
* Printing on Non-Standard Paper Sizes (Mac OS X)

e 'Printing on Non-Standard Paper Sizes (Windows)

This topic describes two ways to print on non-standard paper sizes.
* Printing by using Custom Size

* Printing by using Custom Paper Size

Printing by using Custom Size
This section describes how to print using Custom Size based on the following example.

* Document: Any Type

Printing on Non-Standard Paper Sizes iPF815
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* Page size: Square of non-standard dimensions (430x430 mm [16.9x16.9 in])

* Paper: Sheets

* Paper type: Any type
* Paper Size: A square sheet (430 X 430 mm [16.9 X 16.9 in])

1.
2.
3.

4.

S.
6.

Load the square paper (430 x 430 mm [16.9 x 16.9 in]) in the printer.

Choose Print in the application menu.

Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications (Windows) ")

Make sure the Main sheet is displayed.

In the A Media Type list, select the type of paper that is loaded.

After confirming that L) Easy Settings is selected, select from the = Print Target list.

iPF815
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7. Click the Page Setup tab to display the Page Setup sheet.

8. Click Cut Sheet in the L. Paper Source list.

9. Click Custom Size in the /\ Page Size list to display the Custom Size Settings dialog box.
1 O. Confirm that mm is selected in Units.
1 1 « Enter 430 (16.9 in) in both Width and Height.
12. Click OK to close the Custom Size Settings dialog box.

13 « Confirm the print settings and print as desired.

Note
* For tips on confirming print settings, see "Confirming Print Settings (Windows) "

Printing by using Custom Paper Size
126

This section describes how to print using Custom Paper Size based on the following example. First, register a non-standard
paper size called 430 mm Square as a Custom Paper Size.

* Document: Any Type

* Page Size: A square sheet (430 x 430 mm [16.9 x 16.9 in])
 Paper: Sheets

¢ Media Type: Any type

* Paper Size: A square sheet (430 X 430 mm [16.9 x 16.9 in])

Printing on Non-Standard Paper Sizes (Windows) iPF815
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1 « Load the square paper (430 x 430 mm [16.9 x 16.9 in]) in the printer.
2. Choose Print in the application menu.

3 « Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications (Windows) ")

4. Make sure the Main sheet is displayed.

5. In the /A Media Type list, select the type of paper that is loaded.

6. After confirming that L) Easy Settings is selected, select from the = Print Target list.
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7.

8.
9.
10.
11.

12.
13.
14.
15.
16.

128

Click the Page Setup tab to display the Page Setup sheet.

Click U Size Options to display the Paper Size Options dialog box.
Enter a desired paper name in Custom Paper Size Name. 430 mm Square is used in this example.
Select mm in Units.

Enter 430 (16.9 in) in both Width and Height.

Note

* If you select the Fix the Ratio of the Width to Height check box, after you enter a value in either
Width or Height, the other value will be automatically applied based on the original aspect ratio.

Click Add to register 430 mm Square.

Click OK to close the Paper Size Options dialog box.

Click Cut Sheet in the L. Paper Source list.

In the A Page Size list, click the size you added,430 mm Square.

Confirm the print settings and print as desired.

Note
* For tips on confirming print settings, see "Confirming Print Settings (Windows) "
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'Printing on Non-Standard Paper Sizes (Mac OS X)

This section describes how to register and print Custom Page Sizes (Mac OS X 10.3.9-10.5)/ Custom Paper Sizes (Mac
OS X 10.6) based on the following example. Here, you will register a non-standard paper size named 430%430 in Custom
Page Sizes (Mac OS X 10.3.9-10.5)/ Custom Paper Sizes (Mac OS X 10.6).

e Document: Any Type

e Page Size: A square sheet (430 x 430 mm [16.9 x 16.9 in])
* Paper: Sheets

* Media Type: Any type

 Paper Size: A square sheet (430 x 430 mm [16.9 X 16.9 in])

Note
* The following procedures are based on Mac OS X 10.5. The method of setting up non-standard paper sizes
varies depending on the version of Mac OS X.

1 o Create the document in the application.
2. Load the square paper (430 X 430 mm [16.9 x 16.9 in]) in the printer.

3. Choose Print in the application menu.

4. Select the printer in the /A Printer list.
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S.

9.
10.
11.

130

Click Manage Custom Sizes in the _ Paper Size list to display the Custom Page Sizes dialog box.

In Page Size, enter the height and width of the original. Here, enter 43.00 cm in Height and Width.

In Printer Margins, enter 0.5 for the top and side margins and 2.3 for the bottom margin. Here, measurements are
entered in centimeters.

Double-click Untitled in the list at left in the Custom Page Sizes dialog box and enter the paper name—in this case,
430*430.

Click OK to close the Custom Page Sizes dialog box.

In the © Paper Size list, click the size of the original. In this case, click 430%430, the size you registered.

If you configured the settings using the Page Attributes dialog box, click " OK to close the dialog box, and then
select Print from the application software menu.

Printing on Non-Standard Paper Sizes (Mac OS X) iPF815
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1 2. Access the Main pane.

13 « Inthe A Media Type list, select the type of paper that is loaded.
1 4. After confirming that L) Easy Settings is selected, select from the = Print Target list.
1 5. Make your selection in the = Print Quality list.

1 6. Access the Page Setup pane.
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1 7. Click Cut Sheet in the /A Paper Source list.
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1 8. In © Page Size, make sure 430%430 is displayed, as registered in Page Setup.

1 9. Confirm the print settings, and then click VI Print to start printing.

Note
* For tips on confirming print settings, see "Confirming Print Settings (Mac OS X) "
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Tiling and multiple pages per sheet

Printing Multiple Originals Next to EaCh Other ........cc.uviiiiiiii e 133
Printing Multiple Originals Next to Each Other (WIiNdOWS) .........oocciiiiiiiiiiiie e 134
Printing Multiple Originals Next to Each Other (Mac OS X) .....uuuiiiiiiiiiiiiiee et 136

Printing Multiple Pages COontINUOUSIY ............uiiiiiiiiiie ettt e et e e e s e e e e s ennneeees 138
Printing Multiple Pages Continuously (WINAOWS) .........ueiiiiiiiiiiii e 139
Printing Multiple Pages Continuously (Mac OS X) ......uiiiiiiiiiiiiie ittt e e e e e e e snree e e e 141

Printing MUltiple Pages Per SNEET ........o.uiiiiii ittt e e s e e e enne e e e s annneee s 143
Printing Multiple Pages Per Sheet (WINAOWS) ........coiiiiiiiiiiiiie et e et e e e e e e e e 143
Printing Multiple Pages Per Sheet (Mac OS X) .....uuuiiiiiiiiiiie ettt a e ennae e e e e e nnees 146

Printing POSIErS iN SECHONS ...t e et e e e e st e e e e s snae e e e e e s anssaeeeeesanssneeeas 150
Printing Large Posters (WINAOWS) ........uiiiiiiiiiie ettt e e s e e e s et e e e s e annre e e e s annnraeeeeennnees 151

'Printing Multiple Originals Next to Each Other

By arranging originals from word-processing or spreadsheet programs or web browser screen shots next to each other on
single sheets, you can create highly expressive presentation materials, easy-to-understand meeting materials, and a variety
of other printed documents.

Free Layout (Windows)

Besides combining multiple pages in a single-page layout, you can combine originals from multiple files—even multiple
source applications—in a single-page layout.
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@ Important
* Free Layout cannot be used in 64-bit version of Windows.

imagePROGRAF Free Layout (Macintosh)

Besides combining multiple pages in a single-page layout, you can combine originals from multiple files—even multiple
source applications—in a single-page layout.

For instructions on arranging originals from multiple applications, refer to the following topics.

* Printing Multiple Originals Next to Each Other (Windows)
* Printing Multiple Originals Next to Each Other (Mac OS X)

'Printing Multiple Originals Next to Each Other (Windows)

This topic describes how to arrange multiple originals using the Free Layout function.
@ Important
* Free Layout cannot be used in 64-bit version of Windows.

1 « Choose Print in the application menu.

134 2. Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications (Windows) ")
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3. Make sure the Main sheet is displayed.

4. Click the Layout tab to display the Layout sheet.
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5. Select the /A Page Layout check box.

6. Click Free Layout in the /A Page Layout list.
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7. When you attempt to print, the imagePROGRAF Free Layout window is displayed. (At this point, the document will
not be printed yet.)

8. Edit and rearrange the image in the imagePROGRAF Free Layout window as desired.
@ Important
» Without closing the imagePROGRAF Free Layout window, repeat steps 1-7 to arrange originals
from multiple applications on the same page.

Note
* For instructions on editing and rearranging images, refer to the imagePROGRAF Free Layout help
topic.
9. Print from the imagePROGRAF Free Layout menu.

Note
* For details on imagePROGRAF Free Layout functions, refer to Free Layout .

13

6
'Printing Multiple Originals Next to Each Other (Mac OS X)

This topic describes how to use the Free Layout function to arrange multiple originals next to each other before printing.

1 « Choose Print in the application menu.

Printing Multiple Originals Next to Each Other (Mac OS X) iPF815
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2. Access the Page Setup pane.

3 « Select the I\ Free Layout check box.
4. Click M Print.

5. The Canon imagePROGRAF Free Layout window is displayed.
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6. Edit and rearrange the image in the Canon imagePROGRAF Free Layout window as desired.

Note
» Without closing the Canon imagePROGRAF Free Layout window, repeat steps 1 to 4 to arrange
originals from multiple applications on the same page.

* For instructions on editing and rearranging images, refer to the Canon imagePROGRAF Free Lay-
out help topic.

7. Print from the Canon imagePROGRAF Free Layout menu.

Note
* For details on Canon imagePROGRAF Free Layout functions, refer to Free Layout .

3 'Printing Multiple Pages Continuously

You can print multiple pages as a single continuous image, without margins between pages.

Roll paper (banner)

@ Important
e This feature is only available with rolls. It cannot be used when printing on sheets.

* During banner printing, settings for conserving paper, number of copies, borderless printing, enlargement or
reduction, and other layout-related settings are disregarded.

138

For instructions on borderless printing of photos and images at actual size, refer to the following topics, as appropriate for
your computer and operating system.

* Printing Multiple Pages Continuously (Windows)
* Printing Multiple Pages Continuously (Mac OS X)

Printing Multiple Pages Continuously iPF815

Downloaded from ManualsPrinter.com Manuals



http://www.manualsprinter.com

Enhanced Printing Options > Tiling and multiple pages per sheet >

'Printing Multiple Pages Continuously (Windows)

This topic describes how to print multiple pages as a single continuous image, without margins between pages.

Important
@ * This feature is only available with rolls. It cannot be used when printing on sheets.
* During banner printing, settings for conserving paper, number of copies, borderless printing, enlargement or
reduction, and other layout-related settings are disregarded.

1 « Choose Print in the application menu.

2. Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications (Windows) ")

3. Make sure the Main sheet is displayed.

4. In the A Media Type list, click the type of paper that is loaded.
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5. Click the Page Setup tab to display the Page Setup sheet.

6. Select and click a roll paper in the . Paper Source list.

7. Click N Reoll Paper Options to display the Roll Paper Options dialog box.

8. Select the 5 Banner Printing check box.
9. click oK.

1 0. Confirm the print settings and print as desired.

140 Note
* For tips on confirming print settings, see "Confirming Print Settings (Windows) "
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'Printing Multiple Pages Continuously (Mac OS X)

This topic describes how to print multiple pages as a single continuous image, without margins between pages.

@ Important
* This feature is only available with rolls. It cannot be used when printing on sheets.

* During banner printing, settings for conserving paper, number of copies, borderless printing, enlargement or
reduction, and other layout-related settings are disregarded.

1 o This sets the 5 Format for and  Paper Size.

Note

* The configuration method varies depending on the OS and application software you are using.
If Page Setup is displayed in the application menu, the settings are configured by opening the Page
Attributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the upper part of the printer driver displayed when
you select Print from the application software menu.

141
2. Select the printer in the /A Printer list.
3. Click the original size in the _ Paper Size list.

4. If you configured the settings using the Page Attributes dialog box, click " OK to close the dialog box, and then
select Print from the application software menu.
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5. Access the Main pane.

« Inthe A Media Type list, click the type of paper that is loaded.

7. Make your selection in the = Print Target list.
8. Make your selection in the I~ Print Quality list.

« Access the Page Setup pane.
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1 0. In the A Paper Source list, click Roll Paper 1 (Banner) or Roll Paper 2 (Banner).
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1 1 « Confirm the print settings, and then click IVl Print to start printing.

Note
* For tips on confirming print settings, see "Confirming Print Settings (Mac OS X) "

'Printing Multiple Pages Per Sheet

To conserve paper, you can print several pages of the original on a single sheet by reducing the original and dividing the
sheet into areas for each page.

Page Layout

Specify a number of pages of the original to print on a single sheet, in a layout of multiple pages per sheet.
Note
* You can print up to 16 pages of the original on a single sheet.

* You can also change the page layout order and print page boundary lines, as desired.

@ Important

* This function cannot be combined with the following options.
* Borderless Printing
* Scaling Originals (Windows)
* Banner Printing (Windows)

* When printing using this function, the Print Centered setting is disabled.

For instructions on printing multiple pages per sheet, refer to the following topics, as appropriate for your computer and
operating system.

* Printing Multiple Pages Per Sheet (Windows)

* Printing Multiple Pages Per Sheet (Mac OS X) 1

'Printing Multiple Pages Per Sheet (Windows)

This topic describes how to print four pages of originals together on a single sheet based on the following example.

* Document: Any Type
* Page size: A3 (297.0x420.0 mm [11.7%16.5 in])

iPF815 Printing Multiple Pages Per Sheet
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 Paper: Roll
* Paper type: Plain Paper
* Roll paper width: A2/A3 roll (420.0 mm [16.5 in])

1 « Choose Print in the application menu.

2. Select the printer in the dialog box, and then open the printer driver dialog box.(See "Accessing the Printer Driver
Dialog Box from Applications (Windows) ")

3. Make sure the Main sheet is displayed.

4. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.
5. Make your selection in the = Print Target list.

6. Make your selection in the I~ Print Quality list.

144

Printing Multiple Pages Per Sheet (Windows) iPF815

Downloaded from ManualsPrinter.com Manuals



http://www.manualsprinter.com

Enhanced Printing Options > Tiling and multiple pages per sheet >

7. Click the Page Setup tab to display the Page Setup sheet.

8. In A Page Size, click the size of the original as specified in the application software. In this case, click ISO A3 or
Letter (8.5"x11").

9. Select and click a roll paper in the L Paper Source list.

1 0. Select the width of the loaded roll in the VI Roll Paper Width list—in this case, ISO A2/A3 Roll (420.0mm).
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1 1 « Click the Layout tab to display the Layout sheet.

1 2. Select the /A Page Layout check box.

13. Click 4 Pages/Sheet in the /A Page Layout list.

Note
* You can select the layout order for placing four pages on a sheet and a frame border in the Page Lay-
out Printing dialog box by clicking = Set.

1 4. Confirm the print settings and print as desired.

Note
* For tips on confirming print settings, see "Confirming Print Settings (Windows) "

'Printing Multiple Pages Per Sheet (Mac OS X)

This topic describes how to print four pages of an original on a single sheet, based on the following example.
146 » Document: Any Type
* Page size: A3 (297.0 X 420.0 mm [11.7 x 16.5 in])
* Paper: Roll paper
* Paper type: Plain Paper
* Roll paper width: A2/A3 roll (420.0 mm [16.5 in])

Printing Multiple Pages Per Sheet (Mac OS X) iPF815
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1 o This sets the 5 Format for and  Paper Size.

Note

* The configuration method varies depending on the OS and application software you are using.
If Page Setup is displayed in the application menu, the settings are configured by opening the Page
Attributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the /A Printer list.
3. In the = Paper Size list, click the size of the original. In this case, click ISO A3.
4. If you configured the settings using the Page Attributes dialog box, click " OK to close the dialog box, and then

select Print from the application software menu.
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5. Access the Layout pane.

6. Click 4 in the /~ Pages per Sheet list.

3 Note

* You can choose the layout order and specify a boundary line for the four pages in = Layout Direc-
tion and _ Border.

7. Access the Main pane.

148 8. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.
9. Make your selection in the = Print Target list.

1 0. Make your selection in the  Print Quality list.

Printing Multiple Pages Per Sheet (Mac OS X) iPF815
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1 1 o Access the Page Setup pane.

1 2. Select and click a roll paper in the /A Paper Source list.

13 « Make sure the width of the loaded roll is displayed in the = Roll Width list—in this case, ISO A2/A3 (420.0mm).

Note

o If the width of the roll loaded in the printer is not shown in = Rell Width, click L Printer Informa-
tion on the Main pane to update the printer information.
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14. Make sure _ Page Size shows the original size as specified in  Paper Size in the Page Attributes dialog box—in
this case, ISO A3.

1 5. Confirm the print settings, and then click IVl Print to start printing.

Note
* For tips on confirming print settings, see "Confirming Print Settings (Mac OS X) "

'Printing Posters in Sections

You can enlarge an original to print it in sections on several sheets. By assembling the printed sheets, you can create a post-
er larger than the maximum supported paper size of the printer.

Page Layout
150 Choose poster printing.
Important

* When printing using this function, the Print Centered, Watermark, No Spaces at Top or Bottom (Con-
serve Paper), and Page Options settings are disabled.

For instructions on printing large posters, refer to the following topics, as appropriate for your computer and operating sys-
tem.

* Printing Large Posters (Windows)

Printing Posters in Sections iPF815
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Note
 This method of poster printing is supported in Windows.

'Printing Large Posters (Windows)

You can enlarge an original to print it in sections on several sheets. By assembling the printed sheets, you can create a post-
er larger than the maximum supported paper size of the printer. This topic describes how to enlarge an A2 original for print-
ing it in sections on four sheets, based on the following example.

e Document: Poster

* Page size: A2 (420.0x594.0 mm [16.5 X 23.4 in])

* Paper: Sheets

* Paper Size: A2 (420.0 x 594.0 mm [16.5 x 23.4 in])

1 o Choose Print in the application menu. 3

2. Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications (Windows) ")

3. Make sure the Main sheet is displayed.
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4. In the A Media Type list, select the type of paper that is loaded.

5. Click Poster in the = Print Target list.
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6. Click the Page Setup tab to display the Page Setup sheet.

7. In A Page Size, click the size of the original as specified in the application. In this case, click ISO A2.
8. Click Cut Sheet in the L Paper Source list.

9. Click the Layout tab to display the Layout sheet.
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1 0. Select the /A Page Layout check box.

1 1 o Click Poster (2 x 2) in the /A Page Layout list.

Note
* Follow the steps below to print only a portion of the poster as divided for printing.

* Click = Set under /\ Page Layout to display the Pages to Print dialog box.
* On the Pages to Print dialog box, clear the check boxes of the portion you do not want to print.
* Click OK to close the Pages to Print dialog box.

1 2. Confirm the print settings and print as desired.

Note
* For tips on confirming print settings, see "Confirming Print Settings (Windows) "
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Centering originals
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'Printing Originals Centered on Rolls

You can print originals centered on a page—for example, if the paper is larger than the original, or if you are reducing the
original.

3 Centering originals relative to roll paper width

If you use originals smaller than the roll paper width, you can center them relative to the width when printing.
Print Centered
Aligns the center of the original with the center of the roll, relative to the width.

For instructions on centering originals when printing on rolls, refer to the following topics, as appropriate for your computer
and operating system.

* Printing Originals Centered on Rolls (Windows)
* Printing Originals Centered on Rolls (Mac OS X)

'Printing Originals Centered on Rolls (Windows)

This topic describes how to center originals before printing on rolls based on the following example.
* Document: Any type
* Page size: A4 (210.0x297.0 mm)/Letter (8.3 x 11.7 in)
154 * Paper: Roll
* Paper type: Plain Paper
Roll width: A3/A4 roll (297.0 mm [11.7 in])

1 o Choose Print in the application menu.

2. Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications (Windows) ")

Printing Originals Centered on Rolls iPF815
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3. Make sure the Main sheet is displayed.

4. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.
5. Select the print target in the = Print Target list.

6. Click the Page Setup tab to display the Page Setup sheet.
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7. In the /A Page Size list, click the size of the original as specified in the application. In this case, click ISO A4 or
Letter (8.5"x11").

8. Select and click a roll paper in the L Paper Source list.
9. Select the width of the loaded roll in the VI Roll Paper Width list—in this case, ISO A3/A4 Roll (297.0mm).

1 0. Click the Layout tab to display the Layout sheet.

1 1 o Select the = Print Centered check box.

1 2. Confirm the print settings and print as desired.

Note
* For tips on confirming print settings, see "Confirming Print Settings (Windows) "

'Printing Originals Centered on Rolls (Mac OS X)
156

This topic describes how to center originals before printing on rolls based on the following example.
* Document: Any Type
* Page size: A4 (210.0 X 297.0 mm [8.3 % 11.7 in])
 Paper: Roll paper
* Paper type: Plain Paper
* Roll paper width: A3/A4 roll (297.0 mm [11.7 in])
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1 o This sets the 5 Format for and  Paper Size.

Note

* The configuration method varies depending on the OS and application software you are using.
If Page Setup is displayed in the application menu, the settings are configured by opening the Page
Attributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the /A Printer list.
3. In the = Paper Size list, click the size of the original. In this case, click ISO A4.
4. If you configured the settings using the Page Attributes dialog box, click " OK to close the dialog box, and then

select Print from the application software menu.
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5. Access the Main pane.

« Inthe A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.

7. Make your selection in the = Print Target list.
8. Make your selection in the I~ Print Quality list.

« Access the Page Setup pane.
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1 0. Select and click a roll paper in the /A Paper Source list.
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1 1 « Make sure the width of the loaded roll is displayed in = Roll Width —in this case, ISO A3/A4 (297.0mm).

Note

o If the width of the roll loaded in the printer is not shown in = Rell Width, click L Printer Informa-
tion on the Main pane to update the printer information.

12. Make sure the  Page Size setting matches the original size as selected in © Paper Size in the Page Attributes
dialog box—in this case, ISO A4.
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13 o Select the < Print Centered check box.

iPF815 Printing Originals Centered on Rolls (Mac OS X)

Downloaded from ManualsPrinter.com Manuals



http://www.manualsprinter.com

Enhanced Printing Options > Centering originals >

1 4. Confirm the print settings, and then click IVl Print to start printing.

Note
* For tips on confirming print settings, see "Confirming Print Settings (Mac OS X) "

'Printing Originals Centered on Sheets

You can print originals centered on a page—for example, if the paper is larger than the original, or if you are reducing the
original.

Centering originals on sheets

If you use paper larger than the original size or print originals after reduction, the printed images may be aligned in the
upper-left corner of the paper. In this case, you can center originals on sheets when printing.

3 Print Centered
Aligns the center of the original with the center of the sheet.

For instructions on centering originals when printing on sheets, refer to the following topics, as appropriate for your com-
puter and operating system.

* Printing Originals Centered on Sheets (Windows)
* Printing Originals Centered on Sheets (Mac OS X)

'Printing Originals Centered on Sheets (Windows)

This topic describes how to reduce an original 50% for printing centered on a sheet.
e Document: Any Type
* Page size: A4 (210.0 x 297.0 mm [8.3 x 11.7 in])
* Paper: Sheets
* Paper type: Plain Paper

160 * Paper size: A4 (210.0 x 297.0 mm [8.3 x 11.7 in])

1 o Choose Print in the application menu.

2. Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications (Windows) ")

Printing Originals Centered on Sheets iPF815
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3. Make sure the Main sheet is displayed.

4. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.
5. Make your selection in the = Print Target list.

6. Click the Page Setup tab to display the Page Setup sheet.
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7. In the /A Page Size list, click the size of the original as specified in the application. In this case, click ISO A4.
8. Select the  Enlarged/Reduced Printing check box.
9. Click Match Page Size in the (5 Paper Size list.

1 0. Click = Scaling and enter 50.

1 1 o Click Cut Sheet in the L Paper Source list.

1 2. Click the Layout tab to display the Layout sheet.

13 o Select the = Print Centered check box.

1 4. Confirm the print settings and print as desired.

Note
* For tips on confirming print settings, see "Confirming Print Settings (Windows) "

162

Important
@ * If you have selected Cut Sheet as the paper source, follow the instructions on the printer control pan-
el to enter the paper size.
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'Printing Originals Centered on Sheets (Mac OS X)

This topic describes how to center originals for printing on sheets, based on the following example.
e Document: Any Type
e Page size: A4
* Paper: Sheets
* Paper type: Plain Paper

* Paper size: Non-standard

1 o This sets the 5 Format for and C Paper Size.

Note

* The configuration method varies depending on the OS and application software you are using.
If Page Setup is displayed in the application menu, the settings are configured by opening the Page
Attributes dialog box from Page Setup. 3

If it is not displayed, the settings are configured in the upper part of the printer driver displayed when
you select Print from the application software menu.
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2. Select the printer in the /A Printer list.

3. In the I~ Paper Size list, click the size of the original. In this case, click ISO A4 - Cut Sheet.
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4. If you configured the settings using the Page Attributes dialog box, click I~ OK to close the dialog box, and then
select Print from the application software menu.

5. Access the Main pane.

6. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.
7. Make your selection in the = Print Target list.

8. Make your selection in the = Print Quality list.
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9. Access the Page Setup pane.

1 0. Click Cut Sheet in the /~ Paper Source list.

1 1. Make sure the  Page Size setting matches the original size as selected in _ Paper Size in the Page Attributes
dialog box—in this case, ISO A4 - Cut Sheet.
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1 2. Select the < Print Centered check box.

13 « Confirm the print settings, and then click IVl Print to start printing.

Note
* For tips on confirming print settings, see "Confirming Print Settings (Mac OS X) "
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Important
@ e If you have selected Cut Sheet as the paper source, follow the instructions on the printer control panel to
enter the paper size.
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Conserving roll paper
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'Conserving Roll Paper by Rotating Originals 90 Degrees

You can conserve roll paper by specifying particular settings as suitable for your original.

Rotate Page 90 degrees (Conserve Paper) 3

When originals are printed in portrait orientation, the original is rotated 90 degrees before printing if it fits within the roll
width. This enables you to conserve paper.

Important
@ * If the page would exceed the roll paper width after rotation, use this function with Scale to fit Roll Paper
Width to print rotated pages.

For tips on conserving roll paper, refer to the following topics, as appropriate for your computer and operating system.

» Conserving Roll Paper by Rotating Originals 90 Degrees (Windows)
 Conserving Roll Paper by Rotating Originals 90 Degrees (Mac OS X)

'Conserving Roll Paper by Rotating Originals 90 Degrees (Windows)

This topic describes how to conserve paper by rotating originals 90 degrees before printing, based on the following exam-

ple.
e Document: Any type 167
* Page size: A4 (210.0x297.0 mm)/Letter (8.3x11.7 in)
* Paper: Roll
* Paper type: Plain Paper
* Roll paper width: A3/A4 roll (297.0 mm [11.7 in])

iPF815 Conserving Roll Paper by Rotating Originals 90 Degrees
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This example illustrates how to rotate an A4 (210.0x297.0 mm)/Letter (8.3x11.7 in) original in portrait orientation 90 de-
grees to fit within the width of A3/A4 roll paper (297.0 mm [11.7 in]), which enables you to conserve paper.

1 o Choose Print in the application menu.

2. Select the printer in the dialog box, and then open the printer driver dialog box.(See "Accessing the Printer Driver
Dialog Box from Applications (Windows) ")

3. Make sure the Main sheet is displayed.

4. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.
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5. Click the Page Setup tab to display the Page Setup sheet.

6. In the /A Page Size list, click the size of the original as specified in the application. In this case, click ISO A4 or
Letter (8.5"x11").

7. Select and click a roll paper in the L Paper Source list.
8. Select the width of the loaded roll in the VI Roll Paper Width list—in this case, ISO A3/A4 Roll (297.0mm).
9. Select the . Rotate Page 90 degrees (Conserve Paper) check box.

1 O. Confirm the print settings and print as desired.

Note
* For tips on confirming print settings, see "Confirming Print Settings (Windows) "

'Conserving Roll Paper by Rotating Originals 90 Degrees (Mac OS X)
This topic describes how to conserve roll paper by rotating originals 90 degrees before printing, based on the following
example.
* Document: Any Type
* Page size: A4 (210.0 X 297.0 mm [8.3 % 11.7 in])
* Paper: Roll paper
* Paper type: Plain Paper
* Roll paper width: A3/A4 roll (297.0 mm [11.7 in])

iPF815 Conserving Roll Paper by Rotating Originals 90 Degrees (Mac OS X)
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This example illustrates how to rotate an A4 (210.0x297.0 mm)/Letter (8.3 % 11.7 in) original in portrait orientation 90
degrees to fit within the width of A3/A4 roll (297.0 mm [11.7 in]), which enables you to conserve paper.

1 o This sets the 5 Format for and  Paper Size.

Note

* The configuration method varies depending on the OS and application software you are using.
If Page Setup is displayed in the application menu, the settings are configured by opening the Page
Attributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the /A Printer list.
3. In the = Paper Size list, click the size of the original. In this case, click ISO A4.

170 4. If you configured the settings using the Page Attributes dialog box, click " OK to close the dialog box, and then
select Print from the application software menu.
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5. Access the Main pane.

6. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.

7. Access the Page Setup pane.

171

8. Select and click a roll paper in the /A Paper Source list.
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9. Make sure the width of the loaded roll is displayed in = Roll Width —in this case, ISO A3/A4 (297.0mm).

Note

o If the width of the roll loaded in the printer is not shown in = Rell Width, click L Printer Informa-
tion on the Main pane to update the printer information.

10. Make sure the  Page Size setting matches the original size as selected in © Paper Size in the Page Attributes
dialog box—in this case, ISO A4.
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1 1 o Select the L Rotate Page 90 degrees check box.
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1 2. Confirm the print settings, and then click IVl Print to start printing.

Note
* For tips on confirming print settings, see "Confirming Print Settings (Mac OS X) "

'Conserving Roll Paper by Printing Originals Without Top and Bottom Margins

You can conserve roll paper by specifying particular settings as suitable for your original.

No Spaces at Top or Bottom (Conserve Paper)

You can print without feeding the paper for blank portions of originals if there are top and bottom margins in originals. This
enables you to conserve as much paper as the size of the margins.

Important
@ * Printing without the top and bottom margins is not supported in the following cases.
* Banner printing

* If you have chosen poster as the type of page layout

Note
* Even during borderless printing, you can print without the top and bottom margins.

* Printing without the top and bottom margins may cause inconsistency in the size of printed documents, de-
pending on the layout of images or text in your originals.

For tips on conserving roll paper, refer to the following topics, as appropriate for your computer and operating system.

» Conserving Roll Paper by Printing Originals Without Top and Bottom Margins (Windows)
 Conserving Roll Paper by Printing Originals Without Top and Bottom Margins (Mac OS X)

Conserving Roll Paper by Printing Originals Without Top and Bottom Margins
(Windows) 173

This topic describes how to conserve roll paper when printing originals that have a top and bottom margin, based on the
following example.

* Document: Any type

» Page size: A4 (210.0x297.0mm)/Letter (8.3 x 11.7 in)

* Paper: Roll

* Paper type: Plain Paper

* Roll paper width: A3/A4 roll (297.0 mm [11.7 in])

iPF815 Conserving Roll Paper by Printing Originals Without Top and Bottom Margins
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1 « Choose Print in the application menu.

2. Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications (Windows) ")

3. Make sure the Main sheet is displayed.

4. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.
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5. Click the Page Setup tab to display the Page Setup sheet.

6. In the /A Page Size list, click the size of the original as specified in the application. In this case, click ISO A4 or
Letter (8.5"x11").

7. Select and click a roll paper in the L Paper Source list.

8. Select the width of the loaded roll in the VI Roll Paper Width list—in this case, ISO A3/A4 Roll (297.0mm).
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9. Click the Layout tab to display the Layout sheet.

1 0. Select the (= No Spaces at Top or Bottom (Conserve Paper) check box.

1 1 o Confirm the print settings and print as desired.

Note
* For tips on confirming print settings, see "Confirming Print Settings (Windows) "

Conserving Roll Paper by Printing Originals Without Top and Bottom Margins (Mac OS
X)
This topic describes how to conserve roll paper when printing originals that have a top and bottom margin, based on the
following example.
e Document: Any Type
* Page size: A4 (210.0 x 297.0 mm [8.3 x 11.7 in])
* Paper: Roll paper
176 * Paper type: Plain Paper
* Roll paper width: A3/A4 roll (297.0 mm [11.7 in])
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1 o This sets the 5 Format for and  Paper Size.

Note

* The configuration method varies depending on the OS and application software you are using.
If Page Setup is displayed in the application menu, the settings are configured by opening the Page
Attributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the /A Printer list.
3. In the = Paper Size list, click the size of the original. In this case, click ISO A4.
4. If you configured the settings using the Page Attributes dialog box, click " OK to close the dialog box, and then

select Print from the application software menu.
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5. Access the Main pane.

6. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.

7. Access the Page Setup pane.
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8. Select and click a roll paper in the /A Paper Source list.
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9. Make sure the width of the loaded roll is displayed in = Roll Width —in this case, ISO A3/A4 (297.0mm).

Note

o If the width of the roll loaded in the printer is not shown in = Rell Width, click L Printer Informa-
tion on the Main pane to update the printer information.

10. Make sure the  Page Size setting matches the original size as selected in © Paper Size in the Page Attributes
dialog box—in this case, ISO A4.
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1 1 « Select the '\ No Spaces at Top or Bottom check box.
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1 2. Confirm the print settings, and then click IVl Print to start printing.

Note
* For tips on confirming print settings, see "Confirming Print Settings (Mac OS X) "
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Using PosterArtist to Compose Originals

Using PosterArtist to COMPOSE OFGINAIS .........eviiiiiiiiiiiieee ettt e e e e e e s sseeae e e e s snnssaeeeessnnsseeeeas 181

'Using PosterArtist to Compose Originals

You can print a variety of source documents from word-processing or spreadsheet programs or screen shots from web
browsers after composing an original with them using PosterArtist.
This topic describes how to use PosterArtist to compose originals from multiple applications, creating a poster layout for

printing.

@ Important
e This function is only supported in Windows.
* PosterArtist (sold separately) must be installed to use this function.

1 o Choose Print in the application menu.

2. Select the printer in the dialog box, and then open the printer driver dialog box. (See "Accessing the Printer Driver
Dialog Box from Applications (Windows).")

3. Make sure the Main sheet is displayed.
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4. Click the Layout tab to display the Layout sheet.

5. Select the /A Page Layout check box.
6. Click in the Edit Using PosterArtist in the /A Page Layout list.

7. When you attempt to print, PosterArtist starts up and the PageCapture window is displayed. (At this point, the docu-
ment will not be printed yet.)

182

8. Choose the page to load in PosterArtist.
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9. Edit and rearrange the image in the PosterArtist window as desired.

Important
@ » Without closing the PosterArtist window, repeat steps 1-8 to arrange originals from multiple applica-
tions on the same page.

Note

* For instructions on editing and rearranging images, refer to the PosterArtist Manual.

1 0. Print from the PosterArtist menu.
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Checking Images Before Printing

Checking the Layout in @ Preview Before Printing ..........cccuuiiiiiiiiiiiee et 184

'Checking the Layout in a Preview Before Printing

You can check the print layout on the preview screen.

Open Preview When Print Job Starts (\Windows)

While viewing the preview screen, you can also adjust orientation or other settings, and your changes will be instantly ap-
plied on the preview screen.

Note
* Under some settings and in some environments, PageComposer may be started.

184
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Preview (Macintosh)

While viewing the preview screen, you can also adjust layout or size settings, and your changes will be instantly applied on
the preview screen.

For instructions on how to check the layout before printing, refer to the following topics:

» Checking the Layout in a Preview Before Printing (Windows)
* Checking the Layout in a Preview Before Printing (Mac OS X)

185
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Other useful settings

Printing With Watermarks ...ttt e e e e e e e e et e e e e e e e e e e e e s nnnneeeeeeas 186
Printing with Watermarks— COPY, FILE COPY, and so on (WIiNAOWS) ........ccccviireeiiiiiiiireeeesiiiee e 187
Making the Original Orientation Match the Paper Orientation ..o, 190
Making the Original Orientation Match the Paper Orientation (Windows) ...........ccoociiiiiiiiniie e 190
Making the Original Orientation Match the Paper Orientation (Mac OS X) ........cccocciiiiiiiiiiiiiniiee e 192
USING FAVOIIEES ...ttt e oot e e o et e oo e b b et e e e e e b et e e e e annbe e e e e e e ennreeas 196
Cutting ROIl Paper After PIINTING .........ooo ittt sttt e bt st e e e s be e e s sbbe e e enbae e e eneeas 196
Cutting Roll Paper After Printing (WINAOWS) ......oouiiiiiiiiieiieee ettt ettt nnbee e 196
Cutting Roll Paper After Printing (Mac OS X)) ....cooiiiiiiiiiiie ettt st e s ebeee e 198

3 'Printing With Watermarks

You can add watermarks (background images) to documents that require special handling.

W
N A
S S
QO qu
v\<<
&

Watermark

Watermarks are applied to all pages of your document.
@ Important
» Watermarks are not printed if you select poster as the type of page layout.

The following watermarks are provided:

* CONFIDENTIAL
 COPY

* DRAFT

* FILE COPY

e FINAL

* PRELIMINARY
* PROOF

* TOP SECRET
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You can also create your own watermarks. Specify the following options to customize your watermark.
e Watermark string: Specify the font, size, color, and so on. Surround the watermark with a frame, if desired.

* Watermark position: Specify the position on the page, the angle, and so on.

Printing With Watermarks iPF815
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» Watermark printing method: Specify whether to print the watermark superimposed or under the document image. You
can also print the watermark only on the first page, if desired.

Note
» Watermarks are supported in Windows.

* In addition to the provided watermarks, you can create up to 50 original watermarks in Windows.

For detailed instructions on printing with watermarks, refer to the following topics:

* Printing with Watermarks— COPY, FILE COPY, and so on (Windows)

'Printing with Watermarks— COPY, FILE COPY, and so on (Windows)

This topic describes how to print with watermarks, based on the following example of printing with a FILE COPY water-
mark.

* Document: Any type 3
» Page size: A2 (420.0x594.0 mm [16.5 x 23.4 in])

* Paper: Roll paper

* Paper type: Plain Paper

* Roll paper width: A2/A3 roll (420.0 mm [16.5 in[)

1 « Choose Print in the application menu.

2. Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications (Windows) ")

3. Make sure the Main sheet is displayed.
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4. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.

5. Make your selection in the = Print Target list.

Note
* You can check the settings values selected in the = Print Target list by clicking (= View Settings.

6. Click the Page Setup tab to display the Page Setup sheet.

7. In A Page Size, click the size of the original as specified in the application software. In this case, click ISO A2.
8. Select and click a roll paper in the L Paper Source list.

9. Select the width of the loaded roll in the VI Roll Paper Width list—in this case, ISO A2/A3 Roll (420.0mm).

188
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1 0. Click the Layout tab to display the Layout sheet.

1 1 o Select the L Watermark check box.

1 2. Click FILE COPY in the Watermarks list.

Note

e Click L) Edit Watermark to open the Edit Watermark dialog box. In the Edit Watermark dialog
box, you can create custom watermarks and change the position and angle of watermarks.

13 o Confirm the print settings and print as desired.

Note
* For tips on confirming print settings, see "Confirming Print Settings (Windows) "
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'Making the Original Orientation Match the Paper Orientation

You can specify the original orientation to match the orientation of the paper for printing.

Orientation

Paper is usually loaded in the printer in portrait orientation. When you have an original in landscape orientation, you can
specify the printing orientation so that the original is printed in landscape orientation.

Rotate 180 degrees

The original is rotated 180 degrees to print it upside down.

Mirror

A mirror image of the original is printed.

For instructions on specifying the original orientation before printing, refer to the following topics, as appropriate for your
computer and operating system.

» Making the Original Orientation Match the Paper Orientation (Windows)
» Making the Original Orientation Match the Paper Orientation (Mac OS X)

'Making the Original Orientation Match the Paper Orientation (Windows)

This topic describes how to print an original in landscape orientation after matching the paper orientation, based on the fol-
lowing example.

* Document: An original in landscape orientation

* Page size: A4 (210.0 x 297.0 mm)/Letter (8.3 x 11.7 in)
* Paper: Roll

* Paper type: Plain Paper

* Roll paper width: A2/A3 roll (420.0 mm [16.5 in])

1 « Choose Print in the application menu.

190
2. Select the printer in the dialog box, and then open the printer driver dialog box.(See "Accessing the Printer Driver
Dialog Box from Applications (Windows) ")
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3. Make sure the Main sheet is displayed.

4. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.
5. Make your selection in the = Print Target list.

6. Make your selection in the  Print Quality list.
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7. Click the Page Setup tab to display the Page Setup sheet.

8. In the /A Page Size list, click the size of the original as specified in the application. In this case, click ISO A4 or
Letter (8.5"x11").

9. In I Orientation, click < Landscape.
1 O. Select and click a roll paper in the . Paper Source list.
1 1 o Select the width of the loaded roll in the V! Roll Paper Width list—in this case, ISO A2/A3 Roll (420.0mm).

1 2. Confirm the print settings and print as desired.

Note
* For tips on confirming print settings, see "Confirming Print Settings (Windows) "

'Making the Original Orientation Match the Paper Orientation (Mac OS X)
192

This topic describes how to print an original in landscape orientation after matching the paper orientation, based on the fol-
lowing example.

* Document: An original in landscape orientation

* Page size: A4 (210.0 X 297.0 mm [8.3 % 11.7 in])
 Paper: Roll paper

* Paper type: Plain Paper

* Roll paper width: A2/A3 roll (420.0 mm [16.5 in])

Making the Original Orientation Match the Paper Orientation (Mac OS X) iPF815
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1 o This sets the 5 Format for and  Paper Size.

Note

* The configuration method varies depending on the OS and application software you are using.
If Page Setup is displayed in the application menu, the settings are configured by opening the Page
Attributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the upper part of the printer driver displayed when
you select Print from the application software menu.

« Select the printer in the /A Printer list.
« Inthe I~ Paper Size list, click the size of the original. In this case, click ISO A4.

o In U Orientation, click the icon of the document in landscape orientation.

nh =~ W N

« If you configured the settings using the Page Attributes dialog box, click = OK to close the dialog box, and then 193
select Print from the application software menu.
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6. Access the Main pane.

7. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.
8. Make your selection in the = Print Target list.
9. Make your selection in the = Print Quality list.

1 0. Access the Page Setup pane.
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1 1 o Select and click a roll paper in the /A Paper Source list.
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1 2. Make sure the width of the loaded roll is displayed in the = Roll Width list—in this case, ISO A2/A3 (420.0mm).

Note

o If the width of the roll loaded in the printer is not shown in = Rell Width, click L Printer Informa-
tion on the Main pane to update the printer information.

13. Make sure the  Page Size setting matches the original size as selected in © Paper Size in the Page Attributes
dialog box—in this case, ISO A4.

195

1 4. Confirm the print settings, and then click IVl Print to start printing.

Note
* For tips on confirming print settings, see "Confirming Print Settings (Mac OS X) "
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'Using Favorites

You can register print settings as Favorites to reuse settings from a particular job that met your expectations, or settings for
a particular page size that you will use repeatedly.

Favorites

Registering a favorite for later use. You can choose the settings you have registered from a list before printing, and you can
check the settings details.

Note

* You can also save the favorite settings as files. Using these files is a convenient way to print under the same
conditions on another computer. (In Windows.)

For instructions on using favorites to print, refer to the following topics, as appropriate for your computer and operating
system.

3 * Using Favorites (Windows)
* Using Favorites (Mac OS X)

'Cutting Roll Paper After Printing

Roll paper can be automatically cut after printing.

Note

* It may not be possible to cut certain types of paper, such as adhesive paper. For details on types of paper that
cannot be used with the auto cut feature, see the Paper Reference Guide. (See "Types of Paper ")

Automatic Cutting
Roll paper is cut automatically after printing. If you prefer, you can print continuously without cutting the roll, or you can
print a cut line.
For instructions on cutting roll paper after printing, refer to the following topics, as appropriate for your computer and oper-
ating system.

* Cutting Roll Paper After Printing (Windows)

* Cutting Roll Paper After Printing (Mac OS X)

'Cutting Roll Paper After Printing (Windows)

This topic describes how to cut roll paper automatically after printing (using the auto cut function), as well as how to print a
196 cut line for manual cutting.

Note

* The auto cut function is activated on the printer by default and when the printer driver is installed. Follow the
steps below to reactivate the function if it is disabled, or to select the setting for printing a cut line instead.

1 o Choose Print in the application menu.

2. Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications (Windows) ")

Using Favorites iPF815
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3. Click the Page Setup tab to display the Page Setup sheet.

4. Select and click a roll paper in the . Paper Source list.

5. Click N Reoll Paper Options to display the Roll Paper Options dialog box.

6. To enable automatic cutting, click Yes in the /A Automatic Cutting list. If you prefer to cut the paper later yourself,
click Print Cut Guideline.

7. Click OK to close the Roll Paper Options dialog box.

8. Confirm the print settings and print as desired.

197
Note

* For tips on confirming print settings, see "Confirming Print Settings (Windows) "

Roll paper will be automatically cut after printing.
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'Cutting Roll Paper After Printing (Mac OS X)

This topic describes how to cut roll paper automatically after printing (using the auto cut function), as well as how to print a
cut line for manual cutting.

Note
* The auto cut function is activated on the printer by default and when the printer driver is installed. Follow the
steps below to reactivate the function if it is disabled, or to select the setting for printing a cut line instead.

1 o This sets the 5 Format for and © Paper Size.

Note

* The configuration method varies depending on the OS and application software you are using.
If Page Setup is displayed in the application menu, the settings are configured by opening the Page
Attributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the upper part of the printer driver displayed when
you select Print from the application software menu.

198

2. Select the printer in the /A Printer list.
3. Choose the original size in the _ Paper Size list.

4. If you configured the settings using the Page Attributes dialog box, click " OK to close the dialog box, and then
select Print from the application software menu.

Cutting Roll Paper After Printing (Mac OS X) iPF815
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5. Access the Page Setup pane.

6. Select and click a roll paper in the /A Paper Source list.

7. Access the Main pane.
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8. In the A Media Type list, select the type of paper that is loaded.
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9. Click © Set to display the Paper Detailed Settings dialog box.

10. To enable automatic cutting, click Printer Default in the [ Automatic Cutting list. If you prefer to cut the paper
later yourself, click Print Cut Guideline.

Important
@ * If the automatic cut function has been deactivated on the printer, change the auto cut setting on the
printer Control Panel.

1 1 o Click OK to close the Paper Detailed Settings dialog box.

1 2. Confirm the print settings, and then click V! Print to start printing.

Note
* For tips on confirming print settings, see "Confirming Print Settings (Mac OS X) "
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Windows Software

Printer Driver 202
Preview 243
Free Layout 256
Color imageRUNNER Enlargement Copy 286
Print Plug-In for Office 301
HDI Driver 354
Status Monitor 387
Accounting 390
Digital Photo Front-Access 402 4
Device Setup Utility 403
Media Configuration Tool 406
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Printer Driver
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'Printer Driver Settings

For instructions on accessing the Windows printer driver, refer to the following topics.

* Accessing the Printer Driver Dialog Box from Applications
* Accessing the Printer Driver Dialog Box from the Operating System Menu

Printer Driver Settings iPF815
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For information on the Windows printer driver settings, refer to the following topics.

* Main Sheet

You can specify the type of paper, color processing, print quality, print preview, and other settings. Choose Easy Set-
tings to specify basic print settings based on the printing application or Advanced Settings to complete more detailed
settings as desired.

» Paper Detailed Settings Dialog Box

View Settings Dialog Box for the Printing Application
Color Adjustment Sheet: Color

Matching Sheet

* Color Adjustment Sheet: Monochrome

» Page Setup Sheet
You can specify the page size of the original, borderless printing, enlargement or reduction, the orientation, the paper
size and feed source, and automatic cutting.
* Output Method dialog box

» Paper Size Options Dialog Box

» Layout Sheet GgFxE
You can specify the page layout, watermarks, the orientation, the number of copies, and print processing options.

» Page Options Dialog Box
* Special Settings Dialog Box 203

Favorites Sheet Garxid
Groups of print settings you select on each sheet can be saved as a favorite. Favorites you have added can be edited or
used at the time of printing as desired.

Utility Sheet
You can specify settings related to maintenance for the Printhead and feed amount, as well as settings for Color im-

ageRUNNER Enlargement Copy.

Support Sheet EF2T)
You can view support information and the user manual.

iPF815 Printer Driver Settings
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* Device Settings Sheet

You can display settings for optional equipment installed on the printer and see the version information for the printer
driver.

imagePROGRAF Free Layout is a feature for freely arranging originals from various source applications on a single page
as desired before printing. For details, see Free Layout .

Color imageRUNNER Enlargement Copy is a feature for automatic enlargement and printing of scanned originals from a
Color imageRUNNER. For details, see Color imageRUNNER Enlargement Copy )

Important
@ * Color imageRUNNER Enlargement Copy and imagePROGRAF Free Layout cannot be used on 64-bit
version of Windows.

'Specifying Paper in the Printer Driver

If you have replaced the paper, you must complete the following settings in the printer driver.
@ Important
» Always specify the same type and size of paper in the printer menu and printer driver.
204 1 o Choose Print in the application menu.

2. Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications ")

Specifying Paper in the Printer Driver iPF815
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3. Make sure the Main sheet is displayed.

4. In the A Media Type list, select the type of paper that is loaded.

Note

* Click the = Get Information button to display the Paper Information on Printer dialog box. On
the Paper Information on Printer dialog box, you can obtain information on the paper in the printer
and configure printer driver settings for the feed source and type of paper.

This function requires that the Status Monitor be installed.
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5. Click the Page Setup tab to display the Page Setup sheet.

6. In the /A Page Size list, select the size of the original as specified in the application.
7. In the L Paper Source list, select how paper is supplied.

8. If you have selected roll paper in L Paper Source, select the width of the loaded roll in Vi Roll Paper Width.

Note
* A variety of settings are available in the printer driver to suit different printing applications.
For details on available printing conditions, see "Printer Driver Settings "

'Confirming Print Settings

There are two ways to confirm the print settings, as follows.

¢ Checking a preview of the settings

* Checking a print preview

206
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Checking a preview of the settings

A preview of the settings is displayed on the left side of the Main, Page Setup, and Layout sheets. By checking illustra-
tions and numerical values in the preview, you can confirm current settings for the page size, orientation, paper source, lay-
out, and so on.

Display Area Information Displayed

Top illustrations Tllustrations indicate the orientation, page layout, borderless printing selection, col-
or mode, and other settings information.

Middle, bordered area The page size, paper size, and method and percentage of enlargement or reduction
are indicated.

Bottom illustrations Tllustrations indicate the feed source, orientation, borderless printing selection, and
other settings information.

Note

* To confirm the Print Target specified in Easy Settings, click (> View Settings on the Main sheet to display
the View Settings dialog box.

Checking a print preview

You can check an image of the original just as it will be printed.

When you activate this feature, imagePROGRAF Preview or PageComposer is started before printing. Confirming how 207
documents will be printed this way helps prevent printing errors.

For details on print previews, see "Checking the Layout in a Preview Before Printing "

'Checking the Layout in a Preview Before Printing

This topic describes how to preview images of print jobs before actually printing them.

1 « Choose Print in the application menu.

iPF815 Checking the Layout in a Preview Before Printing
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2. Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications "

3. Make sure the Main sheet is displayed.

4. Select the L. Open Preview When Print Job Starts check box.

5. After you click OK, when you print a job, the imagePROGRAF Preview window will be displayed.

208

Note
e If PageComposer is running, access the Special Settings dialog box from the Layout sheet and clear
Enable Preview Switching.

Checking the Layout in a Preview Before Printing iPF815
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6. On the main window, you can check the layout and change settings as needed.

7. To print, click Print in the File menu.

Note
* For details on imagePROGRAF Preview functions, see Preview .

'Using Favorites

This topic describes how to register favorites and print using favorite settings.

Registering a favorite

This section describes the procedure for registering printing settings that have been changed in the driver as Favorites.

1 o Choose Print in the application menu. 4

2. Select the printer in the dialog box, and then display the printer driver dialog box. (Refer to "Accessing the Printer
Driver Dialog Box from Applications ")

3 « Perform normal printing settings.
The favorite is registered from here.

4. Click the Favorites tab to display the Favorites sheet.

209
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5. Click "l Add to display the Add dialog box.

o Enter a desired name in Name, such as Photos for Presentations or Monthly Report.
« Choose a fitting icon for these print settings in the Icon list.
« In Comment, enter a description of the favorite to be added, as desired.

« Click OK to close the Add dialog box.
The favorite you have added is now displayed in /A Favorites.

Note

 To save a favorite as a file, click < Export and specify the file to save.

Printing using the favorite

Follow the steps below to print using the favorite you have registered.

1 « Choose Print in the application menu.

2. Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications ")

210
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3 « Click the Favorites tab to display the Favorites sheet.

4. In the A Favorites, choose the favorite you registered.

Note
» To import a favorite, click | Import and specify the favorite file.

5. Click U Apply Favorite to replace the favorite settings with the current print settings.

6. Confirm the print settings and print as desired.

Note
* For instructions on confirming print settings, see "Confirming Print Settings "

'Accessing the Printer Driver Dialog Box from Applications

1 o Choose Print from the File menu to display the dialog box for printing conditions.

211
2. Select the printer, and then display the printer driver dialog box.

Note

* The dialog box for specifying printing conditions varies depending on the source application. In some
cases, when you select the printer, a sheet for configuring the printer driver is added to the dialog box.
In the following case, click Preferences.

» Example: Print dialog box displayed by the application software

iPF815 Accessing the Printer Driver Dialog Box from Applications
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Six sheets of print settings are displayed by the printer driver: Main, Page Setup, Layout, Favorites, Utility, and

Support.
212
Note
* The titles of dialog boxes may vary depending on the application, and sheets other than these six
sheets may be displayed.
Accessing the Printer Driver Dialog Box from Applications iPF815
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Important
@ * If you access the printer driver dialog box from the source application, changes you make to the settings will
only apply temporarily to that application. Because these are sizes you specify temporarily in the printer driv-
er, the sizes will not be available after you exit the application.

* You can also access the printer driver dialog box from the Windows system menu.
To use the settings continuously in all applications, open the printer driver from the system menu to make the
settings.
See "Accessing the Printer Driver Dialog Box from the Operating System Menu "

'Accessing the Printer Driver Dialog Box from the Operating System Menu

1 « Click start > Printers and Faxes (or Printers ).

2. Select the printer, and then display the printer properties dialog box.

213

iPF815 Accessing the Printer Driver Dialog Box from the Operating System Menu
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3 « Click Printing Preferences to display the Printing Preferences dialog box, titled with the name of this printer.

Note
e The Device Settings sheet is also an extension of the printer driver.(See "Device Settings Sheet
")
Six sheets of print settings are displayed by the printer driver: Main, Page Setup, Layout, Favorites, Utility, and
Support.
214
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Important
@ * If you access the printer driver dialog box from the operating system menu, changes you make to the settings
will apply to all applications you use for printing.

* You can also access the printer driver dialog box from applications.
See "Accessing the Printer Driver Dialog Box from Applications "

'Main Sheet

The following settings are available on the Main sheet. For details on settings items, refer to the printer driver help file.

Note
* On the Main sheet, choose Easy Settings to specify basic print settings based on the particular printing ap-
plication, or switch to Advanced Settings to complete more detailed settings as desired.

Common ltems

Media Type

Select the type of paper.
For information on the types of paper the printer supports, refer to the Paper Reference Guide.(See "Types of Pa- 215

per &

Get Information
Displays Paper Information on Printer. You can update the printer driver settings for the feed source, media type, and roll

width by selecting the feed source.
» Paper Information on Printer Dialog Box

iPF815 Main Sheet
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Advanced Settings

Displays Paper Detailed Settings. You can configure the printing settings to match the type of media, such as the ink dry-
ing time.

» Paper Detailed Settings Dialog Box

Open Preview When Print Job Starts

If you turn this on, imagePROGRAF Preview starts before printing.
This allows you to check on-screen previews of documents before printing.

» Checking the Layout in a Preview Before Printing

Status Monitor

Starts imagePROGRAF Status Monitor.

You can check the printer status, job status, and other conditions.

You can also set up email notification if printer errors occur by completing the Email Notice settings.
For details, refer to the Status Monitor help file.

About

Displays version information for the printer driver.

Defaults

Restores all settings on the sheet to the default values.

Configuration using Easy Settings

216

Print Target
Choose presets that match the type of document to be printed.

Main Sheet iPF815
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* Printing Photos and Images
* Printing Line Drawings and Text
* Printing Office Documents

Depending on the /A Media Type setting, some = Print Target options may not be available.

Print Quality
Choose the level of print quality.
* Giving Priority to Particular Graphic Elements and Colors for Printing

View Settings

Displays the Print Target setting values.
You can view and change the order of Print Target setting values.

* View Settings Dialog Box for the Printing Application

Configuration using Advanced Settings 4
Print Priority
Choose the graphic elements that you want to emphasize for printing. 217

* Giving Priority to Particular Graphic Elements and Colors for Printing

Print Quality
Choose the level of print quality.
* Giving Priority to Particular Graphic Elements and Colors for Printing

iPF815 Main Sheet

Downloaded from ManualsPrinter.com Manuals



http://www.manualsprinter.com

218

Windows Software > Printer Driver >

Color Mode

Choose the color mode.
* Giving Priority to Particular Graphic Elements and Colors for Printing

Note

* Depending on the /A Media Type setting, some ‘5 Color Mode options may not be available.

Color Settings
Click to display the Color Settings dialog box for more advanced color settings.

* Adjusting the Color in the Printer Driver

Thicken Fine Lines

Activate this option to print fine lines more distinctly.

Unidirectional Printing

Select this checkbox to prevent problems such as misaligned lines and improve the print quality. However, the printing
speed becomes slower.

Sharpen Text

Activate this option to print text more sharply.

Economy Printing
Select this checkbox to reduce the amount of ink consumed during printing. However, the print quality is worse than for
normal printing.
Select this mode if you want to conserve ink when checking drawings, for example. Depending on the /A Media Type and
Print Quality settings, this mode may not be available.

Main Sheet iPF815
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'Paper Information on Printer Dialog Box

On the Paper Information on Printer dialog box, you can obtain information on the paper in the printer and configure
printer driver settings for the paper source and media type.

Paper Information on Printer &|

A Paper Source

(%) Roll Paper
Media Tupe : Flain Paper
Fioll Paper Width : 17-in. Rall [431.8mm)

i Theze media typesz and paper sizez are specified on the prinker for the
. ) cormesponding paper sources,

By choosing a desired paper source here, you can automatically apply
the printer settings [including media type and roll width] ta the printer
driver.

[ Ok l[ Cancel l

Note

e To display the Paper Information on Printer dialog box, on the Main sheet, click Get Information by
Media Type.(See "Main Sheet ")

Paper Source

Shows the paper source supported by the printer, as well as information about the loaded paper. To update the paper source
and media type settings in the printer driver, select the desired Paper Source option and click OK.

'Paper Detailed Settings Dialog Box

The Paper Detailed Settings dialog box offers the following settings. For details on settings items, refer to the printer driv-
er help.

219

iPF815 Paper Information on Printer Dialog Box
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Note
e To display the Paper Detailed Settings dialog box, on the Main sheet, click Settings by Media Type.(See

"Main Sheet "

Drying Time
Specify the time that the printer waits for ink to dry, as needed. The Drying Time setting is only valid for rolls.
* (See "Specifying the Ink Drying Time for Rolls ")

Between Pages

Specify the time the printer waits after printing a page until ejecting the paper, as needed.

Between Scans

Specify the time the printer waits after printing a line on the page until printing the next line, as needed.

Roll Paper Margin for Safety

You can specify the length of a margin on the leading edge of paper to ensure that paper susceptible to curling is held firmly
against the Platen.

Near End Margin
Specify the length of the Near End Margin (the leading edge margin) of the roll, as needed.

Cut Speed

Select the speed of automatic cutting, as needed. You can adjust this setting if paper is not cut well when automatic cutting
is used.

Mirror

Specify whether to print a mirror image, as needed. Select this option to print a version of the document or image with the
left and right sides inverted.

Paper Detailed Settings Dialog Box iPF815
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'View Settings Dialog Box for the Printing Application

In the View Settings dialog box, you can check details of the selected printing application.

View Settings E|
Frint Target : | A B Mame Default Settings
: mage|
CAD [Calor Line Dirawing)
CAD [Monochrome Line Diawing |
Perspective, GIS
Phota [Calar)
Office Document o
Faithful Color Reproduction C Details :
Parameter Settings
Print Priority Image
Prrint Qluality Standard
Color Mode Calor
[Colar Adjustment]
Brightness n]
Contrast 0
Saturation 0
Object Adjustment All
[t atching]
tatching Made Driver Matching Maode
Matching Method Perceptual
Thicken Fine Lines Off
Uridirectional Printing aff
Sharpen Text On
Economy Printing aff 4
£ |
]
Ok ] [ Cancel ] [ Help

Note

» To display the View Settings dialog box,

on the Main sheet, click View Settings by Print Target.(See
"Main Sheet ")

Print Target

Shows all Print Target options (settings items for the printing application).

Name

Identifies the item selected in Print Target by its name and an icon.

Details

Here, you can confirm detailed settings values for each listed item for the selected Print Target.

'Color Adjustment Sheet: Color

If the color tone as printed is not as you expected, you can adjust it on the Color Adjustment sheet.

221

iPF815 View Settings Dialog Box for the Printing Application
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Note
e To display the Color Adjustment sheet, on the Main sheet, click Color Settings by Color Mode in Ad-
vanced Settings.(See "Main Sheet ")

Sample Type

Choose a sample image from Standard, Portrait, Landscape, or Graphics.

View Color Pattern
Select this checkbox to display the color pattern.

Apply to Sample
Select this checkbox to apply the changed settings to the sample image.

Cyan/ = Magenta/ I~ Yellow

Fine-tune color tones by adjusting the levels of each color.

Gray Tone

Adjust the color tone of grays as desired. Choose Cool Black (tinged with blue) or Warm Black (tinged with red).
202

Brightness

Adjust the overall image brightness as desired. You can adjust the brightness if the printed document is lighter or darker
than the original image (that is, the original photo that was scanned or the original graphic as it appears on the computer
screen).

Contrast

Adjust the contrast of the darkest and lightest portions relative to each other, as desired. Increasing the Contrast makes
images sharper, and reducing the Contrast softens images.

Color Adjustment Sheet: Color iPF815
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Saturation

Adjust the color intensity as desired. Increasing the Saturation setting makes colors more vivid, and reducing the Satura-
tion makes colors more subdued.

Object Adjustment

Select this option to display the Object Adjustment dialog box, in which you can specify objects subject to color adjust-
ment.

* Object Adjustment dialog box: Color

Defaults

Click to restore all settings on the sheet to the default values.

Note
* For details on settings items, see "Adjusting the Color in the Printer Driver "

'Object Adjustment dialog box: Color

In the Object Adjustment dialog box, you can specify what type of print jobs to apply color adjustment to. If an original
comprises images, graphics, and text, you can specify which portion to apply color adjustment to.

Note
 To display the Object Adjustment dialog box, click Object Adjustment on the Color Adjustment sheet.

Image
223

Select this option to apply color adjustment to image areas, such as photos.

Graphics

Select this option to apply color adjustment to graphics, such as lines and circles.

Text

Select this option to apply color adjustment to text.

iPF815 Object Adjustment dialog box: Color
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'Matching Sheet

On the Matching sheet, you can specify color matching to compensate for differences in the appearance of colors on vari-
ous devices.

Note
* To display the Matching sheet, on the Main sheet, click Color Settings in Color Mode in Advanced Set-
tings, and then click the Matching sheet. (Refer to "Main Sheet ")

Important
@ * If No color correction is selected under Color Mode, the Matching sheet is not displayed.

Driver Matching Mode

The following options are available when you select Driver Matching Mode in the /A Matching Mode list.

Matching Mode

Select the color matching mode to use, as desired.
Normally, select Driver Matching Mode. For color matching based on ICC profiles, select ICC Matching Mode, Driver
ICM Mode, or Host ICM Mode, depending on your color matching system.

224 Matching Method

Select the color matching method that suits the document to be printed. Various Matching Method options are available
depending on your selection in Matching Mode.

Matching Sheet iPF815
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ICC Matching Mode, Driver ICM Mode and Host ICM Mode

The following options are available when you select ICC Matching Mode, Driver ICM Mode, or Host ICM Mode in the
Matching Mode list.

Matching Mode

Select the color matching mode to use, as desired.

Input Profile Settings

You can select Image, Graphics, or Text. You can choose Matching Method and Input Profile.

Various options are available depending on your selected Matching Mode.

To apply the same input profile automatically for Graphics and Text, select Use the Same Profile for All Objects. To
apply separate input profiles to Graphics and Text, clear Use the Same Profile for All Objects and specify the individual
settings.

Printer Profile Settings
Specify the printer profile as desired. Normally, select Auto Settings.

Note
* For details on settings items, see "Adjusting the Color in the Printer Driver "

225
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'Color Adjustment Sheet: Monochrome

On the Color Adjustment sheet for monochrome printing, you can adjust the brightness and contrast.

Note
* To display the Color Adjustment sheet, on the Main sheet, click Color Settings by Color Mode in Ad-
vanced Settings.(Sec "Main Sheet ")

Sample Type

Choose a sample image from Standard, Portrait, Landscape, or Graphics.

View Color Pattern
Select this checkbox to display the color pattern.

Apply to Sample
Select this checkbox to apply the changed settings to the sample image.

Cyan/ = Magenta/ I~ Yellow

Not available.
226

Gray Tone

Not available.

Brightness

Adjust the overall image brightness as desired. You can adjust the brightness if the printed document is lighter or darker
than the original image (that is, the original photo that was scanned or the original graphic as it appears on the computer
screen).

Color Adjustment Sheet: Monochrome iPF815
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Contrast

Adjust the contrast of the darkest and lightest portions relative to each other, as desired. Increasing the Contrast makes
images sharper, and reducing the Contrast softens images.

Saturation

Not available.

Object Adjustment

Select this option to display the Object Adjustment dialog box, in which you can specify objects subject to color adjust-
ment.

* Object Adjustment dialog box: Monochrome

Defaults

Click to restore all settings on the sheet to the default values.

Note 4

* For details on settings items, see "Adjusting the Color in the Printer Driver "

'Object Adjustment dialog box: Monochrome

In the Object Adjustment dialog box, you can specify what type of print jobs to apply color adjustment to. If an original
comprises images, graphics, and text, you can specify which portion to apply color adjustment to.

Note
* To display the Object Adjustment dialog box, click Object Adjustment on the Color Adjustment sheet. 227

Image
Select this option to apply color adjustment to image areas, such as photos.

Graphics

Select this option to apply color adjustment to graphics, such as lines and circles.

iPF815 Object Adjustment dialog box: Monochrome
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Text

Select this option to apply color adjustment to text.

'Page Setup Sheet

The following settings are available on the Page Setup sheet. For details on settings items, refer to the printer driver help
file.

Page Size

Select the page size as specified in the source application.
For details on available page sizes, see "Paper Sizes Gaaz1) "

Borderless Printing

228

Borderless printing is available if roll paper is selected in the L. Paper Source list. Choose from the following options when
this setting is activated.

* Borderless Printing on Paper of Equivalent Size
* Borderless Printing by Resizing Originals to Fit the Roll Width
* Borderless Printing at Actual Size

Page Setup Sheet iPF815
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Fit Paper Size

Scales the document image to match the paper size.

Scale to fit Roll Paper Width

Scales the document image to match the roll width.

Print Image with Actual Size

Prints documents at their actual size. This function is available when you have selected the size same as the width of Rell
Paper for either the length or width of the document from the /A Page Size list.

Paper Size

Available when [ Fit Paper Size is selected.

Choose the size of the paper you will print on.

For details on available paper sizes, see "Paper Sizes "
Paper sizes compatible with borderless printing are shown in the list.

Enlarged/Reduced Printing

Choose from the following options when this setting is activated.

* Resizing Originals to Match the Paper Size
* Resizing Originals to Fit the Roll Width
 Resizing Originals by Entering a Scaling Value

Fit Paper Size

Scales the document image to match the paper size.

Fit Roll Paper Width

Scales the document image to match the roll width.

Scaling
229

Resizes the document image based on a specified scaling value. Enter a value in a range of 5-600.

Paper Size

Choose the size of the paper you will print on.
For details on available paper sizes, see "Paper Sizes "

Orientation

Choose the printing orientation.

iPF815 Page Setup Sheet
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» Making the Original Orientation Match the Paper Orientation

Rotate Page 90 degrees (Conserve Paper)
Activate this setting to rotate the document image by 90 degrees before printing.

» Conserving Roll Paper by Rotating Originals 90 Degrees

Paper Source

Choose the feed source, as desired.
Options displayed in the list vary depending on the selection in Media Type on the Main sheet.

Roll Paper Width

Choose the roll width.
For details on available roll widths, see "Paper Sizes "

Roll Paper Options
Complete optional roll paper settings. Click to display the Roll Paper Options dialog box.

Under A Automatic Cutting, you can specify Yes or No and Print Cut Guideline.

* Cutting Roll Paper After Printing

Select = Banner Printing when printing multiple pages continuously.

* Printing Multiple Pages Continuously

Output Method

Click to display the Output Method dialog box, which enables you to complete the Output Method and Name of data to
be saved settings.

* Output Method dialog box

Size Options

Click to display the Paper Size Options dialog box, which enables you to register additional paper sizes or select the size
system for use.

* Paper Size Options Dialog Box

Defaults

Restores all settings on the sheet to the default values.

Page Setup Sheet iPF815
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'Output Method dialog box

The Output Method dialog box allows you to select the Output Method and set the save settings when saving to the box.

Note
* To display the Output Method dialog box, on the Page Setup sheet, click Output Method. (Refer to "Page
Setup Sheet ")

Output Method

If Print is selected, the print job is saved to the printer hard disk after printing has finished.

If Print (auto delete) is selected, the data is deleted immediately after printing has finished.

If Save in mail box is selected, the print job is saved to the printer hard disk. If you choose Save in mail box, also specify
the destination personal box in the Mail box list.

If the Save data before printing check box is selected, printing starts after the print job has finished being saved in the
temporary save box.

Name of data to be saved 231

To use the file name, choose Use file name.
Otherwise choose Enter name and enter a name in Name.

Mail box

Displays a list of mail boxes. If you choose Save in mail box, also specify the destination personal box from the list.

iPF815 Output Method dialog box
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Acquire Mail Box Name

When this is clicked, the box name acquired from the printer main unit is displayed in Mail box.

'Paper Size Options Dialog Box

In the Paper Size Options dialog box, you can create and register your own Custom Paper Size. The sizes you define are

listed with standard paper sizes for selection later as needed.

Paper, Size Options

Paper Size List : C Custam Paper Size Mame :
A Mame Size b

@ JISB1 28.66 « 40.55 T

@ JISB2 20.28 % 28.66 @

*JISE3 143342028 _

#JI5 B4 1012 % 14.33 @ inch

@ 34" 44" (ANS] E) 34.00 % 44.00 )

* 28"40"(ANS F) 2800 % 40,00 Bl - Paper Size

@ 2234 [AN5I D) 2200 % 34.00 [ Barderless Printing Size

@722 ANSI C) 17.00% 22.00 [ Fitt the: Ratio of the \width to Height

21319 (Super B) 13.00%19.00 Width - 50~ | .

4 * 1117 (Ledger] 11.00%17.00 - inch(3.34 - 44.02)

@ | etter(8.5"11") 2.50%11.00 Z Height : 11.00 5 | inch(3.00 - 702.65)
B F Add
G Dizplay Series :

[J4DIN(C3,C4...) [¥] Phata
12150 BB3.B4...] [¥] 5 ARCH [&.B...] [] Oversize
[¥]3JIS [B3.B4...) []Other
I Ok ] [ Cancel ] [ Help

Note

e To display the Paper Size Options dialog box, on the Page Setup sheet, click Paper Size Options.(See

"Page Setup Sheet ")

Paper Size List

Shows the names and sizes of paper that can be used with the print

Delete

er driver.

Custom paper sizes created by users can be deleted from the /A Paper Size List, as needed.

However, they cannot be deleted in the following situations.

* If a standard paper size of the printer driver is selected.

* If an oversized paper size is selected.

232

* If a paper size marked with a red circle is selected.

Custom Paper Size Name

You can name Custom Paper Size as desired.

Units

Specify the desired unit of measure for the Custom Paper Size height and width.

Paper Size Options Dialog Box
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Paper Size

Specify the desired Width and Height. You can make your selection from sizes that are compatible with Borderless Print-
ing by selecting Borderless Printing Size. To maintain the aspect ratio of the Width and Height as you resize the paper,
select Fix the Ratio of the Width to Height.

Add

Enables you to register the custom paper size you have specified or overwrite an existing custom paper size.

Display Series

You can limit the number of options shown in Page Size, Paper Size, and Paper Size List.

'Layout Sheet

The following settings are available on the Layout sheet. For details on settings items, refer to the printer driver help.

Page Layout
Activate this setting to select a particular page layout.
* Printing Multiple Pages Per Sheet 233
* Printing Posters in Sections
* Printing Multiple Originals Next to Each Other
* Using PosterArtist to Compose Originals

Set

Click to display one of the following dialog boxes depending on the selection in /\ Page Layout. In these dialog boxes, you
can specify layout details and which pages to print, as well as other settings.

iPF815 Layout Sheet
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* Page Layout Printing
* Pages to Print
* Free Layout Settings

Watermark

Activating this option makes two settings available, Watermarks and ) Edit Watermark.

* Printing With Watermarks

Watermarks

Lists the provided watermarks. Choose the watermark to print.

Edit Watermark

Click to display the Edit Watermark dialog box for creating your own, original watermark.

Print Centered

Activate this setting to print document images in the center of the paper.
* Printing Originals Centered on Rolls
* Printing Originals Centered on Sheets

Rotate 180 degrees

Activate this option to rotate document images by 180 degrees before printing.

No Spaces at Top or Bottom (Conserve Paper)

Activate this setting to print the next image skipping blank areas above and below printable data in documents, which ena-
bles you to conserve the paper.

» Conserving Roll Paper by Printing Originals Without Top and Bottom Margins

Copies

Enter the number of copies to print, in a range of 1-999.

Reverse Order

Activate this option to print pages in reverse order.

Page Options

Click to display the Page Options dialog box, which enables you to complete settings for printing the user name, date, or
page number in the header or footer.

» Page Options Dialog Box

Special Settings
If the printing results are not as you expected, click this option to change how printing is processed.

* Special Settings Dialog Box

Layout Sheet iPF815
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Defaults

Click to restore all settings on the sheet to the default values.

'Page Options Dialog Box

The Page Options dialog box offers the following settings.

Page Options E|
Print Date : A&
|D|:| Mok Print v|
Print Time Alzo J
Frint Uzer Hame : C
|D|:| Mat Print V|

Print Page Mumber : [0
|D0 Hat Print v|

E [ Farmat Settings... ]

| ] | [ Cancel l [ Defaults ] [ Help ]
Note
* To display the Page Options dialog box, on the Layout sheet, click Page Options.(See "Layout Sheet
i)
Print Date

Select where the date is printed, as desired. To print the time as well, select = Print Time Also.

Print User Name

Select where the user name is printed, as desired.

Print Page Number

Select where the page number is printed, as desired.

Format Settings

Click to display the Format Settings dialog box, which enables you to complete format-related settings.

Format Settings E|
235
Font: i 4
Style | Regular w |
Size: Paints [1 - 72]
Calor - Ml Black v|
0k l [ Cancel l [ D efaultz ] [ Help ]
iPF815 Page Options Dialog Box
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Note
* If you specify the same position for multiple items, the items are printed from left to right in this order: date,
user name, and page number.

* When you print multiple pages per sheet using Page Layout Printing or similar functions, these items will
be printed for each page.

'Special Settings Dialog Box

If the printing results are not as you expected, you can change how printing is processed in the Special Settings dialog box.

Special Settings E|
FineZoom Settings : [ T

Application Colar Matching Prioity |B
[ Enable Preview Switching (G
4 Fast Graphic Procesz )

Reduce Print Unevenness E
Adjuzt faint lines [

[ ak. ] [ Cancel ] l Defaultz ] [ Help ]
Note
* To display the Special Settings dialog box, on the Layout sheet, click Special Settings.(See "Layout Sheet
5

FineZoom Settings

This function is used in large-format printing. Normally, choose Auto. If documents are not printed correctly on large-for-
mat paper, it may help to select Yes, and if fine lines are not visible or if images are distorted when printed, it may help to
select No.

Application Color Matching Priority

You can give applications priority in color management.

Enable Preview Switching

When this option is selected, PageComposer starts if you print with Open Preview When Print Job Starts selected on the
Main sheet.

236 Fast Graphic Process

If image colors are inconsistent in printed documents or if lines are printed in varying thicknesses, clearing this option may
help produce the expected results.

@ Important
e This function cannot be used on 64-bit version of Windows.

Special Settings Dialog Box iPF815
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Reduce Print Unevenness

If you are concerned about print unevenness, the printing results can be improved by selecting this option. However, print-
ing may take longer for some images.

Adjust faint lines

If fine lines are printed in colors that do not match the colors of other shapes, clearing this option may help produce the
expected results. However, lines in some colors may appear broken.

'Favorites Sheet

The following settings are available on the Favorites sheet. For details on settings items, refer to the printer driver help.

Favorites
Printing favorites you have created are listed with Default Settings favorites.

e Using Favorites a4 E

Settings Details

Displays details of the favorite selected in the /A Favorites. 237

Comment

Displays notes registered in the favorite.

Apply Favorite

Click to change the current print settings to those of the favorite selected in the /A Favorites.

iPF815 Favorites Sheet
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Application Settings Priority

Activate this setting to use settings values specified in the source application in preference to favorite settings selected in the

Favorites, when clicking L) Apply Favorite. For details on the settings items used in preference, refer to the printer driv-
er help.

Delete

Click to delete the selected favorite from the /A Favorites list.

Edit
Click to display the Edit dialog box, which enables you to change the name and icon for the favorite selected in the
Favorites list.

Add
Click to display the Add dialog box, which enables you to add the current print settings as a favorite.

Import

Click to display the Open dialog box, which enables you to import favorite settings saved as a file.

Export

Click to display the Save As dialog box, which enables you to save the favorite settings as a file.

Up
Click to move the selected favorite up in the /A Favorites list.

238
Down

Click to move the selected favorite down in the /A Favorites list.

Favorites Sheet iPF815
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'Utility Sheet

The following items can be executed on the Utility sheet. For details on the utilities, refer to the relevant utility help.

Maintenance
Click to start the imagePROGRAF Status Monitor, which offers the following maintenance for the printer.
* Nozzle (ink ejecting outlet) check
* Nozzle (ink ejecting outlet) cleaning
* Head alignment adjustment

¢ Feed amount adjustment

Color imageRUNNER Enlargement Copy

Click to launch Color imageRUNNER Enlargement Copy (iR enlargement copy), which enables you to create hot folders
used for Color imageRUNNER Enlargement Copy and assign print settings to hot folders.

* Printing Enlargements of Scanned Originals from a Color imageRUNNER

For details, see Color imageRUNNER Enlargement Copy .

239
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'Support Sheet

On the Support sheet, you can view support information and the user's manual.

Support Information

Click to access the Canon support webpage, where you can find the latest information on the printer and consumables,
check for printer driver updates, and browse other information.

User Manual

Click to view the printer user's manual. This function requires the user's manual to be installed on your computer.
Settings Summaries

Click to display the View Settings dialog box, which enables you to confirm the settings for the Main, Page Setup, Lay-
out, and Favorites sheets.

240
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'Settings Summaries Dialog Box

The Settings Summaries dialog box enables you to confirm the settings for the Main, Page Setup, Layout, and Favorites
sheets.

Copy

Click to copy the settings information to the clipboard. You can paste the settings information into a file created with a text
editor or similar application.

241
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'Device Settings Sheet

Many settings items on the printer properties sheets are controlled by Windows applications. However, the Device Settings
sheet is for configuring the printer, and it is an extension of the printer driver.
The following settings are available on the Device Settings sheet.

Color Compatibility

Click to display the Color Compatibility dialog box, which enables you to adjust colors if you have selected Color Mode
> Color (CAD).

* For details on color settings, see Specifying Colors and Printing CAD Drawings .

About

You can display version information for the printer driver.

242
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Preview
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'The Features of Preview 4

The main features of Preview are as follows.

e While viewing this screen, you can adjust layout settings of a document created with application software.
* You can not only adjust layout settings but also your changes will be instantly applied on the preview screen, and you
can print the preview screen as it is seen.

Note

» The media type, image size, detailed media settings, and the printer settings can cause the actual print output
to differ from the Preview settings.

'Operating Environment

You can use the Preview in the following environments.

* Compatible Operating System
Windows 2000, Windows XP, Windows Server 2003, Windows Vista, Windows Server 2008, Windows 7

¢ Software that requires installation
imagePROGRAF Printer Driver

'Starting Preview

Follow the procedure below to start the Preview.

243

1 « Start the apllication software which you use.

2. From the application software's File menu, select the printer setup menu to open the Print dialog box.

Note
* Normally, select Print from the File menu.

iPF815 The Features of Preview
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3 « On the Main sheet, click on the Open Preview When Print Job Starts check box.
Click the OK button to save the settings.

Note
* Your printer is depicted in the lower-left area of this screen.

4. On the Print dialog box in the apllication software, click the Print button.

5. Preview main window is displayed.

244
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'Preview Main Window

The Preview main window consists of the menu and tool bars, preview and dialog area and status bar.

Note
* You can use the View menu to show or hide the tool bar.

Menu Bar

This allows you to select menus required for operations.

£ Canon imagePROGRAF Preview - Canon iPFxooo

File Miew Options Help

Tool Bar

This allows you to select tool buttons required for major operations.

@ Z00M: |Fit Screen w I‘ ‘ . .I {@

245
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Preview Area

You can check the settings you made in this area.

Dialog Area

This allows you to set the print conditions and perform a print job.

246
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For more information about Dialog Area, see "Dialog Area." GeZ¢ZL]

Status Bar

Media Type: Flain Paper
Faper Source: Rall Paper
Fall Paper width: 17-in. Fall [431 . 8mm)

Layout Selection

24

L &

'E' [ Center Driginals Across Roll

[::I [[JMo Spaces at Top ar Battom

[ Print l [ Cancel

Prititer Information

Frinter Status
Online

Feed Information
b anual feed tray
Faper Size : Letter8.5"11"
Faper Type : Plain Paper
Faper Remaining : Loaded

Foll Paper 1

=2

Fiall Paper width - 17-in. Fall (431 S

Faper Type : Plain Paper
Dermmr D mrm miamiemm - 06 T

< |

E

hd

[ Update Printer Information

[ Status Monitor

This shows the message, Pages and Output Size.

Ratating images 90 degrees can conserve paper.

Pages : 1[1

Oukput Size @ 11,70 = 16.5i0

iPF815
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'Dialog Area

You can select the layout and print on the center.

Media Type: Flair Paper
Faper Source: Rall Paper
Roll Paper width: 17-in. Roll (431, 8mm)

Layout Selection

'@' [] Center Driginals Across Roll

I:::l [[TMo Spaces at Tap or Bottom

[ Print ] [ Cancel

Prirter Information

Frinter Status
Online

Feed Information
tanual feed tray
Faper Size : Letter(8.5"11")
Faper Type : Plain Paper
Faper Remaining : Loaded

Roll Paper 1
Rl Paper width : 17-in. Roll (431, 8mm
Faper Type : Plain Paper
i .

Errot m R e L] T N

4 *

bl

[ Update Printer Information

[ Status Monitor

Media Type / Paper Source /Paper Size

You can confirm the information that is set.

Layout Selection

You can print which conserves paper by selecting the layout.

For more information about Layout Selection, see "Printing with Selecting the Layout."

Center Originals Across Roll

You can print on the center of the media loaded in the printer.

For more information about Center Originals Across Roll, see "Print on the Center."

Note

* Available only if rolls are selected in Paper Source.

Dialog Area
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No Spaces at Top or Bottom

You can save paper on not to feed roll paper for the empty spaces when the print data contains spaces at the top or bottom.
For more information about No Spaces at Top or Bottom, see "Not Print Spaces at the Top/Bottom."

Note
* Available only if rolls are selected in Paper Source.

Print Button
Click the button to start printing.

Cancel Button
Click the button to stop printing.

Printer Information

You can confirm the information acquired from the printer. 4

Update Printer Information Button

Click the button to update the printer information with connecting to the printer.

Status Monitor Button
Click the button to start Status Monitor.

'EnlargelReduce the screen display

You can enlarge or reduce the screen display when you select Zoom from the View menu.

Setting Details
Fit Screen Display all.
Fit to Width Display to the width of the paper.
Reduce Display at half of the standard size.
Standard Display at the standard size.
Enlarge Display with the double of the standard size.
Enlarge More Display with the triple of the standard size.

249
Note

e This item can be selected even if you have clicked the ¥ button in the toolbar Zoom.

'Moving a Page

You can move a page to display when you select Go to Page from the View menu.

iPF815 Enlarge/Reduce the screen display
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Setting Details
First Page Go to the first page.
Previous Page Go to the previous page.
Next Page Go to the next page.
Last Page Go to the last page.
Go To Page Go to the specified page.

Note

H 4% M

* You can also move a page by clicking on the tool bar.

'Using the ruler

You can confirm the layout with using the ruler.
4 * Switching the ruler Show/Hide
In the View menu, select Ruler to switch the ruler Show/Hide.

* Changing the ruler unit
You can set the ruler unit when you select Units from the View menu.
Setting Details
mm Use mm as the ruler unit.

inch Use inches as the ruler unit.

'Priority setting for rotating 90 degrees

You can select Rotate 90 Degrees If Possible or Use Driver Settings from the Options menu.

& Canon imagePROGRAF Preview - Canon iPFxooc

File  Wwiew BslEft=8 Help
v Rotate 90 Degrees If Possible
Use Driver Settings

Setting Details
Rotate 90 Degrees If Possible Rotates pages in portrait orientation 90 degrees before printing. Pages are only ro-
tated if they can fit lengthwise across the roll.
Use Driver Settings Follows printer driver settings when determining whether to rotate pages.
250
Using the ruler iPF815
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Selecting Rotate 90 Degrees If Possible or Placing a checkmark for Rotate Page 90 degrees (Conserve Paper) on the
printer driver

Selecting Use Driver Settings

251
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You can print which conserves paper by selecting the layout.

1 « In Layout Selection, click the layout button to use.

Button Details

Upper Button

Turn at the position of

252 Right Button
Turn at the position of
Left Button
Turn at the position of
Printing with Selecting the Layout iPF815
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Button Details

Lower Button

Turn at the position of

Note

* Right Button or Left Button can be selected only when the rotated pages can fit lengthwise across

the roll.

* By clicking Right Button or Left Button, you can save paper by printing in landscape orientation on

roll paper.

* You can select only Upper Button or Lower Button if Cut Sheet is selected.

Button Details

The button is selected currently.

The button can be selected.

The button can not be selected.

2. Click the Print Button.

Printing on the selected layout begins.

iPF815
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'Print on the Center

You can print on the center of the media loaded in the printer.

1 « Click the Center Originals Across Roll check box on.

2. Click the Print button

Printing on the center begins.

Note
* Available only if rolls are selected in Paper Source.

254
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'Not Print Spaces at the Top/Bottom

You can save paper on not to feed roll paper for the empty spaces when the print data contains spaces at the top or bottom.

1 o Click the No Spaces at Top or Bottom check box on.

2. Click the Print button.

Printing on the settings with no spaces at top or bottom begins.

255
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Windows Software > Free Layout >

Free Layout
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'The Features of Free Layout

The main features of Free Layout are as follows.

e Allows you to lay out at will and print a document created with application software.

* You can not only lay out multiple pages on one page but also lay out and print a multiple-file document on one page,
or lay out and print a document created with multiple application programs on one page.

* Any two pages can be arranged and printed in a layout that becomes duplex on folding.
This can be used such as for advertising posters that are suspended from the ceiling.

The Features of Free Layout iPF815
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Note
* The media type, image size, detailed media settings, and the printer settings can cause the actual print output
to differ from the Free Layout settings.

'Operating Environment

You can use the Free Layout in the following environments.

* Compatible Operating System
Windows 2000, Windows XP, Windows Server 2003, Windows Vista, Windows Server 2008, Windows 7

 Software that requires installation
imagePROGRAF Printer Driver

Note
e This function is not available on 64-bit version of Windows.

'Starting Free Layout

Follow the procedure below to start the Free Layout.

1 « Start the apllication software which you use.

2. From the application software's File menu, select the printer setup menu to open the Print dialog box.

Note
e Normally, select Print from the File menu.

3 o From the list, select the printer and select the Layout sheet.

257
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Note
* Your printer is depicted in the lower-left area of this screen.

4. In the Layout sheet, click on the Page Layout check box and select Free Layout from the list.
Click the OK button to save the settings.

Note
* When you select Free Layout, all other setting items will be disabled.

5. On the Print dialog box in the apllication software, click the Print button.
Free Layout main window is displayed.

258
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'Free Layout Main Window

The Free Layout main window consists of the menu and tool bars, layout area and status bar.

Note
¢ You can use the View menu to show or hide the tool and status bar.

Menu Bar

This allows you to select menus required for operations.

Tool Bar

This allows you to select tool buttons required for major operations.

259
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Layout Area

This allows you to lay out objects and edit the object size and orientation.

Status Bar
This shows the paper size, unit of length, and number of objects.
IRDII Paper : 24-in. Roll (609, &) nits:inch Mumnber of Objecks;4 I
260
Free Layout Main Window iPF815
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'Detailed Settings

The printer driver opens when you select Detailed Settings from the File menu. The printer driver is used to configure basic
settings to match the type of media loaded in the printer.

Refer to Printer Driver @3g71F) for details on the printer driver.

Note
* When you select the Detailed Settings, the only three sheets displayed are the Main sheet, the Page Setup
sheet, and the Layout sheet. Some of the printer driver settings may be disabled.

261
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'Preferences Dialog Box

This dialog box appears when you select Preferences from the File menu. This allows you to configure the preferences of
Free Layout.

Preferences @

Lnitz

) mim

inch

Gridiines: inchl0.39-7.88)
Divizions: sections [1-10)
[Erid Calor: |_ Gray

Auto drrange Spacing: inchi0.00-3.34]

Solid Line v

Object Frame Style:

] ][ Cancel ] [ Defaults

Units

Set the unit for paper length, margins, and so on.

Gridlines
You can input a grid line width value in numerical characters so that they serve as a guide to laying out objects.

Note
* You can input between 10.0 and 200.0(mm) (between 0.39 and 7.88(inch)).

* You can change the numbers by clicking either A button or ¥ button.

Divisions
You can change the number of divisions of grid lines so that they serve as a guide to laying out objects.

Note
* You can input between 1 and 10.

* You can change the numbers by clicking either A button or ¥ button.

Grid Color

Select the grid line color.

Auto Arrange Spacing

Change the object-to-object spacing to be applied in the operation of laying out objects automatically.

Preferences Dialog Box iPF815
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Note
* You can input between 0.0 and 100.0(mm) (between 0.00 and 3.94(inch)).

* You can change the numbers by clicking either A button or ¥ button.

Object Frame Style

You can select the object frame style for printing.
The following settings are available for the object frame style.

Setting Details
None You can print with no frame style.
Solid Line You can print the solid line as the frame style.
Dotted Line You can print the dotted line as the frame style.
Dashed Line You can print the dashed line as the frame style.
Crop Marks You can print with the crop marks.

'Page Options Dialog Box

This dialog box appears when you select Page Options from the File menu. This allows you to configure the roll paper
length, object layout order, and margins of Free Layout.

263

Roll Paper Length

Set the length of one page to print on roll paper.
The following settings are available for roll paper length.

iPF815 Page Options Dialog Box
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Setting Details
Auto Settings The one-page length to be printed on roll paper is automatically set so that the laid-
out objects are printed on one page.
Manual Settings You can input the length of one page to print on roll paper in numerical characters.
Note

* Available only if rolls are selected in Paper Source.
* You can input between 203.2 and 18000.0(mm) (between 8.00 and 708.66(inch)).

* You can change the numbers by clicking either A button or ¥ button.

Order

Set the object layout order.
The following settings are available for order.

Setting Details
4 Upper Left to Right The objects are laid out from upper left to right.
Upper Left to Bottom The objects are laid out from upper left to bottom.
Upper Right to Left The objects are laid out from upper right to left.
Lower Left to Top The objects are laid out from lower left to top.

Note

* When you have selected Roll Paper Length > Auto Settings and Paper Orientation > Vertical, you can
choose Upper Left to Right or Upper Right to Left.

e When you have selected Roll Paper Length > Auto Settings and Paper Orientation > Horizontal, you can
choose Upper Left to Bottom or Lower Left to Top.

Margins
You can input the paper margins in numerical characters.

Note
* You can input between 0.0 and 50.0(mm) (between 0.00 and 1.97(inch)).

* You can change the numbers by clicking either A button or ¥ button.

'Zoom Dialog Box

This dialog box appears when you select Zoom from the View menu. You can enlarge or reduce the screen display.

264

Scaling

Set the magnification for enlargement or reduction of the screen display.

Zoom Dialog Box iPF815
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Note
* You can input between 25 and 400.

* You can change the numbers by clicking ¥ button.

'Format Dialog Box

This dialog box appears when you select Format from the Object menu after you select an object.

Size Sheet

You can rotate, enlarge, or reduce an object.

Note
e When the objects are not selected, you can not select Format.

Rotate
When you place a checkmark here, you can select Rotate Right or Rotate Left.

Setting Details 265
Rotate Right Rotates the object 90 degrees clockwise.
Rotate Left Rotates the object 90 degrees counterclockwise.

Note
* When several objects are selected, you cannot select Rotate.

iPF815 Format Dialog Box
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Enl./Red.
When you place a checkmark here, you can select Scaling, Fit Paper Size, or Fit Photo Size.
Setting Details
Scaling Allows you to input the value of the enlargement or reduction ratio of an object.
Fit Paper Size Prints by enlarging or reducing each object to match the paper size. If you are using

roll paper, objects are enlarged or reduced so that the width of each object matches
the width of the roll paper.

Fit Photo Size Prints all of the objects at the specified photo size.

Note
* You can input between 25 and 600.

* You can change the numbers by clicking either A button or ¥ button.

Position Sheet

4 You can rotate, enlarge, or reduce an object.
Note
266 * When the objects are not selected, you can not select Format.

Object Position

You can move the object position by changing the values.

Setting Details
Vertical Pos You can input the number of the vertical position in numerical characters.
Horizontal Pos You can input the number of the horizontal position in numerical characters.
Format Dialog Box iPF815
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Setting
Page Pos

Object Size

You can confirm the object size.

Note

Details

You can input the number of the page position in numerical characters.

* When several objects are selected, you cannot display Object Size.

'Laying out a Multiple-File Document on One Page

You can lay out and print a multiple-file document on one page.

1 « From the application software's File menu, select the printer setup menu to open the Print dialog box.

Note
* Normally, select Print from the File menu.

2. Click Properties to open the Properties dialog box.

O Current page

Type page numbers andjor page
ranges separated by commas counting
From the start of the document or the
section, For example, type 1, 3, 5-12
or plsl, pls2, pls3—-p8s3

Printer

Marne: -_.,g Canon iPFxxxx ¥ | I[ Properties ]I
Status: Idie [ Fird Frinter... ]
Type: Canan iPFxxxx

Where: TP seaad 0 2 [ Print ko File
Comment: [ Manual duplex
Page range Copies

[OF:1] Murnber of copiss:

5 e

Print what: |D0cument w | Zoom
Prink: |.ﬁ.|| pages in range v | Pages per sheet: | 1 page b |
Scale to paper size: |N0 Scaling w |
Options... ¢ K | ’ Cancel ]

iPF815
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3. In the Page Setup sheet, select Paper Source.

Note
* Your printer is depicted in the lower-left area of this screen.

4. In the Layout sheet, click on the Page Layout check box and select Free Layout from the list.

268
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Note
* Your printer is depicted in the lower-left area of this screen.

* When you select Free Layout, all other setting items will be disabled.

5. Click the OK button to save the settings.

6. In the Print dialog box, select the pages to print and the number of copies, and click the OK button.

Printer

Mame: -\,fg Canon PPz W | [ Propetties ]
Status:  Ide Fing Printer. ..
Type: Canon iPFx=xx

Where: TP st 2 K 2 ] print ka file
Comment: [ Manual duplex
Page range Copies

[OF:1] Mumber of copies: |1 £

O Current page

Type page numbers andjor page
ranges separated by commas counting
from the start of the document or the
section, For example, type 1, 3, 5-12
or plsl, plsZ, pls3—pEs3

Collate 4

Print whak: |D0cument v| Zoom

Prink: |.C\II pages in range v| Pages per sheek: |1 page V|

Scale to paper size: |N0 Scaling v |

Cancel

Free Layout starts, laying out the document created with application software in the layout area as an object.
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7. Leaving Free Layout running, open other files with the application software and repeat the above steps.

'Laying out a Document Created with Multiple Application Programs on One Page

You can lay out and print a document created with multiple application programs on one page.

1 o From the application software's File menu, select the printer setup menu to open the Print dialog box.

Note

* Normally, select Print from the File menu.

2. Click Properties to open the Properties dialog box.

- | I[ Properties ]I

Printer

Marne: -_.,fg Canon iPFxxxx
Status: Idle
Type: Canan iPFxxxx
Where: TP s st i
Comment:
Page range
@ al

O Current page

Type page numbers andjor page
ranges separated by commas counting
From the start of the document or the
section, For example, type 1, 3, 5-12
or plsl, pls2, pls3—-p8s3

Print what: | Document w |

Prrink: |.ﬁ.|| pages in range - |

Copies

Murnber of copies: |1 £
x

@ .1 e
1

Zoom

Find Printer...

[ Print ko File
[ Marual duplex

Pages per sheet: | 1 page

Scale to paper size: |N0 Scaling

Ik,
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3. In the Page Setup sheet, select Paper Source.

Note
* Your printer is depicted in the lower-left area of this screen.

4. In the Layout sheet, click on the Page Layout check box and select Free Layout from the list.
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Note
* Your printer is depicted in the lower-left area of this screen.

* When you select Free Layout, all other setting items will be disabled.

5. Click the OK button to save the settings.

6. In the Print dialog box, select the pages to print and the number of copies, and click the OK button.

Printer

Mame: -\,fg Canon PPz vl[ Propetties ]

Status: Idle

Find Printer. ..
Type: Canon iPFx=xx

Where: TP a2 6 [ print ko file
Comment: [ Manual duplex
Page range Copies

[OF:1] Mumber of copies: |1 £

O Current page

4 ST —

Type page numbers andjor page
ranges separated by commas counting
from the start of the document or the
section, For example, type 1, 3, 5-12
or plsl, plsZ, pls3—pEs3

Collate

Print whak: |D0cument v| Zoom

Prink: |.C\II pages in range v| Pages per sheek: |1 page V|

Scale to paper size: |N0 Scaling v |

Cancel

Free Layout starts, laying out the document created with application software in the layout area as an object.
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7. Leaving Free Layout running, open other files with other application software and repeat the above steps.

'Selecting an Object

When an object is selected, a select box (blue border) appears around the object.

Note
* To select an object, click that object.

* To select multiple successive objects, click them while holding down the Shift key.
* To select multiple arbitrary objects, click them while holding down the Ctrl key.
* To select all objects, select Select All from the Edit menu.

* When you specify the area with dragging the mouse, the object in the area is selected.
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'Changing the Object Size
You can change the object size by means of mouse operation or by specifying a scaling value.

Note
* The vertical-to-horizontal ratio remains unchanged when the object is enlarged or reduced.
Resizing by means of mouse operation

1 o Select an object.

2. Place the pointer at a corner of the selection box around the object to show the arrow handle, and drag this handle to
change the object size.

Resizing by specifying a scaling value

1 o Select an object.
Click on the Enl./Red. checkbox in the Format Dialog Box and select Scaling.

2. You either enter numbers directly.

Note
* You can input between 25 and 600.

* You can change the numbers by clicking either A button or ¥ button.

3 « Click the OK button.
274

'Moving an Object

You can move the object position.

1 « Select an object.

Changing the Object Size iPF815
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2. Place the pointer inside the selection box of the object to show the crosshair handle, and drag it to move the object.
Alternatively, you can move the Object Position by changing the values in Vertical Pos, Horizontal Pos and Page
Pos in the Format Dialog Box .

'Rotating an Object

You can rotate the object.

1 o Select an object.

2. Select Rotate Left 90 Degrees or Rotate Right 90 Degrees from the toolbar.
Alternatively, you may click on the Rotate check box in the Format Dialog Box then select Rotate Right
or Rotate Left, and click the OK button.
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'Laying out Objects Automatically

Click Auto Arrange Object in the tool bar. This automatically lays out objects. Alternatively, you may select Auto Ar-
range Object from the Object menu.

Note
* The object layout order varies depending on the Order setting in the Page Options Dialog Box
dialog box.

'Aligning Objects
You can align objects systematically.

1 o Select multiple objects.

2. Click the align button from the toolbar.
Alternatively, you may select the align menu from the Object menu.

Align Top
Lays out the objects, justifying them to the top.
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Center Vertically

Lays out the objects, justifying them to the vertical center.

Align Bottom 4
Lays out the objects, justifying them to the bottom.
Align Left
Lays out the objects, justifying them to the left.
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Center Horizontally

Lays out the objects, justifying them to the horizontal center.

4 Align Right
Lays out the objects, justifying them to the right.

'Changing the Object Overlapping Order

You can change the object overlapping order.

1 « Select an object.

278 2. Select the Overlapping Order menu from the Object menu.

Note
* The order of overlapping affects the order of objects automatically laid out.

* You can also select by clicking the right button of the mouse on an object.

Changing the Object Overlapping Order iPF815
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Bring to Front

Moves the object to the frontmost position.

Send to Back 4
Moves the object to the backmost position.

Bring Forward

Moves the object one position to the front.
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Send Backward

Moves the object one position to the back.

4
'Pasting a Copied or Cut Object

1 o Click Copy or Cut from the toolbar.
Alternatively, you may select Copy or Cut from the Edit menu.

2. Click Paste from the toolbar.
Alternatively, you may select Paste from the Edit menu.

Note
* The copied or cut object is laid out at the end of the page.
* You can also select by clicking the right button of the mouse on an object.

* In order to paste an object on any position that you like, you can paste the object with Pointed Paste by
clicking the right button of the mouse on any position that you want.
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'Folded Duplex Window

This window is displayed if you select Folded Duplex from the Edit menu after selecting an object. Using the Folded Du-
plex function allows you to print with fold lines added.
The Folded Duplex window consists of the menu and tool bars, layout area and status bar.

Note
* The toolbar and status bar can be toggled between hidden and displayed from the View menu.

Menu Bar
This allows you to select menus required for operations.
| File Edit Options Wiew Help |
Tool Bar 281

This allows you to select tool buttons required for major operations.

Bl -& I
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Layout Area

This allows you to check the arrangement and orientation of objects.

Status Bar

This shows the paper source, roll paper width, and output size.

IFL-::II Paper \Width:17-in. Roll (431, Smm) Cutput Size: 17.00inch x 44, 26inch I

'Finished Size Settings Dialog Box

This dialog box is displayed when you select Finished Size Settings from the Edit menu. This allows you to configure
finished size settings.

282

Finished Size

Selects the method for setting the finished size.

Finished Size Settings Dialog Box iPF815
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The following settings are available for the finished size.

Setting Details

Fit Roll Paper Width Prints by automatically enlarging or reducing the entire document so that the width
of the document matches the roll paper width.

Specify Folded Size Prints by automatically enlarging or reducing the entire document to match the size
of the paper. Select the actual size of the paper you want to print on in Fit Paper
Size.

Rotate Page 90 degrees (Con- Prints by rotating pages by 90 degrees. Pages are automatically rotated if they will

serve Paper) fit within the roll paper width when rotated, and are not rotated if they will not fit

within the roll paper width.

'Binding Settings Dialog Box

This is displayed when you select Binding Settings from the Edit menu. This allows you to configure the binding edge

settings.
Binding Settings _ 4
Binding E dge () Battom O Top
Binding 0.000 2 | inch(0.00-1.97)

[ Priet Fold Lines
Fald Line Calar ] v
Fold Line Type — G id Line v

[] Only Print Center and Edges

I (1]8 ] l Cancel ] l Defaults

Binding Edge

Configures the binding edge when folding paper.
The following settings are available for the binding edge.

Setting Details
Bottom Prints by placing the binding margin (gutter) at the bottom of the document.
Top Prints by placing the binding margin (gutter) at the top of the document.

283
Binding
Configures the binding margin (gutter).
Prints by creating a binding margin (gutter) of the specified size. Enter the margin size as a number.

Note
* The values that can be entered are 0 to 50 (mm).

iPF815 Binding Settings Dialog Box
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Print Fold Lines
Configures the color and type of fold lines.

Note
* To not print fold lines, clear the Print Fold Lines checkbox.

Fold Line Color

You can select the fold lines.

Fold Line Type

You can select the fold lines.
The following settings are available for the fold line type.

Setting Details

Solid Line You can print the solid line as the frame style.
4 Dotted Line You can print the dotted line as the frame style.
Dashed Line You can print the dashed line as the frame style.

Only Print Center and Edges
To print fold lines at the center and both edges, select the Only Print Center and Edges checkbox.

'Prints using Folded Duplex

Allows you to produce duplex printing by combining two pages and folding them.

1 « Select two objects from the layout area of Free Layout.

2. Select Folded Duplex from the Edit menu of Free Layout.
Open the Folded Duplex window and arrange the selected objects in the layout area.

3 « Open the Finished Size Settings dialog box from the Edit menu.

4. Select Fit Roll Paper Width or Specify Folded Size in Finished Size.

Note
* Rotate Page 90 degrees (Conserve Paper) is also available when Specify Folded Size is selected.

284
Click OK to save the settings.

6. Open the Binding Settings dialog box from the Edit menu.
7. Select Bottom or Top in Binding Edge.

Specify the Binding width in Binding.

Prints using Folded Duplex iPF815
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9. Configure the Fold Line Color and Fold Line Type from Print Fold Lines.

Note
* When the Only Print Center and Edges checkbox is selected, fold lines are only printed at the three
locations of the center and both edges.

1 0. Click OK to save the settings.

1 1 « Confirm the print setting and begin printing.
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Color imageRUNNER Enlargement Copy
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'The Features of Color imageRUNNER Enlargement Copy

The main features of Color imageRUNNER Enlargement Copy are as follows.
¢ Allows the document scanned with the Color imageRUNNER to be automatically enlarged and printed.

* You can perform basic printer settings such as printer selection, media type and output profile selection, and matching
methods, in addition to borderless printing and enlargement/reduction process without growing through the printer
driver.

Note

» The media type, image size, detailed media settings, and the printer settings can cause the actual print output
to differ from the Color imageRUNNER Enlargement Copy settings.

'Operating Environment

You can use the Color imageRUNNER Enlargement Copy in the following environments.
* Compatible Operating System
Windows 2000, Windows XP, Windows Server 2003, Windows Vista, Windows Server 2008, Windows 7

¢ Software that requires installation
imagePROGRAF Printer Driver

Note
¢ This function is not available on 64-bit version of Windows.

286 'Starting Color imageRUNNER Enlargement Copy

Follow the procedure below to start the Color imageRUNNER Enlargement Copy.

To start by selecting Printers and Faxes from the start button

1 o Open the folder of the OS you are using for configuring printers.
For example, on Windows XP click the start button on the desktop, and then select Printers and Faxes.

The Features of Color imageRUNNER Enlargement Copy iPF815
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2. Right-click the Printers icon and select Printing Preferences to open the Printing Preferences dialog box.
In the Utility sheet, click the Color imageRUNNER Enlargement Copy button.

3 o The Color imageRUNNER Enlargement Copy dialog box displays.

= Color imageRUNNER Enlargement Copy

Hat Folder:

Mame Shared Mame  Printer Name Status Details Add...

[ Add to Startup folder
[ 5ave Printed Data

About ] [ Operation Guide ] [ Help ] [ Cloze

Note

e If you click on the Add to Startup folder check box in the Color imageRUNNER Enlargement Copy
dialog box, the icon of Color imageRUNNER Enlargement Copy utility will appear on the task bar when
starting Windows thereafter.
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To start by selecting Color imageRUNNER Enlargement Copy from the start button

1 o From the Windows start button, select Color imageRUNNER Enlargement Copy.

fi imagePROGRAF Printer Driver Extra Kit Pk E Color imageRIUNMER: Enlargement Copy

réj Readme_English. txk
"Q“.' Uninstaller { imagePROGRAF Printer Driver Extra Kit )

2. The Color imageRUNNER Enlargement Copy dialog box displays.

= Color imageRUNNER Enlargement Copy:

Hot Folder:

MName Shared Mame  Printer Mame Statug D etails Add...

[ Add to Startup folder
[ 5ave Printed Data

About ] [ Operation Guide ] [ Help ] [ Cloze

'Color imageRUNNER Enlargement Copy Dialog Box

The explanation below is on the Color imageRUNNER Enlargement Copy dialog box.

% Color imageRUNMER Enlargement Copy

Hot Faolder:

Mame Shared Mame | Printer Name Status Details Add...

B9 |CC Matching... ICC Matchin.. Canon iPFusxs active

[ Add ta Startup folder
[ 5ave Printed D ata

288

[ About ] [ Operation Guide ] [ Help ] [ Cloze

Note

* For the step to open the Color imageRUNNER Enlargement Copy dialog box, see "Starting Color image-
RUNNER Enlargement Copy."

Hot Folder
The hot folder list appears.

Color imageRUNNER Enlargement Copy Dialog Box iPF815
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Add Button
Click the button to open the Easy Setup Wizard dialog box so that you can add a hot folder.

Edit Button

From the Hot Folder list, select a hot folder and click the button to open the Add/Edit Hot Folder dialog box that allows
you to edit the hot folder.

Delete Button
From the Hot Folder list, select a hot folder and click the button to delete the hot folder.

Start Button

Clicking the button changes the status of the selected inactive Hot Folder to active.

Stop Button
Clicking the button changes the status of the selected active Hot Folder to inactive.

Add to Startup folder

Register the application in the Windows startup menu.

Save Printed Data

Automatically saves printed data.

About Button

Click the button to display the name and the version number of the utility.

Operation Guide Button
Click the button to display the Color imageRUNNER Enlargement Copy Setup Manual.

'Hot Folder

Hot folder refers to a folder used for Color imageRUNNER Enlargement Copy.

* When transferred to the PC's hot folder, the document data scanned with the Color imageRUNNER is printed in en-
larged size from the printer according to the print conditions set in the hot folder. 289

* You can create a new hot folder, edit or delete an existing one, and set print conditions at will.

Note
* You can create up to 20 hot folders.

iPF815 Hot Folder
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'Creating a New Hot Folder

1 « Open the Color imageRUNNER Enlargement Copy dialog box, and then click the Add button.

& Color imageRUNNER Enlargement Copy

Hot Folder:
Mame Shared Mame  Printer Name Statug Details Add...
Edi...
Delete
Start Stop
[ &sdd to Startup folder
[ 5ave Printed Data
4 About ] [ Operation Guide ] [ Help ] [ Cloze

Note

* For the step to open the Color imageRUNNER Enlargement Copy dialog box, see "Starting Color
imageRUNNER Enlargement Copy."

2. The Easy Setup Wizard dialog box displays.
Click the Next button.

290
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3 o Select the type of printer to use.
Click the Next button.

4. Select the media type to print.

Note
« If the Borderless Printing checkbox is checked, only media types that can be used for borderless
printing are displayed in the list.

Click the Next button.

291
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5. Select roll paper or cut sheet to print. Also, select the media size to print.
Click the Next button.

6. Select the color matching method.
Click the Next button.

292

7. To receive a document scanned with the Color imageRUNNER, you need to share a folder. Enter the folder shared
name in Shared Name.
Click the Next button.

Note
¢ This shared name is used as the name of the hot folder.

* You cannot use the Back button, after clicking the Next button here.

Creating a New Hot Folder iPF815
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8. Click Finish button to close the Easy Setup Wizard dialog box.
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The hot folder you have created appears in the Hot Folder list in the Color imageRUNNER Enlargement Copy

dialog box.
= Color imageRUNNER Enlargement Copy.
Hat Folder:
Marne Shared Mame | Printer Name Status Detailz

EJIEC Matching... ICC Matchin.. Canon PR active
[ Add to Startup folder

[ 5ave Printed Data

About ] [ Operation Guide ] [ Help ] [ Cloze

'Specifying an Existing Shared Folder as a Hot Folder

1 o Share the folder you want to specify as a hot folder.

2. Open the Color imageRUNNER Enlargement Copy dialog box, and then click the Add button.

& Color imageRUNNER Enlargement Copy

Hot Folder:
Mame Shared Mame  Printer Name Statug Details Add...
Edi...
Delete
Start Stop
[ Add to Startup folder
[ 5ave Printed Data
About ] [ Operation Guide ] [ Help ] [ Cloze

Note

imageRUNNER Enlargement Copy."

* For the step to open the Color imageRUNNER Enlargement Copy dialog box, see "Starting Color

iPF815
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3 o The Easy Setup Wizard dialog box displays.
Click the Manual Settings button.

4. The Add/Edit Hot Folder dialog box displays.
Enter the hot folder name in Name.
Click the Browse botton, with selecting Specify a folder, to set the existing shared folder.

Add/Edit Hot Folder E3
Mame: |II2I2 M atching_MIR1[Perceptual) |
Prirter
Printer Mame | Canon iPFeusws v | l Froperties ]

Hat folder management

() Specify a shared name | |

() Specily a folder | |

] Apply Sharpriess

E
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0k Cancel ] [ Defaults l [ Help ]
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5. The location of the folders will appear.
Select the folder to specify a hot folder, and click the OK button.

6. As necessary, set the print conditions in the hot folder. (See "Setting the Print Parameters.")
Click the OK button to close the Add/Edit Hot Folder dialog box.

Add/Edit Hot Folder

Mame:

Frirter

Frinter Hame

[ of]

() Specity a shared name |

X

| ICC Matching MIR1[Perceptual]

| Cahon IPFxxes

V|[ Properties ]

Huot folder management

(&) Specify a folder |E:\F‘rogram Filez\HotFalder

[ ] &pply Sharpress

Browse...

ak ] [ Cancel ] [ Defaults ] l Help

]
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The hot folder you have created appears in the Hot Folder list in the Color imageRUNNER Enlargement Copy
dialog box.

'Setting the Print Parameters

The printer driver opens when you click the Properties button in the Add/Edit Hot Folder dialog box. The printer driver is
used to configure basic settings to match the type of media loaded in the printer.

Add/Edit Hot Folder X]
Mame: ||CE b atching_MIR1 [Ferceptual) |
Printer
Printer Mame | Canon iPF ~ | | Fropeties |

Hot folder management

) Specify a shared name | |

(%) Specify a folder |E:'\F'rngram FilegHotFolder |

Browse. .

[ &pply Sharpress

E

297

[ 0k ] [ Cancel ] [ D efaultz ] [ Help ]

Refer to Printer Driver @&2¥1iF) for details on the printer driver.

Note

* The only three sheets displayed are the Main sheet, the Page Setup sheet, and the Layout sheet. Some of the
printer driver settings may be disabled.

iPF815 Setting the Print Parameters
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Apply Sharpness

Place a checkmark here to set the sharpness.

Drag the slider bar to the left or right to adjust. You can also adjust by directly entering a number in the numeric input field.
Note
* You can input between 0 and 500.
* You can change the numbers by clicking either A button or ¥ button.

* You cannot be applied to PDF files.

'Printing Enlargements of Scanned Originals from a Color imageRUNNER

Scanned originals from a Color imageRUNNER can be enlarged and printed automatically.

Originals you create by scanning with a Color imageRUNNER are transferred to a "hot folder" and printed automatically
after enlargement according to printing conditions you specify for that folder.

This processing sequence is called the Color imageRUNNER Enlargement Copy function.

To use Color imageRUNNER Enlargement Copy, first complete these settings in the following order.

1. Register a hot folder on your computer.
Register a hot folder on your computer for storing scanned originals from the Color imageRUNNER and complete the
settings for enlargement copy.

2. Complete the scanning settings on the Color imageRUNNER.
Configure the Color imageRUNNER to send scanned originals to the hot folder.

After these settings are complete, you can print enlarged copies of scanned originals from the Color imageRUNNER.

Registering a hot folder on your computer

Folders used for Color imageRUNNER Enlargement Copy (iR enlargement copy) are called hot folders. Register a hot
folder on your computer for storing scanned originals from the Color imageRUNNER. You can specify printing conditions
(such as the image quality and paper size), based on which originals transferred to the hot folder will be printed. Follow
these steps to register and modify hot folders.

1. Display the printer driver dialog box. (See "Accessing the Printer Driver Dialog Box from the Operating System

Menu .") EFIE
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2. Click the Utility tab to display the Utility sheet.

3 o Click Color imageRUNNER Enlargement Copy to start the Color imageRUNNER Enlargement Copy utility.

4. Use the Color imageRUNNER Enlargement Copy utility to register or modify hot folders.
For instructions on registering and modifying hot folders, refer to the help file for the Color imageRUNNER En-
largement Copy utility.

Completing the scanning settings on the Color imageRUNNER.

Configure the Color imageRUNNER to send scanned originals to the hot folder. It is easy to send scanned originals to the
hot folder if you assign the scanning settings and destination to a Favorites button on the Color imageRUNNER.

For instructions on assigning scanning settings and destinations to a Faverites button, refer to the setting manual, displayed
by clicking Color imageRUNNER Enlargement Copy Setup Manual button of Color imageRUNNER Enlargement Copy
utility, or refer to the Color imageRUNNER manual.

Scanning the original and print an enlargement

Follow the steps below to scan an original on the Color imageRUNNER for enlarged printing on the printer. For detailed
instructions, refer to the Color imageRUNNER manual.

1 o Load the original on the platen glass or document feeder of the Color imageRUNNER. 299
2. Press Send to display the screen for transmission.

3 « Press Favorites, and then press the Favorites button assigned to the hot folder.

iPF815 Printing Enlargements of Scanned Originals from a Color imageRUNNER
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4. Press Start on the control panel. If you scan originals on the platen glass, after scanning all originals, press Done on
the touch-panel display.

Scanned originals are sent to the hot folder and automatically enlarged and printed following the conditions you
specified for the folder.
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Print Plug-In for Office

Print Plug-In for OffiCe fEATUMNES ......eoii i e e e e e s e e e e s estaa e e e e s annneeeas 301
Operating ENVIFONMENT ... ..ottt e e e e e e s st e e e e e e s sbe e e e e e e eanstaeeaeeeaansaeeeeeeennnreneas 302
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'Print Plug-In for Office features

Print Plug-In for Office is a Plug-In that enables easy printing from Microsoft Office.

* It is displayed on the toolbar/ribbon, so it is easily accessible.
* It can be set by just selecting from the Wizard.

* Large-Format Printing custom media size can also be set in the Wizard from Microsoft Word or Microsoft Power-
Point.

¢ Custom media size can be set automatically from Microsoft Excel.

* The layout can be checked before printing by starting the preview screen.

Important
@ * The Print Plug-In for Office toolbar/ribbon might not be displayed in Microsoft Office after installing im-
agePROGRAF Print Plug-In for Office. 301
Refer to the following topic for details on how to display the imagePROGRAF Print Plug-In for Office
toolbar/ribbon.

» When Print Plug-In for Office is not displayed
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'0perating Environment

Print Plug-In for Office 's operating environment is as below.

* Compatible Operating System
Windows XP, Windows Server 2003, Windows Vista, Windows Server 2008, Windows 7

¢ Software that requires installation
Microsoft Office XP/2003/2007/2010
imagePROGRAF Printer Driver Ver. 3.95 or later

e Hardware
CPU 2.0 GHz Pentium 4 or better
RAM 512 MB or more

Important
@ * If you opened the Office document from Internet Explorer, the software will not run correctly.
* If you are editing an embedded object or link object, the software will not run correctly.

¢ If you added the imagePROGRAF Print Plug-In ribbon to the Microsoft Office 2007/2010 Quick Access
4 toolbar, the software will not run correctly.

'Steps to install

Below are the steps to install Print Plug-In for Office.

Note
* You must log into Windows as an Administrator before the installation.

1 « Insert "User Software CD-ROM" into the CD-ROM drive and start the installer.

Note
* If the installer screen does not display, open the CD-ROM icon from My Computer, click setup.exe,
and open the icon.
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2. Click the Install Individual Software button.

3 « Click Install in imagePROGRAF Print Plug-In for Office.

Installation List
Installs the following software. Click Install

Disolav the Readme file :

imagePROGRAF Printer Driver instalk T
imagsPROGRAF Status Monftor o tnsta | MB
Media Configuration Toal Install l
46MB
Digital Photo Fromt-Access Install I
35ME
imagePROGRAF HDI Driver &j
49MB
imagePROGRAF Print Plugn for Office Install l MB
ICC Prafiles Install I
14ME
imagePROGRAF Device Setup Liility &j MB

Point the software names with the mouse, and then displays the software instruction here

Back I Exit I
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4. Click the Next button.

5. Read the License Agr

eement, and click the Yes button.

2 imagePROGRAF Print Plug-In for Office Setup Wizard

Licensze Agreement ¥ty
Fleaze read the following licenze agreement completely and carefully. ’

Click Yes to agree to the license agreement.

CANON SOFTWARE LICENSE AGREEMENT "~
IMPORTANT-READ THIS AGREEMEMT BEFORE INSTALLING THE SOFTwWARE!

This legal document is a license agreement between you and Canaon Inc. ["'Canon'’] governing
your use of the software and the online or electic manual [collectively, the "SOFTWARE"). BY
IMSTALLIMG THE SOFTWARE, vOU ARE DEEMED TO HAWE AGREED TO BE BOUMD BY
THE TERMS OF THIS AGREEMENT. IF¥OU DO NOT AGREE TO THE TERMS OF THIS
AGREEMEMNT, PROMPTLY CLOSE THIS INSTALLATION PROGRA&M AND DO MOT INSTALL
THE SOFTWARE.

In consideration of the right to uze the SOFTWARE ., vou agree to abide by the terms and
conditions of this Agreement,

1. GRAMT OF LICEMSE AMD RESTRICTIOMS: You may use ["uze" shall mean starning, loading,

Do vou agree to the tems in license agreement?

Yes Mo

Steps to install
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6. Click the Start button.

7. Click the Yes button.

8. Click the Exit button.

305

The installation for Print Plug-In for Office is complete.
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Important
@ e When you install this software, the virtual printer Canon imagePROGRAF PrintPlugIn may be installed. If
you want to use this software, do not uninstall the virtual printer Canon imagePROGRAF PrintPlugIn.
* The Print Plug-In for Office toolbar/ribbon might not be displayed in Microsoft Office after installing im-

agePROGRAF Print Plug-In for Office.
Refer to the following topic for details on how to display the imagePROGRAF Print Plug-In for Office

toolbar/ribbon.
* When Print Plug-In for Office is not displayed

'Steps to uninstall

Below are the steps to uninstall Print Plug-In for Office.

1 « If Microsoft Office is open, close it.
4 2. Select Control Panel from the start menu.
3. Open Add or Remove Programs.

4. Select imagePROGRAF Print Plug-In, and click the Remove button.

Note
306 * You cannot uninstall Print Plug-In for Office if an Office application is running. When a message appears,
select Cancel and close all Office applications that are running.

'When Print Plug-In for Office is not displayed

Buttons such as Start imagePROGRAF Print Plug-In sometimes do not appear in the Word, PowerPoint and Excel
Office applications, and the Print Plug-In for Office functions are not available.
In this event, re-install Print Plug-In for Office.

Steps to uninstall iPF815
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If you are using Microsoft Office 2003 or later, you can also enable add-ins to display Print Plug-In for Office.
See below for the procedure for re-installing the plug-in or enabling add-ins.
Re-installing Print Plug-In for Office

* If a problem occurs, such as the system or an application terminating abnormally, the Microsoft Office application
disables add-ins as a safety precaution.

In this event, you will need to re-install Print Plug-In for Office to display the imagePROGRAF Print Plug-In toolbar/
ribbon.

Note
* You cannot re-install Print Plug-In for Office once an Office application is running. When the message ap-
pears, select Cancel and close the active Office application.

Re-install Print Plug-In for Office as follows:

1 o Close Microsoft Office if it is open.

2. Install Print Plug-In for Office. 4
For information about instsalling, see "Steps to install."

Enabling Print Plug-In for Office for items disabled in Office applications

 If a problem occurs, such as the system or an application terminating abnormally, the Microsoft Office application
disables add-ins as a safety precaution.

In this event, you will need to restore the disabled add-ins in order to display the imagePROGRAF Print Plug-In toolbar/
ribbon.
Use the procedure below to restore the add-ins disabled by Microsoft Office.

For Microsoft Office 2010

1 o Select Options from the File menu.
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2. From the list on the left side of the <application name> options dialog box, select Add-ins.
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3 « Select Disabled Items in the Manage combo box and click the Go button.

4. If Addin imageprograf print plug-in (ipfaddinif.dll) is displayed in the Disabled Items dialog box, select it and
click the Enable button.

5. Close all the dialog boxes and restart the Office application.
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For Microsoft Office 2007

1 o Click the Office button and then click the <application name> options button.

2. From the list on the left side of the <application name> options dialog box, select Add-ins.

3 o Select Disabled Items in the Manage combo box and click the Go button.
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4. If Addin imageprograf print plug-in (ipfaddinif.dll) is displayed in the Disabled Items dialog box, select it and
click the Enable button.

5. Close all the dialog boxes and restart the Office application.
For Microsoft Office 2003

1 o Click About <application name> in the Help menu of application.

Help Type a queskion For help
@ Microsoft Office PowerPoink Help F1

Shiow the Office Assiskant

Microsoft Cffice Gnline

Conkack s

Check For Updates
Deteck and Repair. ..
Ackivate Product. .,

Zuskomer Feedback Options, ..

I ahaout Micrasoft Office PowerPaink I
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2. Click the Disabled Items button in the About <application name> dialog box.

About Microsoft Office PowerPoint ['5__<

Micrasoft® Office PowerPoint® 2003 (11.5529.5606)
Part of Microsoft Office Professional Edition 2003
Copyright © 1987-2003 Microsoft Corporation, All rights reserved,

Partions of Intemational CorectSpell™ zpelling comrection systern € 1993 by Lemout & Hauspie Spaech
Products M., All ights reserved, French spelling checker and dictionaties & 1994-2000 SYMAPSE
Développenent, Toulouse (France], All rights reserwed, Franch thesaurus and application @& 1994-2000
SYMAPZE Déweloppement, Toulouse (France), All Hghts reserved, Spanish Spelling Engine & 1993-2002
by SIGMUM Cia, Ltda, Quita, Ecuador, All rights reserved. Spanish Thesaurus Engine @ 1993-2002 by
SIGMNUM Cia, Leda, Quite, Ecuador, All Fights reserved.,

L This product is licensed to:

Wiew the End-User License Agreement

“Warning; This computer program is protected by copyright law and international
treaties, Unauthorized reproduction or diskribution of this program, or any parkion of

it, may result in severe civil and criminal penalties, and will be prosecuted to the ;

maximum extent possible under the law, Jystem Info...
Tech Suppott...
Disabled Items. ..

3. If Addin imageprograf print plug-in (ipfaddinif.dll) is displayed in the Disabled Items dialog box, select it and
click the Enable button.

Disabled ltems El

The items listed below were disabled because they prevented
PowerPaoint From Functioning carrectly,

Please noke that wou may hawe to restart PowerPoink for these
changes to take place.
Select the ones you wish ko re-enable.

imagepragraf prink in {ipfaddinitdIl

l Enable |

4. Close all the dialog boxes and restart the Office application.

'To start from Microsoft Word 311

Below are the steps to start Print Plug-In for Office from Microsoft Word.

1 o Start Microsoft Word.
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2. If Start imagePROGRAF Print Plug-In is displayed on the toolbar/ribbon, click it.

Important
@ e If the imagePROGRAF Print Plug-In toolbar/ribbon is not displayed, refer to the following.
* When Print Plug-In for Office is not displayed

3 o Check that the imagePROGRAF Print Plug-In toolbar/ribbon is displayed.

imagePROGRAF ~ | Canon iPPooox - ﬁ

Print Paper Settings

imagePROGRAF Print Plug-In

4. Click the buttons on the toolbar/ribbon according to the items you want to set.

Icon Contents
imagePROGRAF ~ Displays the About, He!p, and.Special Sett'ings difllog bpxes.
You can change the settings using the Special Settings dialog box.
Menu Refer to Configuring Special Settings for details.

. Select Printer.
—Em e If you select Show All Printers, the imagePROGRAF printers will be displayed

Printer list again. Select this when you want to display all printer drivers or update the display.

The print Wizard is displayed.
@ The settings Print Matching Roll Width, Borderless Printing, Multi-Page

Printing, and Print Using Registered Settings can be set.

Print
Print Button
Large-Format Wizard is displayed.
ﬂ Settings for Portrait or Landscape Orientation can be set.

Paper Settings
Paper Settings Button
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Printing Wizard dialog box

Important
@ ¢ If you want to change the display to another file or application while the Printing Wizard is open, close the
Printing Wizard dialog box. Otherwise, you may not be able to change displays or operate the toolbar.

Large-Format Printing Wizard dialog box

Large-Format Printing Wizard

Large-Format Printing Menu

Create a page size to suit your printing application.
Click the desired large-farmat printing menu.

| 1 Large-Format Printing hMenu 2 Create Fage Size

E=co)

Landscape Orientation

Portrait Orientation

FPointthe menus with the mouse, and then displays the software instruction 313
hera.
Cancel
iPF815 To start from Microsoft Word
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Important
@ * If you want to change the display to another file or application while the Large-Format Printing Wizard is
open, close the Large-Format Printing Wizard dialog box. Otherwise, you may not be able to change dis-
plays or operate the toolbar/ribbon.

* The layout may collapse if you create a form using existing data. If that is the case, modify the data again.

'Print Matching Roll Width (Word)

Prints to the edge of the roll width. You can print large exhibits and posters, and also print Portrait and Landscape orienta-
tions made in Large-Format Printing Wizard.

1 o Start Microsoft Word.

2. If Start imagePROGRAF Print Plug-In is displayed, click it.

3 « Click Print from the imagePROGRAF Print Plug-In toolbar/ribbon.
The Printing Wizard dialog box is displayed.

314

Important
@ * If you want to change the display to another file or application while the Printing Wizard is open,
close the Printing Wizard dialog box. Otherwise, you may not be able to change displays or operate
the toolbar/ribbon.

Print Matching Roll Width (Word) iPF815
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4. Click Print Matching Roll Width.

Printing Wizard

Print Matching Roll Width
Complete the settings so that the original fits the roll width.
Select the roll width and image layout and click MNext.

[2 Layout 3 Prirt

Roll PaperWidth

17.0010nch

Image Size 100 =1 % (47 -100)

@ J (-Bl

[22.10 inch R

Layout Selection :

= Back et = Cancel

5. Select Roll Paper Width that is set in the printer.
6. Select image size.
7. Select layout.

« Select Next.

Printing Wizard

Print

Complete these settings to print from the source application.
Specify the media type and the range of pages to print, and then click Print.

[3 Print

Printer :
Canon iPFw@ex

17.00inch

Media Type

[22.10 inch R

Print Range :
i« Al Pages
" Current Page 315
© Pages Fist: [ =] o-2000

Last: |1 =] ¢1-2000
Copies: [17 =] -9

I Printin Draft mode

Print Preview |

One-Touch Registration...

= Back | Print | Cancel |

iPF815
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9. Select Media Type.

1 0. Select Print Range from All Pages, Current Page, and Pages.
If Pages is selected, enter the number of pages.

1 1 o Enter Copies.
Note
* When Print in Draft mode is selected, printing is fast but the print quality is poor.

* The settings are registered when the One-Touch Registration is pressed. This is convenient if you to
need print multiple times using the same setting.

* Press the Print Preview button to display the preview screen. You can check and make changes to
the layout in the preview screen.

* When you print to the edge of the roll width, the maximum length will be the lesser of 5.587 times the
roll paper width, or 18.0m.

4 1 2. Press Print to start printing.

'Borderless Printing (Word)

Prints up to the border of the media. Photos and posters can be printed without worrying about margins.

1 « Start Microsoft Word.

2. If Start imagePROGRAF Print Plug-In is displayed, click it.
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3 o Click Print from the imagePROGRAF Print Plug-In toolbar/ribbon.
The Printing Wizard dialog box is displayed.

Important
@ * If you want to change the display to another file or application while the Printing Wizard is open,
close the Printing Wizard dialog box. Otherwise, you may not be able to change displays or operate
the toolbar/ribbon.

4. Click Borderless Printing.
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5. A confirmation dialog box is displayed. If the data fills up the page, confirm that Continue using the plug-in is
selected in Choose how to proceed and press OK.

Note

* To adjust the data, select Return to application and press OK. Exit Print Plug-In for Office and
return to the application.

Printing Wizard

Borderless Printing
Complete the settings for borderless printing.
Select the roll width and image layout and click Mext.

[2 Layout 3 Print

Roll PaperWidth

22,08 inch R Layout Selection :
A L

—
= Back | Mewt = | Cancel
6. Select Roll Paper Width that is set in the printer.
7. Select Layout.
318
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8. Select Next.

Printing Wizard
Print

Complete these settings to print from the source application.
Specify the media type and the range of pages to print, and then click Print.

[3 Frint

Printer :

17.000nch Canan iPFias

hedia Type :

Frint Range :

09 inch R + All Pages

" Current Page

" Pages First: [ = o-z00m
Last: [ = o-z00m

______________________ @ Copies: 1 = -99

-

]

Print Preview

One-Touch Registration... = Back | Print | Cancel |

9. Select Media Type.

1 0. Select Print Range from All Pages, Current Page, and Pages.
For Pages, insert the page number.

1 1 o Enter Copies.
Note
* When Print in Draft mode is selected, printing is fast but the print quality is poor.

* Press the One-Touch Registration button to register the settings. This is useful for multiple printing
using the same settings.

* Press the Print Preview button to display the preview screen. You can confirm and make changes to
the layout in the preview screen.

* The maximum length for Borderless Printing is the lesser of 5.587 times the roll paper width, or
18.0m.

1 2. Press Print to start printing.
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'Multi-Page Printing (Word)

Prints multiple pages as one page. You can print handouts into a single page, or print matter with many pages.

1 « Start Microsoft Word.

iPF815 Multi-Page Printing (Word)
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2. If Start imagePROGRAF Print Plug-In is displayed, click it.

3 o Click Print from the imagePROGRAF Print Plug-In toolbar/ribbon.
The Printing Wizard dialog box is displayed.

Important
@ * If you want to change the display to another file or application while the Printing Wizard is open,
close the Printing Wizard dialog box. Otherwise, you may not be able to change displays or operate
the toolbar/ribbon.
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4. Click Multi-Page Printing.

Printing Wizard

Multi-Page Printing
Complete the settings for printing multiple pages per sheet.
Select the roll width and image layout and click MNext.

[2 Layout 3 Prirt

Roll PaperWidth

17.00inch
—

[22.10 inch

Layout Selection :

M Fammn

= Back et = Cancel

5. Select the Roll Paper Width that is set in the printer.
6. Select layout from Layout Selection.

7. Select Next.

Printing Wizard

Print
Complete these settings to print from the source application.
Specify the media type and the range of pages to print, and then click Print.
[3 Print

Printer :

17.000nch Canon iPFmoes

hedia Type :

—

Print Range :
@« Al Pages
" Current Page

 Pages First: [ = a-2000
Last: [i = o-z000
______________________ ' Copies: [17 =] - o0 321

I Printin Draft mode

[22.10 inch

Print Preview |

One-Touch Registration... = Back | Frint | Cancel |

8. Select Media Type.

iPF815 Multi-Page Printing (Word)
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9. Select Print Range from All Pages, Current Page, and Pages.
If Pages is selected, enter the number of pages.

1 0. Enter Copies.
Note
e When Print in Draft mode is selected, printing is fast but the print quality is poor.

* The settings are registered when the One-Touch Registration is pressed. This is convenient if you to
need print multiple times using the same setting.

* Press the Print Preview button to display the preview screen. You can check and make changes to
the layout in the preview screen.

* The maximum length for Multi-Page Printing is the lesser of 5.587 times the roll paper width, or
18.0m.

1 1 « Press Print to start printing.

4

'Register the settings(Word)

If you are going to print multiple times using the same setting, you can select One-Touch Registration. Registered settings
can be recalled from Print Using Registered Settings.

1. Set up to the Print screen from Print Matching Roll Width, Borderless Printing or Multi-Page Printing of
Printing Menu.

Note

* Up to 20 items can be registered.

* The available settings are as follows.
* Print Matching Roll Width (Word)
* Borderless Printing (Word)
 Multi-Page Printing (Word)

2. Click the One-Touch Registration button.

One-Touch Registration

Registered Settings
Mame File Name Date |
SAMPLE sample.doc WNOC000 00N
Mameg :
SAMPLE
322 nd
Delete
Ok | Cancel |
Register the settings(Word) iPF815

Downloaded from ManualsPrinter.com Manuals



http://www.manualsprinter.com

Windows Software > Print Plug-In for Office >

3 « Enter name in Name.
Up to 31 characters can be entered.

4. Click nd . The name you entered is displayed in Registered Settings.
5. Click OK, and return to the Print screen.

6. Click Print to print, and click Cancel to cancel the print.

Note
* Clicking Cancel in the Print screen will not delete the registered settings.

'Print Using Registered Settings (Word)

Prints using the registered settings. 4

1 o Start Microsoft Word.

2. If Start imagePROGRAF Print Plug-In is displayed, click it.

3 o Click Print from the imagePROGRAF Print Plug-In toolbar/ribbon.
The Printing Wizard dialog box is displayed.
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Important
@ * If you want to change the display to another file or application while the Printing Wizard is open,

close the Printing Wizard dialog box. Otherwise, you may not be able to change displays or operate
the toolbar/ribbon.

4. Click Print Using Registered Settings.

Printing Wizard

Print Using Registered Settings
Your document will be printed using registered settings.
Select the settings to use and click Next.

[2 Layout 3 Print

Registered Settings :

17.0010nch

Settings Details :

[22.10 inch R

Farameter | Settings
Printer Driver Canon iPFxyxy

File Mame sample.doc

Date KRS K KX KKK =

Finished Size 17.000inchx 2210 inch

Roll Paper YWidth 17-in. Roll {431.8mm} ]

Image Size 100%

Layout Selection Taop v

|£| — ST | i_
= Back Mext = | Cancel |

5. Click the Next button.
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6. Select Media Type.

Print

Complete these settings to print from the source application.
Specify the media type and the range of pages to print, and then click Print.

[3 Print

Printer :
Canon iPFmoes

17.000nch

Print Range :

@« Al Pages

" Current Page

" Pages First:

' copies

I Printin Draft mode

[ = o-z200m
Last: [ = o-200m
[1— =] o-aa

Print Preview |

One-Tauch Registration... = Back | Frint | Cancel |

Print Using Registered Settings (Word)
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7. Select Print Range from All Pages, Current Page, or Pages.
If Pages is selected, enter the number of pages.

8. Enter Copies.
Note
e When Print in Draft mode is selected, printing is fast but the print quality is poor.

* Press the Print Preview button to display the preview screen. You can check and make changes to
the layout in the preview screen.

* The maximum print length when printing with the registered settings is the lesser of 5.587 times the
roll paper width, or 18.0m.

9. Press Print to start printing.

'Portrait Orientation / Landscape Orientation (Word)

Print to the edge of the roll width. You can print large exhibits and posters, or print the Landscape or Portrait Orientation
Page Sizes made in the Large-Format Printing Wizard.

Create Page Size in Portrait or Landscape Orientation.
Use the Large-Format Printing Wizard to create portrait page sizes for Potrait Orientation, and landscape page sizes for

Landscape Orientation.

1 o Start Microsoft Word.

2. If Start imagePROGRAF Print Plug-In is displayed, click it.

3 o Click Paper Settings from the imagePROGRAF Print Plug-In toolbar/ribbon.
The Large-Format Printing Wizard dialog box is displayed.

Note

* If you want to change the display to another file or application while the Large-Format Printing
Wizard is open, close the Large-Format Printing Wizard dialog box. Otherwise, you may not be
able to change displays or operate the toolbar/ribbon.

325
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Large-Format Printing Wizard

Large-Format Printing Menu
Create a page size to suit your printing application.
Click the desired large-format printing menu.

[1  Large-Format Printing Menu 2 Create Page Size

| ABCD)|
Landscape Qrientation
C
[2)

Portrait Orientation

Faoint the menus with the mouse, and then displays the software instruction
here.

Cancel

4. Click Portrait Orientation or Landscape Orientation.

Note
* The steps taken to create a Portrait Page Size will be used as an example to explain the procedure.

Large-Format Printing Wizard

Portrait Orientation
Create a page size in portrait orientation.
Enter the roll width and length and click Create Page.
2 Create Page Size
= Roll Paper Width :
17.00 inch -
Length
[ 9498 inch (17.00-94.95)
S | ®
= Back Create Page Cancel
5. Adjust Length from the list-box or slide-bar.
6. Click the Create Page button.
Portrait Orientation / Landscape Orientation (Word) iPF815
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7. Click OK if the message is displayed.

8. Edit and create the document.
Note 4

* Printing is done in Print Matching Roll Width of the Printing Wizard. For details on Print Match-
ing Roll Width, refer to see "Print Matching Roll Width (Word)." .

Important
@ * The layout may collapse if you create a form using existing data. If that is the case, modify the data again.

'To start from Microsoft PowerPoint

Below are the steps to start Print Plug-In for Office from Microsoft PowerPoint.

1 o Start Microsoft PowerPoint.

2. If Start imagePROGRAF Print Plug-In is displayed on the toolbar/ribbon, click it.

Important
@ e If the imagePROGRAF Print Plug-In toolbar/ribbon is not displayed, refer to the following.
» When Print Plug-In for Office is not displayed 327

3. Check that the imagePROGRAF Print Plug-In toolbar/ribbon is displayed.

imagePROGRAF ~ | Canon iPPooox - j

Print Paper Settings

imagePROGRAF Print Plug-In

iPF815 To start from Microsoft PowerPoint
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4. Click the buttons on the toolbar/ribbon according to the items you want to set.

Icon Contents
: Displays the About, Help, and Special Settings dialog boxes. (See "Configuring
imagePROGRAF ~ pay inis SRl g &
: Special Settings.")
Menu
. Select Printer.
Canon iPFooo w7

If you select Show All Printers, the imagePROGRAF printers will be displayed

Printer list again. Select this when you want to display all printer drivers or update the display.

The print Wizard is displayed.
@ The settings Print Matching Roll Width, Borderless Printing, Multi-Page

Printing, and Print Using Registered Settings can be set.

Print
Print Button
Large-Format Wizard is displayed.
E Settings for Portrait or Landscape Orientation can be set.

Paper 5ettings
Paper Settings Button

Printing Wizard dialog box

328

Important
@ * If you want to change the display to another file or application while the Printing Wizard is open, close the
Printing Wizard dialog box. Otherwise, you may not be able to change displays or operate the toolbar/rib-
bon.

Note
* If you open a password protected document as read-only, the Printing Wizard cannot be run.

To start from Microsoft PowerPoint iPF815
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Large-Format Printing Wizard dialog box

Large-Format Printing Wizard

Large-Format Printing Menu

Create a page size to suit your printing application.
Click the desired large-format printing menu.

| 1 Large-Format Printing kMenu 2 Create Page Size

Landscape Orientation

Portrait Orientation

Fointthe menus with the mouse, and then displays the software instruction
hera.

Cancel

Important
@ * If you want to change the display to another file or application while the Large-Format Printing Wizard is
open, close the Large-Format Printing Wizard dialog box. Otherwise, you may not be able to change dis-
plays or operate the toolbar/ribbon.

* The layout may collapse if you create a form using existing data. If that is the case, modify the data again.

Note
¢ If you open a password protected document as read-only, the Large-Format Printing Wizard cannot be
run. Remove the password protection.

'Print Matching Roll Width (PowerPoint)

Prints to the edge of the roll width. You can print large exhibits and posters, and also print Portrait and Landscape orienta-
tions made in Large-Format Printing Wizard.

1 « Start Microsoft PowerPoint.

2. If Start imagePROGRAF Print Plug-In is displayed, click it.

329
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3 o Click Print from the imagePROGRAF Print Plug-In toolbar/ribbon.
The Printing Wizard dialog box is displayed.

Important
@ * If you want to change the display to another file or application while the Printing Wizard is open,
close the Printing Wizard dialog box. Otherwise, you may not be able to change displays or operate
the toolbar/ribbon.

4. Click Print Matching Roll Width.

Print Matching Roll Width

Complete the settings so that the original fits the roll width.
Select the roll width and image layout and click Mext.

[2 Layout 3 Prirt

Roll Paper Width :
17-in. Roll §; il

17.0010nch

Image Size 100 =1 % (47 -100)

@ J (-Bl

E1 0inch R Layout Selection :

330

= Back | Mext = | Cancel

5. Select Roll Paper Width that is set in the printer.

Print Matching Roll Width (PowerPoint) iPF815
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6. Select image size.
7. Select layout.

8. Select Next.

Printing Wizard
Print

Complete these settings to print from the source application.
Specify the media type and the range of pages to print, and then click Print.

3 Print
Printer :
,m‘ Canon iPFe
hedia Type
Plain Paper
E@I R Print Range :
+ Al Slides
______________________ " Current Slide 4
€ Slides First: [ Ha-n
Last: l—:| (1 -1y
@ Copies : [1 = -9

[ Printin Draft mode

Print Preview

One-Touch Registration... = Back | Frint | Cancel |

9. Select Media Type.

1 0. Select Print Range from All Slides, Current Slide, and Slides.
If Slides is selected, enter the slide number.

1 1 o Enter Copies.
Note
* When Print in Draft mode is selected, printing is fast but the print quality is poor.

* The settings are registered when the One-Touch Registration is pressed. This is convenient if you to
need print multiple times using the same setting.

* Press the Print Preview button to display the preview screen. You can check and make changes to
the layout in the preview screen.

* When you print to the edge of the roll width, the maximum length will be the lesser of 14.22 times the
roll paper width, or 18.0m. 331

1 2. Press Print to start printing.

iPF815 Print Matching Roll Width (PowerPoint)
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'Borderless Printing (PowerPoint)

Prints up to the border of the media. Photos and posters can be printed without worrying about margins.

1 « Start Microsoft PowerPoint.

2. If Start imagePROGRAF Print Plug-In is displayed, click it.

3 o Click Print from the imagePROGRAF Print Plug-In toolbar/ribbon.
The Printing Wizard dialog box is displayed.

Important
@ * If you want to change the display to another file or application while the Printing Wizard is open,
close the Printing Wizard dialog box. Otherwise, you may not be able to change displays or operate
the toolbar/ribbon.

332
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4. Click Borderless Printing.

5. A confirmation dialog box is displayed. If the data fills up the page, confirm that Continue using the plug-in is

selected in Choose how to proceed and press OK.

Note

e To adjust the data, select Return to application and press OK. Exit Print Plug-In for Office and

return to the application.

Printing Wizard

Borderless Printing
Complete the settings for borderless printing.
Select the roll width and image layout and click MNext.

[2 Layout

Print

Roll PaperWidth

Layout Selection :

o] R

= Back

et = | Cancel

6. Select Roll Paper Width that is set in the printer.

7. Select Layout.

iPF815
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8. Select Next.

Printing Wizard
Print

Complete these settings to print from the source application.
Specify the media type and the range of pages to print, and then click Print.

3 Print
Printer :
17.00inch Canan iPFias
Media Type
ht Coated Paper
E@I Iz Print Range :
{+ All Slides

" Current Slide

" Elides First: = -0

Last: l—Zl {1-13
@ Copies: 1 =] (1-899
4 r
Print Preview
One-Touch Registration... = Back | Print | Cancel |

9. Select Media Type.

1 0. Select Print Range from All Slides, Current Slide, and Slides.
If Slides is selected, enter the slide number.

1 1 o Enter Copies.
Note
* When Print in Draft mode is selected, printing is fast but the print quality is poor.

* Press the One-Touch Registration button to register the settings. This is useful for multiple printing
using the same settings.

* Press the Print Preview button to display the preview screen. You can confirm and make changes to
the layout in the preview screen.

* The maximum length for Borderless Printing is the lesser of 14.22 times the roll paper width, or
18.0m.

1 2. Press Print to start printing.

334

'Multi-Page Printing (PowerPoint)

Prints multiple pages as one page. You can print handouts into a single page, or print matter with many pages.

1 « Start Microsoft PowerPoint.

Multi-Page Printing (PowerPoint) iPF815
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2. If Start imagePROGRAF Print Plug-In is displayed, click it.

3 o Click Print from the imagePROGRAF Print Plug-In toolbar/ribbon.
The Printing Wizard dialog box is displayed.

Important
@ * If you want to change the display to another file or application while the Printing Wizard is open,
close the Printing Wizard dialog box. Otherwise, you may not be able to change displays or operate
the toolbar/ribbon.

335
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4. Click Multi-Page Printing.

Printing Wizard

Multi-Page Printing
Complete the settings for printing multiple pages per sheet.
Select the roll width and image layout and click MNext.

[2 Layout 3 Prirt

Roll PaperWidth

17.00inch
—

[22.10 inch

Layout Selection :

M Fammn

= Back et = Cancel

5. Select the Roll Paper Width that is set in the printer.

6. Select layout from Layout Selection.

7. Select Next.

336

Printing Wizard

Print
Complete these settings to print from the source application.
Specify the media type and the range of pages to print, and then click Print.
[3 Print

Printer :

17.000nch Canon iPFmoes

hedia Type :

Print Range :
@ Al Slides
 Current Slide

 Slides First: |1 = u-n
Legits |1 3: -1
______________________ ' Copies : m (1-93%

I Printin Draft mode

[22.55 inch

Print Preview |

One-Touch Registration... = Back | Frint | Cancel |

8. Select Media Type.

Multi-Page Printing (PowerPoint)
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9. Select Print Range from All Slides, Current Slide, and Slides.
If Slides is sclected, enter the slide number.

1 0. Enter Copies.
Note
e When Print in Draft mode is selected, printing is fast but the print quality is poor.

* The settings are registered when the One-Touch Registration is pressed. This is convenient if you to
need print multiple times using the same setting.

* Press the Print Preview button to display the preview screen. You can check and make changes to
the layout in the preview screen.

* The maximum length for Multi-Page Printing is the lesser of 14.22 times the roll paper width, or
18.0m.

1 1 « Press Print to start printing.

'Register the settings(PowerPoint)

If you are going to print multiple times using the same setting, you can select One-Touch Registration. Registered settings
can be recalled from Print Using Registered Settings.

1. Set up to the Print screen from Print Matching Roll Width, Borderless Printing or Multi-Page Printing of
Printing Menu.

Note

* Up to 20 items can be registered.

* The available settings are as follows.
* Print Matching Roll Width (PowerPoint)
* Borderless Printing (PowerPoint)
« Multi-Page Printing (PowerPoint)

2. Click the One-Touch Registration button.

One-Touch Registration

Registered Settings
Mame File Name Date |
SAMPLE sample.doc WNOC000 00N
Mameg :
SAMPLE L3 337
Deleta
Ok | Cancel |
iPF815 Register the settings(PowerPoint)
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3 « Enter name in Name.
Up to 31 characters can be entered.

4. Click nd . The name you entered is displayed in Registered Settings.

5. Click OK, and return to the Print screen.

6. Click Print to print, and click Cancel to cancel the print.

Note
* Clicking Cancel in the Print screen will not delete the registered settings.

'Print Using Registered Settings (PowerPoint)

4 Prints using the registered settings.

1 « Start Microsoft PowerPoint.

2. If Start imagePROGRAF Print Plug-In is displayed, click it.

3 o Click Print from the imagePROGRAF Print Plug-In toolbar/ribbon.
The Printing Wizard dialog box is displayed.

338
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Important
@ * If you want to change the display to another file or application while the Printing Wizard is open,

close the Printing Wizard dialog box. Otherwise, you may not be able to change displays or operate
the toolbar/ribbon.

4. Click Print Using Registered Settings.

Printing Wizard

Print Using Registered Settings
Your document will be printed using registered settings.
Select the settings to use and click Next.

[2 Layout 3 Print

Registered Settings :

17.0010nch

E1 0 inch Settings Details :
Farameter | Settings

|
N

Printer Driver Canon iPFxyxy

File Mame sample.doc

Date KRS K KX KKK =

Finished Size 17.000inchx 2210 inch

Roll Paper YWidth 17-in. Roll {431.8mm} ]

Image Size 100%

Layout Selection Taop v

|£| — ST | i_
= Back Mext = | Cancel |

5. Click the Next button.

Printing Wizard
Print

Complete these settings to print from the source application.
Specify the media type and the range of pages to print, and then click Print.

[3 Print

Printer :

17.000nch Canon iPFmoes

Print Range :
@ Al Slides
 Current Slide

 Slides First: |1 = -1
Last: |1 3: (=13 339
' Copies : |1 =] ¢ -999

I Printin Draft mode

Print Preview |

One-Tauch Registration... = Back | Frint | Cancel |

6. Select Media Type.

iPF815 Print Using Registered Settings (PowerPoint)
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7. Select Print Range from All Slides, Current Slide, and Slides.
If Slides is sclected, enter the slide number.

8. Enter Copies.
Note
e When Print in Draft mode is selected, printing is fast but the print quality is poor.

* Press the Print Preview button to display the preview screen. You can check and make changes to
the layout in the preview screen.

* The maximum print length when printing with the registered settings is the lesser of 14.22 times the
roll paper width, or 18.0m.

9. Press Print to start printing.

'Portrait Orientation / Landscape Orientation (PowerPoint)

Print to the edge of the roll width. You can print large exhibits and posters, or print the Landscape or Portrait Orientation
Page Sizes made in the Large-Format Printing Wizard.

Create Page Size in Portrait or Landscape Orientation.

Use the Large-Format Printing Wizard to create portrait page sizes for Potrait Orientation, and landscape page sizes for
Landscape Orientation.

1 « Start Microsoft PowerPoint.

2. If Start imagePROGRAF Print Plug-In is displayed, click it.

340
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3 « Click Paper Settings from the imagePROGRAF Print Plug-In toolbar/ribbon.
The Large-Format Printing Wizard dialog box is displayed.

Large-Format Printing Wizard

Large-Format Printing Menu

Create a page size to suit your printing application.
Click the desired large-farmat printing menu.

[1  Large-Format Printing Menu i Create Page Size

Landscape Orientation
D)
Portrait Orientation

Faoint the menus with the mouse, and then displays the software instruction 4
here.

Cancel

Important
@ * If you want to change the display to another file or application while the Large-Format Printing
Wizard is open, close the Large-Format Printing Wizard dialog box. Otherwise, you may not be
able to change displays or operate the toolbar/ribbon.

4. Click Portrait Orientation or Landscape Orientation.

Note
* The steps taken to create a Portrait Page Size will be used as an example to explain the procedure.

341
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Large-Format Printing Wizard

Portrait Orientation
Create a page size in portrait orientation.
Ernter the roll width and length and click Create Page.
2 Create Page Size
= Roll Paper Width :
17.00 inch
17-in. Ro Tl
Length :
94.9833 inch (17.00-94.98)
© | ®
= Back Create Fage Cancel

5. Adjust Length from the list-box or slide-bar.
6. Click the Create Page button.

7. Click OK if the message is displayed.

342 8. Edit and create the document.

Important
@ * The layout may collapse if you create a form using existing data. If that is the case, modify the data
again.

Note
* Printing is done in Print Matching Roll Width of the Printing Wizard. For details on Print Match-
ing Roll Width, refer to see "Print Matching Roll Width (PowerPoint)." .

Portrait Orientation / Landscape Orientation (PowerPoint) iPF815
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'To start from Microsoft Excel

Below are the steps to start Print Plug-In for Office from Microsoft Excel.

1 « Start Microsoft Excel.

2. If Start imagePROGRAF Print Plug-In is displayed on the toolbar/ribbon, click it.

Important
@ o If the imagePROGRAF Print Plug-In toolbar/ribbon is not displayed, refer to the following.
» When Print Plug-In for Office is not displayed

3 o Check that the imagePROGRAF Print Plug-In toolbar/ribbon is displayed. 4

4. Click the buttons on the toolbar/ribbon according to the items you want to set.

Icon Contents

imagePROGRAF - Displays the About, Help, and Special Settings dialog boxes. (See "Configuring

Special Settings.")
Menu

. Select Printer.
Canan iPhooo If you select Show All Printers, the imagePROGRAF printers will be displayed

Printer list again. Select this when you want to display all printer drivers or update the display.

The print Wizard is displayed.
@ The settings Print Entire Sheet and Print Selected Area can be set.
Print
Print Button
343
iPF815 To start from Microsoft Excel
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Printing Wizard dialog box

Important
@ * If you want to change the display to another file or application while the Printing Wizard is open, close the
Printing Wizard dialog box. Otherwise, you may not be able to change displays or operate the toolbar/rib-
bon.

* The Printing Wizard will not start if you click the Print button on the toolbar/ribbon while editing a cell.

* When more than one worksheet is selected, the Printing Wizard cannot be run. Select only one worksheet
and click Print again.

* When an object is selected, the Printing Wizard is not started if you click the Print button on the toolbar/
ribbon.

* If the paper size in Excel is blank, the Printing Wizard cannot be run. From the File menu in Excel, select
Page Setup and check Paper size.

Note
¢ If you click the Print button with a graph selected, a message dialog box will appear asking if you want to
continue printing. If you click Neo, you will return to the application.

e If you click the Print button with a page break set, a message dialog box will appear asking if you want to
continue printing. If you click No, you will return to the application. If you do not use the set page break,
check the page break preview and change the setting.

e If you click the Print button with a page range set, a message dialog box will appear asking if you want to
continue printing. If you click No, you will return to the application. If you do not use the set page range,
check the page break preview and change the setting.

e If you click the Print button with a worksheet or cell protected, a message dialog box will appear asking if
you want to continue printing. If you click No, you will return to the application. If you want to change the
setting, remove the protection from the worksheet or cell.

To start from Microsoft Excel iPF815
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'Print Entire Sheet (Excel)

For resizing the entire sheet to fit the roll width. Choose this option to enlarge the currently displayed sheet before printing.

1 « Start Microsoft Excel.

2. If Start imagePROGRAF Print Plug-In is displayed, click it.

3 o Click Print from the imagePROGRAF Print Plug-In toolbar/ribbon.

Important
* When more than one worksheet is selected, the Printing Wizard cannot be run. Select only one
worksheet and click Print again. 4

If a print area is set, a confirmation message dialog box will appear.
To print the entire sheet, cancel the setting of the print area.

The Printing Wizard dialog box is displayed.

345
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4. Click Print Entire Sheet.
A message will appear informing you that analysis is in progress.

Printing Wizard

Printing Menu
Choose the optimal method of printing for wour application.
Click the desired printing menu to continue.

[ Printing Menu 2 Layout 3 Print

Analyzing data. Please wait.

Cancel |

The Layout menu will appear automatically.

Print Entire Sheet

Complete the settings so that the original fits the roll width.
Select the roll width and image layout and click MNext.

[2 Layout 3 Prirt

Roll PaperWidth

17.0010nch

[17.87 inch R

Image Size 100 =1 % (47 -100)
© ) ®

Layout Selection :

Binding Settings... |

346 = Back | Mewt = | Cancel |
Note
* If data analysis requires time, a message dialog will appear. If you select No, you will return to the
application.
5. Select Roll Paper Width that is set in the printer.
Print Entire Sheet (Excel) iPF815
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6. Select image size.
7. Select layout.

8. To configure Binding, click the Binding Settings button.
Refer to Configuring Binding (Excel) for details on the procedure for configuring Binding.

9. Select Next.

Print

Complete these settings to print from the source application.
Specify the media type and the range of pages to print, and then click Print.

3 Print

Printer :

17.0010nch Canon iPFees

hedia Type :

Plain er

Copies : 1 3: (1-59949)
a7 inch R ™ Mo Spaces at Top or Bottom (Conserve Paper)

[ Printin Draft mode

H

Print Preview

= Back Print Cancel

1 0. Select Media Type.

1 1 o Enter Copies.
Note
* When Print in Draft mode is selected, printing is fast but the print quality is poor.

e Press the Print Preview button to display the preview screen. You can check and make changes to
the layout in the preview screen.

* When you print to the edge of the roll width, the maximum print length is 18.0m.

12. If the upper and lower margins are too wide, check No Spaces at Top or Bottom (Conserve Paper).
The upper and lower margins can be checked in Print Preview.

347
13 « Press Print to start printing.

@ Important
* If divided into plural pages, try reducing the data size or the range you select.

e You cannot run Print or Print Preview if you select it for a worksheet with no data displayed.

iPF815 Print Entire Sheet (Excel)
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'Print Selected Area (Excel)

For resizing the selected range of cells to fit the roll width. Choose this option to enlarge a particular part of the sheet before
printing.

1 » Start Microsoft Excel.

2. If Start imagePROGRAF Print Plug-In is displayed, click it.

3 o Click Print from the imagePROGRAF Print Plug-In toolbar/ribbon.

Important
* When more than one worksheet is selected, the Printing Wizard cannot be run. Select only one
4 worksheet and click Print again.

If a print area is set, a confirmation message dialog box will appear.
To print the selected area, cancel the setting of the print area.

The Printing Wizard dialog box is displayed.

348
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4. Click Print Selected Area.
@ Important
* If only one cell is selected, Print Selected Area cannot be selected.

A message will appear informing you that analysis is in progress.

Printing Wizard

Printing Menu
Choose the optimal method of printing for wour application.
Click the desired printing menu to continue.

[ Printing Menu 2 Layout 3 Print

Analyzing data. Flease wait.

[

The Layout menu will appear automatically.

Printing Wizard

Print Selected Area
Complete the settings so that the original fits the roll width.
Select the roll width and image layout and click Mext.

2 Layout 3 Print

Roll PaperWidth

17-in.

Image Size : 100 = % (49 - 100)

B

@I W © J ®

Layout Selection :

@ - 349

— B
Binding Settings...
= Back | IHext = | Cancel |

Important
@ * If the range selected in Excel 2007/2010 is too large, it will not be possible to analyze the data. Select
a smaller range and then run the analysis.

iPF815 Print Selected Area (Excel)
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Note
e If data analysis requires time, a message dialog will appear. If you select No, you will return to the
application.

« Select Roll Paper Width that is set in the printer.
« Select image size.
o Select layout.

« To configure Binding, click the Binding Settings button.
Refer to Configuring Binding (Excel) for details on the procedure for configuring Binding.

9 « Select Next.

Printing Wizard

4 Print
Complete these settings to print from the source application.
Specify the media type and the range of pages to print, and then click Print.

[3 Print

Printer :

17.000nch Canon iPFees

hedia Type :

Copies 1 E|: (1-9949)
IEST inch R [ Mo Spaces at Top or Bottom (Conserve Faper)

I Printin Draft mode

Print Preview

= Back Print Cancel
10. scicct Media Type.
1 1 o Enter Copies.
Note
350 * When Print in Draft mode is selected, printing is fast but the print quality is poor.

* Press the Print Preview button to display the preview screen. You can check and make changes to
the layout in the preview screen.

e When you print to the edge of the roll width, the maximum print length is 18.0m.

1 2. If the upper and lower margins are too wide, check No Spaces at Top or Bottom (Conserve Paper).
The upper and lower margins can be checked in Print Preview.

Print Selected Area (Excel) iPF815
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13 « Press Print to start printing.

@ Important
* If divided into plural pages, try reducing the data size or the range you select.

* You cannot run Print or Print Preview if you select it for a worksheet with no data displayed.

'Configuring Binding (Excel)
You can configure Binding margins for binding printouts.

1 « Configure the settings up to Layout Selection in the Layout screen in Print Entire Sheet or Print Selected Area.
Refer to Print Entire Sheet (Excel) and Print Selected Area (Excel) for the configuration
methods.

2. Click the Binding Settings button.

@ Important 4
* You cannot click the Binding Settings button in the following situations.

* When the Image Size is set to 100%
* When a graph is selected
* When page breaks have been set

* When a sheet or cell is protected

Open the Binding Settings dialog box.

Binding Settings E|
v Binding
Birditg Edge ‘ Long Edge (Lef) ﬂ
Binding Margin |Standald [Approw. 0.4 in) j
ak Cancel |

3 « If the Binding checkbox is not checked, select it to turn binding on.

4. Select Binding Edge.

351
5. Select Binding Margin.

iPF815 Configuring Binding (Excel)
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6. Click the OK button.
Return to the Layout screen.

Printing Wizard

Print Selected Area
Complete the settings so that the original fits the roll width.
Select the roll width and image layout and click MNext.

[2 Layout 3 Prirt

Roll PaperWidth
17-in. Roll

17.0010nch

Image Size : 100 E|i % (49 - 100)

@I W © J ®

Layout Selection :

B

______________________ R
|
) 3
4 —"
Binding Settings...
= Back | et = | Cancel |

Check that the Binding settings are applied in the preview screen.

7. Configure the settings in the Printing Wizard dialog box.

'Configuring Special Settings
You can configure Special Settings from the imagePROGRAF Print Plug-In toolbar.

1 o Click imagePROGRAF in the toolbar, and select Special Settings.

X

Special Seitings

¥ Show progress indicator during plug-in startup

W Center sheets and print areas
[ Ensure image guality when creating page sizes

[ Correctthe print area when analyzing

Gl | Cancel

352
2. Turn the checkbox for the item you want to change on or off.
Item Details
Show progress indicator during plug-in When this setting is off, hides the progress indicator that appears while
startup the plug-in is starting up.
Center sheets and print areas When this setting is off, printing is performed without changing the

position. When this setting is on, printing is performed with the top,
bottom, left, and right margins layed out equally. When this setting is
off, printing is performed without changing the position.

Configuring Special Settings iPF815
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Iltem

Center sheets and print areas

Ensure image quality when creating page
sizes

Correct the print area when analyzing

Details

This function is only valid in Microsoft Excel.

When this setting is on, documents are created at the maximum size.
This reduces the enlargement ratio during actual printing, which mini-
mizes degradation of the quality of photos, etc.

This function is only valid in [ Microsoft PowerPoint.

For data that cannot be processed with usual data analysis, the print
area is corrected and then the data is processed. When data analysis
fails, you may be able to print by turning on this checkbox.

This function is only valid in Microsoft Excel.

3. Click OK to close the Special Settings dialog box.

iPF815
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HDI Driver
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'The Features of HDI Driver

The main features of HDI Driver are as follows.

* A special HDI (Heidi Device Interface) compatible printer driver for the Autodesk, Inc. software applications for Auto-
CAD and AutoCAD LT architecture (hereafter referred to together as "AutoCAD").

* You can set up the print job with the most appropriate settings for the media and print clear, sharp printouts of plans
and diagrams created with AutoCAD.

'Operating Environment

The HDI driver operating environment is as follows.

* Compatible Operating System
Windows XP, Windows Vista, Windows 7

e Compatible AutoCAD Version
AutoCAD 2005, AutoCAD LT2005, AutoCAD 2006, AutoCAD LT2006,
AutoCAD 2007, AutoCAD LT2007, DWG TrueView 2007, AutoCAD 2008, AutoCAD LT2008, DWG TrueView
2008,
AutoCAD 2009, AutoCAD LT2009, DWG TrueView 2009, AutoCAD 2010, AutoCAD LT2010, DWG TrueView
2010,
AutoCAD 2011, AutoCAD LT2011, DWG TrueView 2011,
AutoCAD 2008(x64), DWG TrueView 2008(x64), AutoCAD 2009(x64), AutoCAD LT2009(x64), DWG TrueView
2009(x64),
AutoCAD 2010(x64), AutoCAD LT2010(x64), DWG TrueView 2010(x64)
AutoCAD 2011(x64), AutoCAD LT2011(x64), DWG TrueView 2011(x64)

Note
* The supported OS version differs for each version of AutoCAD. Check with Autodesk for details.

The Features of HDI Driver iPF815
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'Installation Procedure

There are two ways to install the HDI driver.

* Installing with the Canon Installer
* Installing with the Add-A-Plotter Wizard

'Installing with the Canon Installer

The Canon installer opens and displays as soon as you start the User Software CD-ROM provided with the printer. Follow
the procedure below to perform the installation from this screen.

1 « Mount the User Software CD-ROM in the CD-ROM drive and start the Canon installer.

Note
* If the Canon installer screen does not appear, double-click the CD-ROM icon from the My Comput-
er to open the installer screen.

2. Select Install Individual Software in the Canon installer Setup Menu.

355
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The Installation List appears. Click the Install button of the imagePROGRAF HDI Driver.

The driver setup screen appears. Click the Next button.

356
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3. After you have read the Licensing Agreement, select I accept the terms of the license agreement and click the
Next button.

HDI Driver - InstallShield Wizard

Licensze Agreement
CAMOM SOFTWARE LICEMSE AGREEMENT ~

[MPORTANT-READ THIS AGREEMEMNT BEFORE IMSTALLING THE SOFTWARE!

Thiz legal document iz a icenze agreement between you and Canon Inc, ['Canan™)
governing your uge of the software and the online or electic manual [collectively, the
"SOFTWARE"). BY INSTALLING THE SOFTWARE, vOU ARE DEEMED T0O HAWE
AGREED TO BE BOUMD BY THE TERMS OF THIS AGREEMENT. IF 0L DO HOT
AGREE TO THE TERMS OF THIS AGREEMEMNT, PROMPTLY CLOSE THIS
IMSTALLATION PROGRAM AMD DO MOT IMSTALL THE SOFTWARE.

In conzideration of the right to use the SOFTWARE, pou agree to abide by the terms and
conditions of this Agreement. Z

(3} | accept the terms of the license agreement

()| do not aceept the terms of the license agreement

[ < Back ” Mext » I[ Cancel ]

4. Confirm that the installed AutoCAD is compatible with your computer environment. Click the OK button.

Note
* Confirm that the installed AutoCAD is compatible with your computer environment.

5. The Ready to Install the Program screen opens. Click the Install button.

357
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6. The HDI driver files are copied to the Drv folder where the AutoCAD program files are stored.
Click the Finish button. This completes the setup of the HDI driver.

7. After AutoCAD starts, select Plotter Manager from the File menu.
The Plotters window opens. Click the Add-A-Plotter Wizard icon.

358
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8. The Add Plotter - Introduction Page screen opens. Check the displayed screen and then click the Nextbutton.

Add Plotter - Introduction Page E'

This wizard provides you with the ability ko configure either an existing Windows
zystem plotter, or a new non-Windows system plotter. The configuration information
will be zaved in a PC3 file. The PC3 file will be added as a plotter icon that can be
zelected from the Autodesk Plotter Manager.

‘f'ou can choose to impart configuration information from a PCP or PC2 file, then add
that infarmation to the new plotter configuration file you are creating.

< Back Hewt > l[ Cancel

Note 4

* To open the Add-A-Plotter Wizard you can also click Start > Control Panel > Autodesk Plotter
Manager > and then double-click the Plotter Wizard icon in the Plotters window.

9. Add Plotter - Begin screen opens. Select My Computer then click the Next button.

Plotter - Begin r?|

eEecgin p To configure a new platter, select one of the: following:
Platter Model [ © My Compuier
o All zettings will be configured by an Autodesk Heidi plotter
Impart Pop or Pc2 n-l driver, and managed by thiz computer.
Ports 3
Platter Mame r (O Metwork, Plotter Server
Firizh .

() Systern Printer

< Back ” Hest > l[ Cancel
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1 0. The Add Plotter - Plotter Model screen opens.

Make sure that Canon Inc. is selected in the list of Manufacturers, and for the Models select the name of the print-
er that you want to install then click the Next button.

Add Plotter - Plotter Model X
Begin Select your plotter manufacturer and model. IF your plotter isn't listed, consult wour
" platter documentation for a compatible plotter.
p=Flotter Model Optionally, if you have an installation digk containing an HOI driver. choose Have
Disk._.t’-\ Erowsze for HIF File dia_log box iz digplayed for you to locate and install the
Import Pop or Po2 HIF file attached to the HDI driver.
Ports
F'.Ioltter =t Manufacturers Models
Firish
Adobe
AutaCAD DXB File
Autodesk ePlat [D0wF)
Autodesk ePlat [PDF) =
CalCom
| PP P P b ( | Z

e — —
Thiz model is supported by Raster Driver - by Canon Inc.

4 [ < Back “ Mewt l[ Catcel ]

1 1 o The Add Plotter - Import Pcp or Pc2 screen opens. Click the Next button.

Begin Toimpart plotter specific information from a previously saved
PCP or PCZ file, choose Import File. Paper size, plot
optimization level, network, share names, and port names can
be imported into the new PC3 file.

Platter Model

pelmport Pop or Pe2

Plotter Mame
Firigh

MOTE: Use the Add Plot Style Table wizard to import pen
azzignment information. Uze the Import PCP/PCZ Settings
wizard to import PCP or PC2 page setup informatian,

< Back ” Mest > l[ Cancel

Note

* If you want the installer to read plotter information from previously stored PCP or PC2 files, click the
Import File button.
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1 2. The Add Plotter - Ports screen opens.

Make sure that Plot to a port is selected, select the port that you want to use for the plotter, then click the Next
button.

Add Plotter - Ports

X

Begin b () Platto g pot () Plot to File () AutoSpoal
= The following iz a list of all ports available for the curently
configured device. All documents will be plotted ta the port
Plotter kodel 6" pou select,
Impart Pep or P2 Q-l Part D escription Frinter
wForts 1] LFT1 Local Paort
Platter M ame UWJ‘ LFT2 Local Paort
Firish 3 LFT3 Local Paort

Canon iP) ; Metwork Port

[ LConfigure Port ... ] [ Wwihat iz AutoSpool...

[[] Shiaww all system parts and disable [0 part validation

[ < Back “ Mewt l[ Catcel 4

Note

* In the Add Plotter - Ports screen, it is recommended to select Network Port. If you select Local
Port, the AutoCAD warning message may appear when printing.

13 « The Add Plotter - Plotter Name screen opens. Click the Next button.

Plotter. - Plotter Name E|

Beqin The model name vou selected is the default plotter
configuration name. You can accept the default name. or
enter a new name ko identify the new PC3 file you have
created. The name pou apply will be dizplayed in the Page
Plotter tMadel Setup and Plot dialog boxes.
Import Pop or Pe2
Parts Platter Mamne:
wFlotter Hame A
Firizh
Mote: If you enter a name that is exactly the same as a System
Printer's name, pou will not see the Spstem Printer listed in the
AutoCAD 2007 Plat or Page Setup dialog boxes.
< Back ” Hest > l [ Cancel
Note 1
* You can change the Plotter Name setting here, but you will normally leave it as it is and go to Step 36
14.

iPF815 Installing with the Canon Installer
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1 4. The Add Plotter - Finish screen opens. Click the Finish button.
This completes the installation of the HDI driver.

Add Plotter - Finish X
Begin The plotter iIPFxsxx haz been installed with itz default
b configuration settings. To modify the default sethings, choose
; Edit Platter Configuration,
Plotter Model 5"
Import Pop or Po2 Qll
Ports 1]
Plotter Mame wn Edit Plotter Configuration ...
wFinizh : :

Optionally, ta perform a plot calibration test on the newly
configured plotter, and verify that your drawing measurements
plot accurately, chooze Calibrate Platter.

LCalibrate Plotter ...

[ < Back “ Finizh l[ Cancel ]

15. Clicking the Finish button closes the Installation List and Setup Menu and ejects the User Software CD-ROM
from the CD-ROM drive.

'Installing with the Add-A-Plotter Wizard
Follow the procedure below to use the Add-A-Plotter Wizard to install the HDI driver without the Canon installer.

1 o After AutoCAD starts, select Plotter Manager from the File menu.
The Plotters window opens. Click the Add-A-Plotter Wizard icon.

362
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2. The Add Plotter - Introduction Page screen opens. Check the displayed screen and then click the Next button.

Add Plotter - Introduction Page E'

This wizard provides you with the ability ko configure either an existing Windows
zystem plotter, or a new non-Windows system plotter. The configuration information
will be zaved in a PC3 file. The PC3 file will be added as a plotter icon that can be
zelected from the Autodesk Plotter Manager.

‘f'ou can choose to impart configuration information from a PCP or PC2 file, then add
that infarmation to the new plotter configuration file you are creating.

< Back Hewt > l[ Cancel

Note

* To open the Add-A-Plotter Wizard you can also click Start > Control Panel > Autodesk Plotter
Manager > and then click the Add-A-Plotter Wizard icon in the Plotters window.

3 « The Add Plotter - Begin screen opens. Select My Computer then click the Next button.

Plotter - Begin

eEecgin

Platter kodel

Import Pop or Pe2
Ports

Flotter Mame
Firizh

X

To configure a new platter, select one of the: following:

(%) My Computer

All zettings will be configured by an Autodesk Heidi plotter
driver, and managed by thiz computer.

() Metwork, Platter Server

Jsepoiny

() Systern Printer

[ < Back ” Hest > l[ Cancel ]

4. The Add Plotter - Plotter Model screen opens. Mount the User Software CD-ROM in the CD-ROM drive.

iPF815
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5. On the Add Plotter - Plotter Model screen, click the Have Disk button.

Add Plotter - Plotter Model X
Begin - Select your plotter manufacturer and model. IF your plotter isn't listed, consult wour
3% platter documentation for 2 compatible plotter.
p=Flotter Model Optionally, if you have an installation digk containing an HOI driver. choose Have
Disk._.t’-\ Erowsze for HIF File dia_log box iz digplayed for you to locate and install the
Import Pop or Po2 HIF file attached to the HDI driver.
Ports
F'.Ioltter e Manufacturers Models
Firish
Adobe
AutaCAD DXB File
Autodesk ePlat [D0wF)
Autodesk ePlat [PDF) —
CalCom
Uikl Demle med b ( l Z

Thiz model iz supported by F!a_ster [;iver - by Canon Inc.

[ < Back ” Hest > ][ Cancel ]

6. The Open dialog box opens. From the Look in box, select the CD-ROM drive, and then browse to the folder that
holds the hif file.

Select the hif file then click the Open button.

Note

e The hif format file is contained in the following folder.
364 \HDI Driver\English\2007 (AutoCAD Version 2007)

Installing with the Add-A-Plotter Wizard iPF815
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7. The display returns to the Add Plotter - Plotter model screen.

Select Canon Inc. from the list of Manufacturers, select the name of the printer for Models, and then click the

Next button.

Add Plotter - Plotter Model

X

Begin Select your plotter manufacturer and model. IF your plotter isn't listed, consult wour
" platter documentation for a compatible plotter.

p=Flotter Model Optionally, if you have an installation digk containing an HOI driver. choose Have

Digk. & Browsze for HIF File dialog box iz displayed for pou to locate and install the

Import Pop or Po2
Ports

Platter Mame
Firish

HIF file attached to the HDI driver.

Manufacturers

Adobe
AutaCAD DXB File

Autodesk ePlat [D0wF)

Autodesk ePlat [PDF)
CalCom

Lokt Dl oed

| | € | >

Thiz model iz supported by F!a_ster Iﬁver - by Canon Inc.

[ < Back “ Heut > l[ Cancel ]

8. The Add Plotter - Import Pcp or Pc2 screen opens. Click the Next button.

Add Plotter - Import Pcp or Pc2 [g|

Begin

Platter Model

pelmport Pop or Pe2
Ports
Plotter Mame
Firigh

Toimpart plotter specific information from a previously saved
PCP or PCZ file, choose Import File. Paper size, plot
optimization level, network, share names, and port names can
be imported into the new PC3 file.

Import File ..

MOTE: Use the Add Plot Style Table wizard to import pen
azzignment information. Uze the Import PCP/PCZ Settings
wizard to import PCP or PC2 page setup informatian,

< Back ” Mest > l[ Cancel

Note

* If you want the installer to read plotter information from previously stored PCP or PC2 files, click the

Import File button.

iPF815
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9 o The Add Plotter - Ports screen opens.
Make sure that Plot to a port is selected, select the port that you want to use for the plotter, then click the

Nextbutton.
Add Plotter - Ports E'
Begin b () Platto g pot () Plot to File () AutoSpoal
= The following iz a list of all ports available for the curently
configured device. All documents will be plotted ta the port
Plotter kodel 6" pou select,
Impart Pep or P2 Q-l Part D escription Frinter
wForts 1] LFT1 Local Paort
Platter M ame UWJ‘ LFT2 Local Paort
Firish 3 LFT3 Local Paort
Canon iP) ; Metwork Port
[ LConfigure Port ... ] [ Wwihat iz AutoSpool...
[[] Shiaww all system parts and disable [0 part validation
4 [ < Back “ Mewt l [ Catcel
Note

* In the Add Plotter - Ports screen, it is recommended to select Network Port. If you select Local
Port, the AutoCAD warning message may appear when printing.

1 0. The Add Plotter - Plotter Name screen opens. Click the Nextbutton.

Plotter. - Plotter Name E|

Beqin The model name vou selected is the default plotter
configuration name. You can accept the default name. or
enter a new name ko identify the new PC3 file you have
created. The name pou apply will be dizplayed in the Page
Plotter tMadel Setup and Plot dialog boxes.
Import Pop or Pe2
Parts Platter Mamne:
wFlotter Hame A
Firizh
Mote: If you enter a name that is exactly the same as a System
Printer's name, pou will not see the Spstem Printer listed in the
AutoCAD 2007 Plat or Page Setup dialog boxes.
< Back ” Hest > l [ Cancel
Note
366 * You can change the Plotter Name setting here, but you will normally leave it as it is and go to Step
11.
Installing with the Add-A-Plotter Wizard iPF815
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1 1 « The Add Plotter - Finish screen opens. Click the Finish button.
This completes the installation of the HDI driver.

Add Plotter - Finish X

Begin The plotter iIPFxsxx haz been installed with itz default
p configuration settings. To modify the default sethings, choose
; Edit Platter Configuration,

Plotter Model 6"

Import Pop or Po2 Qll

Ports 1]

Plotter Mame wn Edit Plotter Configuration ...

wFinizh w

Optionally, ta perform a plot calibration test on the newly
configured plotter, and verify that your drawing measurements
plot accurately, chooze Calibrate Platter.

LCalibrate Plotter ...

[ < Back “ Finizh l[ Cancel

1 2. Remove the User Software CD-ROM from the CD-ROM drive.

'Opening the Plotter Configuration Dialog Box

You can open the Plotter Configuration Editor dialog box by two ways.

* Opening from the AutoCAD File Menu
* Opening from the Start Menu

367
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'0pening from the AutoCAD File Menu

Follow the procedure below to open the Plotter Configuration Editor dialog box from the AutoCAD File menu.

1 « Select Plot from the AutoCAD File menu. The Plot dialog box opens.
Check the Name setting under Printer/plotter and confirm that iPFxxxx.pe3 (the name of the printer you use) is

displayed.
Click the Properties button.
@ Plot - Layout1
i| Learn about Plokting
Page setup
Mame: | <Mane = vl [ add ]
Printet plotker
Name: Propetties,..
Plokter: iPPuses - by Canon Inc,
—1 432 MM —
Where: TP R M e me e T
on
Description: !
3
[Plat ka file L
Paper size Murmber of copies
|ANSI C Roll Paper (17.00 x 22,00 in) ~ | 1 :
Flot area Plot scale
What to plat: Fit ko paper
Scale: | 1:1 £ |

Plok offset {origin set to printable area)

w, | 0.000000 inch
y: |0.000000 inch

Center the plot

1 mm w (=

[ 5cale lineweights

[

Preview. .. ] ’ Apply bo Layout H Ok

| @

l [ Cancel

Note

Name list.

* The names of the printers installed when the HDI driver was installed are in the Name list.

e If any other printer name is selected, select the name of the printer that you want to use from the

iPF815

Opening from the AutoCAD

File Menu
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2. The Plotter Configuration Editor dialog box opens.

'Opening from the Start Menu

Follow the procedure below to open the Plotter Configuration Editor dialog box from the Start menu.

1 o Click the Start button then select Control Panel.
The Control Panel window opens.

369
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2. Double-click the Autodesk Plotter Manager icon.
The Plotters window opens.
Double-click the iPFxxxx.pc3 icon (the icon name is the name of the printer you use) to open.

3 o The Plotter Configuration Editor dialog box opens.

370
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'Plotter Configuration Editor Dialog Box

The Plotter Configuration Editor dialog box has three sheets.
The Plotter Configuration Editor dialog box display can be manipulated by selecting the items on these sheets or in the
Explorer tree.

Note
* For more details about the General sheet and the Ports sheet, please refer to the AutoCAD manual.

Device and Document Settings Sheet

Use this sheet to perform the main printing settings. The settings for each item are shown in a tree structure on this sheet.
When you select an item the screen display changes so you make changes for the resolution and other graphic settings, the
media type, the color matching and Custom Properties settings, the drying time and the roll paper margin for safety and
other detailed media settings.

The available settings are as follows. 371
* Media Source and Media Size Settings
* Graphics Settings
» Custom Properties dialog box

iPF815 Plotter Configuration Editor Dialog Box
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'Media Source and Media Size Settings

Follow this procedure to select the media source and the media size.

1 o Press the Source and Size below Media.
The Device and Document Settings sheet opens and switches to the display that presents the media source and size
settings.

2. From the Source list, select the media source.

3 « From the Size list, select the media size.

Note
e When you change the Source setting, the Size setting returns automatically to its default settings. Ev-
ery time you adjust the Source setting, you should also re-adjust the Size setting.

372
4. Click the OK button.

Media Source and Media Size Settings iPF815
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'Graphics Settings

You can perform the graphics settings.

Vector Graphics settings

Use these settings to adjust the print mode and resolution.

1 « Click the Vector Graphics below Graphics.
The Device and Document Settings sheet opens and switches to the Vector Graphics settings.

2. Select Color or Monochrome.

3 « Select a setting for Color Depth from the list.
Color Depth presents the following items for selection.

373

Setting Details

Color 16777216 (24-bit) colors
Monochrome 16777216-Level grayscale

iPF815 Graphics Settings
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4. Move the Res slider to adjust the settings.
Res presents the following items for selection.

Setting Details
300 DPI Due to this low resolution, the image will print faster but its texture will appear
rough.
600 DPI This high resolution will achieve the best results.

5. Select Dithering.
Setting Details
Hardware Dithering Perform dithering on the printer.

6. Click the OK button.

4 Raster Graphics settings

PUse these settings to adjust the balance between the print quality, memory consumption, and the print speed of raster
graphics.

1 o Click the Raster Graphics below Graphics.
The Device and Document Settings sheet opens and switches to the Raster Graphic settings.
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Graphics Settings iPF815
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2. Move the slider for each item to the left or right to adjust the settings.

Setting Details
Raster and Shaded/Rendered Use these settings to adjust the balance between print quality, memory consump-
Viewports tion, and the print speed. If set to None, you cannot print raster images. Printing

time will take longer the higher you set the Best setting.

OLE Use these settings to adjust the balance between print quality, memory consump-
tion and the print speed when printing a OLE object. If set to None, you cannot
print OLE objects. Printing time will take longer the higher you set the Best set-
ting.

Trade-off Use these settings to lower the print quality by a certain degree if the print job can-
not be completed at the best quality.

3. Click the OK button.

Merge Control Settings

Use thse settings to merge intersecting lines. 4

1 o Click the Merge Control below Graphics.
The Device and Document Settings sheet opens and switches to the Merge Control settings.
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Setting Details

Lines Overwrite Where the lines intersect, the line that is printed last is visible, but the lines below it
are not visible.

iPF815 Graphics Settings
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